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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section.

Changes that you make to your system might void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

SpectraSYSTEM AS3000
(with oven and tray temperature control)

EMC Directive 2004/108/EC

EMC compliance has been evaluated by TÜV Rheinland of North America.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TÜV Rheinland of North America.

This device complies with Low Voltage Directive 2006/95/EC, harmonized standard EN 61010-1: 2001, 
IEC 61010-1: 2002, UL 61010A-1: 2004, and CAN/CSA 22.2 61010-1: 2004.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

EN 55011: 2007; A2:2007 EN 61000-4-4: 2004

EN 61000-3-2: 2006 EN 61000-4-5: 2005

EN 61000-3-3: 1995, A1: 2001, A2: 2005 EN 61000-4-6: 2007

EN 61000-4-2: 1995, A1: 1999, A2: 2001 EN 61000-4-11: 2004

EN 61000-4-3: 2006 EN 61326-1: 2006

FCC Class A: CFR 47: Part 15: 2009



FCC Compliance Statement

Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too bulky for one person alone 
to lift or move safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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Shock da folgorazione. L’apparecchio è 
alimentato da corrente ad alta tensione 
che puo provocare lesioni fisiche. Prima di 
effettuare qualsiasi intervento di 
manutenzione occorre spegnere ed isolare 
l’apparecchio dalla linea elettrica. Non 
attivare lo strumento senza lo schermo 
superiore. Non togliere i coperchi a 
protezione dalle schede di circuito 
stampato (PCB).

e contener 
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Prodotti chimici. Possibile presenza di 
sostanze chimiche pericolose 
nell’apparecchio. Indossare dei guanti per 
maneggiare prodotti chimici tossici, 
cancerogeni, mutageni, o 
corrosivi/irritanti. Utilizzare contenitori 
aprovo e seguire la procedura indicata per 
lo smaltimento dei residui di olio.

 que lop 
de efectuar 

Calore. Attendere che i componenti 
riscaldati si raffreddino prima di 
effetturare l’intervento di manutenzione.

ar el 
 

Incendio. Adottare le dovute precauzioni 
quando si usa il sistema in presenza di gas 
infiammabili.

icaduras de 
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.

Pericolo per la vista. Gli schizzi di 
prodotti chimici o delle particelle presenti 
nell’aria potrebbero causare danni alla 
vista. Indossare occhiali protettivi quando 
si maneggiano prodotti chimici o si 
effettuano interventi di manutenzione 
sull’apparecchio.

e existe un 
gorias 
én se utiliza 
l usuario a 
n este 

Pericolo generico. Pericolo non 
compreso tra le precedenti categorie. 
Questo simbolo è utilizzato inoltre 
sull’apparecchio per segnalare all’utente 
di consultare le istruzioni descritte nel 
presente manuale.
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Quando e in dubbio la misura di sicurezza 
per una procedura, prima di continuare, si 
prega di mettersi in contatto con il 
Servizio di Assistenza Tecnica locale per i 
prodotti di Thermo Fisher Scientific San 
Jose.
CAUTION Symbol CAUTION VORSICHT ATTENTION PRECAUCION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Elektroschock: In diesem Gerät werden 
Hochspannungen verwendet, die 
Verletzungen verursachen können. Vor 
Wartungsarbeiten muß das Gerät 
abgeschaltet und vom Netz getrennt 
werden. Betreiben Sie Wartungsarbeiten 
nicht mit abgenommenem Deckel. Nehmen 
Sie die Schutzabdeckung von Leiterplatten 
nicht ab.

Choc électrique: L’instrument utilise des 
tensions capables d’infliger des blessures 
corporelles. L’instrument doit être arrêté et 
débranché de la source de courant avant 
tout intervention. Ne pas utiliser 
l’instrument sans son couvercle. Ne pas 
enlever les étuis protecteurs des cartes de 
circuits imprimés.

Descarga eléctrica: Este ins
utiliza altas tensiones, capace
producir lesiones personales. A
dar servicio de mantenimiento
instrumento, éste debera apag
desconectarse de la línea de a
eléctrica. No opere el instrume
cubiertas exteriores quitadas. N
las cubiertas protectoras de la
de circuito impreso.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Chemikalien: Dieses Gerät kann 
gefährliche Chemikalien enthalten. Tragen 
Sie Schutzhandschuhe beim Umgang mit 
toxischen, karzinogenen, mutagenen oder 
ätzenden/reizenden Chemikalien. 
Entsorgen Sie verbrauchtes Öl 
entsprechend den Vorschriften in den 
vorgeschriebenen Behältern.

Chimique: Des produits chimiques 
dangereux peuvent se trouver dans 
l’instrument. Portez des gants pour 
manipuler tous produits chimiques 
toxiques, cancérigènes, mutagènes, ou 
corrosifs/irritants. Utiliser des récipients 
et des procédures homologuées pour se 
débarrasser des déchets d’huile.

Química: El instrumento pued
productos quimicos peligrosos
guantes al manejar productos 
tóxicos, carcinogenos, mutage
corrosivos/irritantes. Utilice re
procedimientos aprobados par
deshacerse del aceite usado.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Hitze: Warten Sie erhitzte Komponenten 
erst nachdem diese sich abgekühlt haben.

Haute Temperature: Permettre aux 
composants chauffés de refroidir avant 
tout intervention.

Altas temperaturas: Permita
componentes se enfríen, ante 
servicio de mantenimiento.

Fire: Use care when operating the system 
in the presence of flammable gases.

Feuer: Beachten Sie die einschlägigen 
VorsichtsmaBnahmen, wenn Sie das 
System in Gegenwart von entzündbaren 
Gasen betreiben.

Incendie: Agir avec précaution lors de 
l’utilisation du système en présence de 
gaz inflammables.

Fuego: Tenga cuidado al oper
sistema en presencia de gases
inflamables.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

Verletzungsgefahr der Augen: 
Verspritzte Chemikalien oder kleine 
Partikel können Augenverletzungen 
verursachen. Tragen Sie beim Umgang mit 
Chemikalien oder bei der Wartung des 
Gerätes eine Schutzbrille.

Danger pour les yeux: Des projections 
chimiques, liquides, ou solides peuvent 
être dangereuses pour les yeux. Porter des 
lunettes de protection lors de toute 
manipulation de produit chimique ou pour 
toute intervention sur l’instrument.

Peligro par los ojos: Las sal
productos químicos o particula
salten bruscamente pueden ca
lesiones en los ojos. Utilice an
protectores al mnipular produc
químicos o al darle servicio de
mantenimiento al instrumento

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

Allgemeine Gefahr: Es besteht eine 
weitere Gefahr, die nicht in den 
vorstehenden Kategorien beschrieben ist. 
Dieses Symbol wird im Handbuch 
auBerdem dazu verwendet, um den 
Benutzer auf Anweisungen hinzuweisen.

Danger général: Indique la présence 
d’un risque n’appartenant pas aux 
catégories citées plus haut. Ce symbole 
figure également sur l’instrument pour 
renvoyer l’utilisateur aux instructions du 
présent manuel.

Peligro general: Significa qu
peligro no incluido en las cate
anteriores. Este simbolo tambi
en el instrumento par referir a
las instrucciones contenidas e
manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.

Wenn Sie sich über die Sicherheit eines 
Verfahrens im unklaren sind, setzen Sie 
sich, bevor Sie fortfahren, mit Ihrer 
lokalen technischen 
Unterstützungsorganisation für Thermo 
Fisher Scientific San Jose Produkte in 
Verbindung.

Si la sûreté d’une procédure est 
incertaine, avant de continuer, contacter 
le plus proche Service Clientèle pour les 
produits de Thermo Fisher Scientific San 
Jose.

Cuando la certidumbre acerca 
procedimiento sea dudosa, an
proseguir, pongase en contact
Oficina de Asistencia Tecnica 
los productos de Thermo Fishe
San Jose.



CAUTION Symbol CAUTION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Fire: Use care when operating the system 
in the presence of flammable gases.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.
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P

Preface

This guide describes how to install, operate, and maintain the SpectraSYSTEM™ AS3000 
autosampler, as well as how to inject samples and perform diagnostics from the front panel 
keypad.

Safety and Special Notices
This guide contains the following safety and special notices.

Contents

• Safety and Special Notices

• Safety Precautions for the SpectraSYSTEM Autosampler

• Good Laboratory Practices

• Contacting Us

CAUTION  Alerts you to situations that could result in personal injury and tells you how to 
avoid them.

CAUTION  High Voltage. Alerts you to the presence of high voltage and to the potential 
injury that could occur from electrical shock if you came into contact with a specific 
instrument area or component. Also indicates how to avoid contact with the high-voltage 
areas in your instrument. 

CAUTION  Hot Surface. Alerts you to potential injury that could occur from contact with 
a heated surface or area on or in an instrument. Also, tells you how to avoid contact with 
the heated surfaces in your instrument. 

CAUTION  Alerts you to situations that could result in personal injury caused by lifting 
objects that are too heavy, too bulky, or both.
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Safety Precautions for the SpectraSYSTEM Autosampler
Follow these safety precautions for the SpectraSYSTEM autosampler.

Grounding Requirements

The SpectraSYSTEM autosampler requires two levels of grounding. When you install the 
SpectraSYSTEM autosampler, connect the power cord to a power outlet with a protective 
earth ground. In addition, connect the grounding post on the back panel of the autosampler 
to the building ground (see “Connecting the Autosampler to the Building Ground” on 
page 19).

IMPORTANT  Alerts you to connections to the building ground.

IMPORTANT  Alerts you to grounding connections that require a protective earth ground. 

IMPORTANT  Alerts you to the correct operating or maintenance procedures needed to 
prevent equipment or data damage. It also alerts you to important exceptions, side effects, 
or unexpected occurrences that can result from certain actions.

Tip  Calls out general rules or shortcuts. Tips specify ways to obtain the best performance 
and results from your instrument.

IMPORTANT  Make sure that the power cord is connected to a power outlet with a 
protective earth ground. 

IMPORTANT  Make sure that the grounding post on the back panel of the autosampler is 
connected to the building ground.
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Preface
High-Temperature Components

When you set the column oven to high temperatures, the compartment’s metal components 
can cause burns. When you want to change the LC column or tighten the liquid connections 
to the LC column, turn off the column oven, and wait for the oven to cool to room 
temperature.

Heavy Lifting Hazard

Because the autosampler is bulky and heavy, lifting it requires a team effort. For information 
on how to safely lift the autosampler, see “Lifting the Autosampler” on page 17.

Good Laboratory Practices
To obtain optimal performance from your LC system and to prevent personal injury or injury 
to the environment, do the following:

• Keep good records.

• Read the manufacturers’ Material Safety Data Sheets (MSDSs) for the chemicals being 
used in your laboratory.

• Remove particulate matter from your samples before you inject them into the liquid 
chromatograph.

• Use HPLC-grade solvents.

• Connect the drainage tubes from the pump, autosampler, and detector to an appropriate 
waste receptacle. Dispose of solvents as specified by local regulations.

Keeping Good Records

To help identify and isolate problems with either your equipment or your methodology, keep 
good records of all system conditions (for example,% RSDs on retention times and peak areas, 
peak shape, and resolution). At a minimum, keep a chromatogram of a typical sample and 
standard mixture, well documented with system conditions, for future reference. Careful 
comparison of retention times, peak shapes, peak sensitivity, and baseline noise can provide 
valuable clues to identifying and solving future problems.

CAUTION  Never touch the metal components of the column oven compartment when 
you are operating the oven at high temperatures. The metal components can cause burns.

CAUTION  For your safety, and in compliance with international regulations, ask for 
assistance when moving the autosampler from one benchtop location to another. The 
autosampler is too bulky for one person alone to lift or move safely.
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Chemical Toxicity

Although the large volume of toxic and flammable solvents used and stored in laboratories can 
be quite dangerous, do not ignore the potential hazards posed by your samples. Take special 
care to read and follow all precautions that ensure proper ventilation, storage, handling, and 
disposal of both solvents and samples. Become familiar with the toxicity data and potential 
hazards associated with all chemicals by referring to the manufacturers’ MSDSs.

Sample Preparation

Always consider the solubility of your sample in the solvent/mobile phase. Sample 
precipitation can plug the column, tubing, or flowcell causing flow restriction. This 
obstruction can result in irreparable damage to the system. To avoid damage caused by 
particulate matter, filter samples through 0.45 or 0.2 micron (or less) filters.

Solvent Requirements

Many chemical manufacturers provide a line of high-purity or HPLC-grade reagents that are 
free of chemical impurities. Routine filtration of all solvents or eluents through a 0.45 or 
0.2 micron (or less) fluorocarbon filter before placing them in the solvent reservoir 
significantly prolongs the life and effectiveness of the inlet filters, check valves and seals, 
injection valve, and column. Typically, HPLC-grade solvents do not require filtration.

Choose a mobile phase that is compatible with the sample and column you have selected for 
your separation. Remember that some solvents are corrosive to stainless steel.

Solvent Disposal

Make sure you have a solvent waste container or other kind of drain system available at or 
below the benchtop level. Most solvents have special disposal requirements and should not be 
disposed of directly down a drain. Follow all governmental regulations when disposing of any 
chemical.

High-Pressure Systems and Leaks

LC systems operate at high pressures. Because liquids are not highly compressible, they do not 
store much energy. Accordingly, there is little immediate danger from the high pressures in an 
LC system. However, if a leak occurs, correct it as soon as possible. Always wear eye and skin 
protection when operating or maintaining an LC system. Always shut down the system and 
return it to atmospheric pressure before attempting any maintenance.
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Preface
Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to http://sjsupport.thermofinnigan.com/public/index_download_customer.asp and 
click Customer Manuals in the left margin of the window. 

To suggest changes to documentation or to Help

• To provide us with comments about this document, click the link below. Thank you 
in advance for your help. 

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752
Fax 561-688-8736
E-mail us.techsupport.analyze@thermofisher.com
Knowledge base www.thermokb.com

Phone 800-532-4752
Fax 561-688-8731
E-mail us.customer-support.analyze@thermofisher.com
Web site www.thermo.com/ms
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Introduction

This chapter introduces the Thermo Scientific SpectraSYSTEM AS3000 autosampler 
(see Figure 1) and describes the conventions used in this manual.

Figure 1. SpectraSYSTEM AS3000 autosampler

Contents

• Functional Description

• Operation Modes

• Manual Conventions

• Specifications
Thermo Scientific SpectraSYSTEM AS3000 Autosampler User Guide 1



1 Introduction
Functional Description
Functional Description
These topics describe the autosampler’s components and injection types:

• “Autosampler Components” on page 2

• “Injection Types” on page 4

• “Operation Modes” on page 8

Autosampler Components

The autosampler consists of the following components:

• Injection valve and sample loop

• XYZ arm with holding hook and needle

• Syringe and two-position syringe valve

• Tray compartment and temperature control unit

• Column oven compartment

Figure 2 shows the components of the autosampler's injection system. 

Figure 2. Injection system

2

5

3

4
6

1

 

 

Sample
syringe
valve

Sample 
syringe

Injection valve

Injection
tower

Injection
tower

Flush
solvent

Needle

Sample vial

Sample loop

Pump output line

Column input line

Injection valve
2 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 1 Introduction
Functional Description
Prior to sample analysis, the operator loads vials filled with samples and calibration standards 
into three trays that hold 35 vials each if the tray temperature control unit is installed. During 
operation, the autosampler’s mechanical arm (the XYZ arm) locates the requested vial. The 
hook on the end of the arm moves under the selected vial and lifts it from the sample tray. The 
XYZ arm transports the vial to the sample tower and the sample needle for sample injection. 
As necessary, the injection valve switches between the inject and fill positions (see Figure 3) to 
draw sample or solvent into the autosampler lines and to inject sample onto the column. 

Figure 3. Inject and fill positions for the injection valve

The tray compartment holds the sample trays, the injection tower, and the sample syringe. 
The temperature control unit for the tray compartment consists of four Peltier devices, two 
high-speed fans, and a heat sink. Heat is pumped from the sample compartment into the heat 
sink and then blown out the back of the instrument by the two fans. A temperature sensor 
sends the temperature reading back to the microprocessor, which controls the operation of the 
four Peltier devices to regulate the sample compartment temperature. Similar to the column 
oven, the tray temperature control unit is a closed assembly and requires no routine 
maintenance.

The temperature-control unit maintains the temperature of the tray compartment 
within ± 2 °C. At ambient room temperature, the tray compartment takes approximately 
30 minutes to reach a temperature of 0 °C and approximately 10 minutes to reach a 
temperature of 60 °C. 

The actual temperature inside the autosampler vial depends on the specified tray temperature, 
type of vial, sample buffer, and so on. Compared to the tray temperature, the vial temperature 
tends to be higher below 30 °C and lower above 30 °C. The time lag in heating and cooling is 
due to variations in ambient temperatures, indirect contact with temperature control units, 
and vial type.

The column oven compartment holds the LC column. The column oven contains a resistive 
thermal device that heats up to stabilize the column temperature. A temperature sensor 
detects the temperature and sends the temperature reading back to the microprocessor, which 
turns the resistive device on or off to regulate the temperature. This assembly is closed and 
requires no routine maintenance.

2

5

3

4
6

1
2

5

3

4
6

1

From
pump

To
column

From
pump

To
column

Fill position Inject position

Note   The current version of the SpectraSYSTEM AS3000 autosampler includes a 
temperature-control unit for the tray compartment and the vial trays hold 35 vials each.
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Functional Description
Injection Types

The SpectraSYSTEM AS3000 autosampler has three injection types:

• Full-loop Injection Type

• Pull-loop Injection Type

• PushLoop Injection Type

The pull-loop and PushLoop™ injection types are partial-loop injection types that allow you 
to inject variable amounts of sample.

Full-loop Injection Type

Use the full-loop injection type when you need the highest possible injection-to-injection 
precision and you have sufficient sample to overfill the sample loop. During a full-loop 
injection, the autosampler overfills the sample loop, and the mobile phase from the pump 
backflushes the contents of the sample loop onto the LC column.

During a full-loop injection, the autosampler performs these tasks:

1. Picks up the sample vial from the vial position that you specify in the acquisition 
sequence, and transports the vial to the injection tower.

2. Pushes the sample needle through the vial septum to the depth specified in the method 
(Needle Height from Bottom parameter). 

Figure 4 shows the autosampler needle descending to a depth of 2 mm from the bottom 
of the sample vial.

Figure 4. Needle height from bottom (of the vial)
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Functional Description
3. Switches the injection valve to the fill position.

4. Withdraws sample solution from the vial and overfills the sample loop. 

The speed at which the autosampler withdraws sample depends on the sample viscosity 
that you specify in the instrument method (Normal, Medium, or High). The amount of 
sample withdrawn depends on the injection volume that you specify in the acquisition 
sequence. 

The autosampler uses the following algorithm to overfill the sample loop:

Volume withdrawn = Requested injection volume × 1.33 + 70 μL

5. Switches the injection valve to the inject position, allowing the mobile phase to backflush 
the sample out of the loop and through the LC column.

6. Flushes the needle tubing and needle with flush solvent from the flush bottle. You specify 
the flush volume in the instrument method. The default flush volume is 400 μL.

Pull-loop Injection Type

Use the pull-loop injection type when you have a limited amount of sample. During a 
pull-loop injection, the autosampler pulls only the requested sample volume into the sample 
loop.

Because dissolved gases can outgas as the autosampler pulls the sample through the needle 
tubing, the pull-loop injection type is less precise than the Pushloop injection type. The 
bubble formation within the sample slug decreases the reproducibility of the sample volume 
pulled into the sample loop.

During a pull-loop injection, the autosampler performs the following tasks:

1. Draws an air bubble into the needle to isolate the incoming sample slug from the flush 
solvent already present in the lines.

2. Switches the injection valve to the fill position.

3. Lowers the needle into the sample vial.

4. Draws sample into the needle tubing.

5. Raises the needle out of the vial.

6. Draws air into the needle tubing as it pulls the sample solution into the sample loop.

7. Switches the injection valve to the inject position, allowing the mobile phase from the LC 
pump to backflush the sample from the sample loop onto the LC column.
Thermo Scientific SpectraSYSTEM AS3000 Autosampler User Guide 5
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PushLoop Injection Type

Use the PushLoop injection type when you want to vary the injection volume and 
injection-to-injection precision is important.

During a PushLoop injection, the autosampler performs these tasks:

1. Draws sample into the needle tubing and through the injection valve as shown in 
Figure 5:

a. Switches the injection valve to the inject position. 

b. Draws an air bubble into the needle. 

c. Lowers the needle into the sample vial.

d. Draws sample into the needle tubing.

e. Draws a portion of the sample solution through the injection valve. 

This step flushes the solvent path between the needle tubing and the sample loop 
with the sample solution.

Figure 5. PushLoop injection—step 1
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Functional Description
2. Loads the sample loop with the requested injection volume as follows (see Figure 6):

a. Switches the injection valve to the fill position. 

b. Pushes the requested injection volume into the sample loop. 

Figure 6. PushLoop injection—step 2

3. Switches the injection valve to the inject position. Mobile phase enters the injection valve 
through port 6, backflushing the sample out of the loop and onto the column 
(see Figure 7).
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Figure 7. PushLoop injection—step 3

Operation Modes

The SpectraSYSTEM autosampler has two modes of operation: Stand Alone and SpectraNet. 
In the Stand Alone mode, you control the autosampler from its keypad controls and acquire 
data to an external device, such as an integrator. In the SpectraNet mode, the SN4000 system 
controller controls the SpectraSYSTEM HPLC modules through SpectraNET™ 
communication. The SN4000 system controller transmits information from the system 
modules, such as the autosampler’s tray and column oven compartment temperatures, the 
system pressure monitored by the pump, and the data stream from the detector to the data 
system computer. 

For information on setting up the system for SpectraNET control, see “SpectraNet Mode” on 
page 31. For information on controlling the autosampler from the data system, refer to the 
Help and manuals provided with the data system.

For information on setting up the system for stand-alone control, see “Stand Alone Mode” on 
page 39. For information on controlling the autosampler from its command center, see 
“Standalone Operation from the Command Center” on page 63.
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Manual Conventions
Manual Conventions
This manual uses several conventions for working with the autosampler keys and menu 
displays.

Autosampler Displays

The autosampler provides a two-line display as shown in the next figure. For manual 
illustrations of the autosampler menu, the triangular cursor location is indicated by a caret (>).

• A two-line menu display

Frequently, the two lines shown on the display are only part of a longer menu that you 
can see when you press the instrument’s DOWN ARROW key ( ).

In this manual, menus having more than two lines are represented with dashed lines.

• A menu longer than two lines

Text Conventions

This manual uses typographic conventions to differentiate among keys, menus, and fields.

Keys

The manual indicates text keys on the autosampler in all-capital letters, with the exception of 
the Samples key. For example: Press the MENU key. 

Menus

Use of bold text and the right-arrow key, Menu name > Menu command, indicate instrument 
display menu selections. For example: From the main menu, select Files > Load.

Fields

To indicate field names as shown on the instrument display, this manual uses capitalization. 
Generally, the first letters of field names are capitalized. For example, in the Samples menu, go 
to the Injection Volume field.
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Manual Conventions
Standard Words

For this manual, the words select and enter specifically refer to the autosampler menu 
commands and value fields.

Select

The word select is used when you must choose from among available options. For example, to 
select a particular menu option, you move the cursor to the appropriate selection and press the 
ENTER key. To select a field entry, move the cursor to the appropriate field, and then press 
the [+] and [–] keys to scroll to the desired value.

Enter

The word enter is used when you must specify individual alphanumeric digits. To enter a 
particular value, move the cursor to the field and press the [+] and [–] keys to increment or 
decrement each digit in the field until the desired value or letter appears.
10 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 1 Introduction
Specifications
Specifications
These are the specifications for the SpectraSYSTEM AS3000 autosampler.

Vial capacity: 105 in three removable trays

Note  For earlier versions of the autosampler, the tray temperature control unit was a 
hardware option. The tray compartment for autosamplers that do not have this 
option installed hold 120 vials in three removable trays.

Variable-volume:

Injection precision <0.5% RSD @ 10 μL or greater

Injection volume • 0.1 to 100 μL injection standard (250 μL syringe)
• Up to 1000 μL injections with larger loops and syringes

Fixed-loop:

Injection precision <0.5% RSD @ 10 μL or greater

Injection volume • 20 μL standard (250 μL syringe)
• 1000 μL injections with larger loops and syringes

Sample carryover: Typically <0.01% at 400 μL flush volume

Note  The flush volume is user-settable from 0 to 5000 μL.

Minimum sample volume: 1 μL can be injected from a sample volume of 10 μL with a standard needle

Needle height: Settable in 0.1 mm increments from 0 to 20 mm

Column oven (optional): • Settable in 1° increments from 20 to 80 °C, starting at 5 °C above ambient
• Temperature stability typically ±0.2 °C
• Accommodates up to 30 cm columns

Method files: • Protected in non-volatile memory

Communications: • Pump Ready
• Inject Hold

Outputs: • Pump Stop
• Autosampler Ready
• Inject
• Gradient Start
• Four timed-event outputs
• BCD (optional)
• SpectraNET/RS-232 port

Dimensions: 14.5 in. (37 cm) × 17 in. (43 cm) × 20 in. (51 cm) (h×w×d)

Weight: 53 lb. (24 kg) with temperature-controlled tray and column oven compartments

Power requirements: 100/120 VAC, 220/240VAC, 50/60 Hz, 450VA

Environmental: 10 to 40 °C; 5 to 95% relative humidity, noncondensing

Safety/EMC compliance: CSA, TÜV, UL, FCC, CE Mark, EMC and Low Voltage Directives
Thermo Scientific SpectraSYSTEM AS3000 Autosampler User Guide 11





2

Installation

This chapter describes the site requirements, installation procedures, and performance testing 
for the Thermo Scientific SpectraSYSTEM AS3000 autosampler.

Before you unpack the autosampler, read the instructions on lifting the autosampler (see 
“Lifting the Autosampler” on page 17).

The following items are factory installed: a 250 μL syringe, three sample trays, a sample 
needle, and a 100 μL sample loop.

Contents

• Startup Checklist

• Site Requirements

• Lifting the Autosampler

• Unpacking the Autosampler

• Connecting the Autosampler to the Building Ground

• Connecting the Plumbing

• Installing the Column Compartment Cover

• Installing the Sample Trays

• Powering-Up the Autosampler

• Priming the Autosampler

• Communication: SpectraNet or Stand Alone

• Performance Verification
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2 Installation
Startup Checklist
Startup Checklist
This list summarizes the tasks that are required to install your autosampler. Complete 
installation information is contained in this chapter.

To install the autosampler, use these tools:

• Phillips screwdriver (1)

• 1/4 in. open-end wrench (2)

• Small, standard screwdriver (1)

Unpacking

Unpack and inspect your instrument. “Unpacking the Autosampler” on page 18

Remove cardboard/foam packing insert from the sample 
compartment (tub).

Check for parts shortages.

Read the Safety Information section.

Back panel

Place the autosampler so that the back panel is accessible. “Site Requirements” on page 16

Install filter/solvent line and flush bottle.

Connect the power cord. “Powering-Up the Autosampler” on page 29

Connect the autosampler to the building ground. “Connecting the Autosampler to the Building 
Ground” on page 19

Hardwire the external events terminals and make the 
connections to other SpectraSYSTEM instruments.

For an autosampler under SpectraNET control, make the 
hardwire connections to other SpectraSYSTEM instruments 
and connect the instruments to the SN4000 system 
controller.

“Connecting the System Synchronization 
Harness” on page 37 and
“Connecting the SpectraSYSTEM Devices to the 
SN4000 Controller” on page 31
14 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 2 Installation
Startup Checklist
Front panel

Install the solvent tray/waste container. “Installing the Solvent Waste Container” on 
page 22

Connect the autosampler to the pump:

On instruments with the column oven installed, connect the 
pump outlet line to the solvent preheat tube.

“Connecting the Pump to the Autosampler” on 
page 24

Mount the LC column:

On instruments with the column oven installed, install the 
column between the column mounts, secure the column 
mounts to the oven, and connect the inlet end to injection 
valve port 5.

“Installing the Column” on page 25

Connect the autosampler to the detector.
(Connect 12 in., 0.010 in. ID tubing to the inlet side of 
flowcell.)

“Connecting the LC Column’s Outlet to the 
Detector’s Flowcell Inlet” on page 26

Startup/priming

Turn on the autosampler and check the initial response to 
power-on.

“Powering-Up the Autosampler” on page 29

Using the 250 μL syringe, flush the lines with 500 μL of 
solvent.

Performance verification

Run a standard sample (a test mix is shipped with the 
instrument).

“Performance Verification” on page 49

Date and retain run results with instrument documentation.

Customize the READY participation settings. “Ready Participation” on page 48

Run an unretained sample to determine the system gradient 
delay time.

“Gradient Delay” on page 99

Optimize the needle height. The default value of 2 mm is 
appropriate for most applications.

“Needle Height” on page 95

Installed by:

(Name) (Date)
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2 Installation
Site Requirements
Site Requirements
These topics describe the space and electrical requirements for the SpectraSYSTEM 
autosampler:

• “Space” on this page

• “Electrical” on page 17

Space

The autosampler weighs 24 kg (53 lbs) and requires a team effort to lift. Before you lift the 
autosampler, read the lifting instructions in “Lifting the Autosampler” on page 17. The 
instrument requires a bench space at least 14.5 in. (37 cm) × 17 in. (43 cm) × 20 in. (51 cm) 
(h×w×d). Be sure to allow adequate ventilation away from heating or air conditioning ducts. 
Avoid exposing the autosampler to direct sunlight. If used with the SpectraSYSTEM pump 
and detector, place the autosampler in the middle (see Figure 8). 

Figure 8 does not show the vacuum membrane degasser. Place the vacuum membrane 
degasser to the left of the LC pump.

Figure 8. SpectraSYSTEM LC system benchtop setup

Tip  You might want to set your instrument on the benchtop so that you have easy access 
to the back panel.

LC Pump Autosampler Detector

CAUTION  If you use hazardous solvents, be sure to use the proper venting apparatus.
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 2 Installation
Lifting the Autosampler
Electrical 

Your autosampler automatically configures itself to operate from the local line voltage 
(100 to 260 VAC at 50 or 60 Hz). You do not need to set the line voltage. The instrument 
arrives with the necessary fuses installed.

To avoid intermittent failures and unexplained occurrences (lockup, loss of memory, incorrect 
operation) that are directly related to poor power, provide a stable, spike-free power source. 
Thermo Fisher Scientific recommends the use an uninterruptible power supply (UPS) for 
maximum protection from power-related failures. 

Lifting the Autosampler
The autosampler, at 24 kg (53 lbs) and a height, width, and depth of 37 × 43 × 51 cm 
(14.5 × 17 × 20 in.), is too heavy and too bulky for one person alone to lift safely. In addition, 
any jarring or uneven movement can cause misalignment of the autosampler’s XYZ arm.

In accordance with international safety regulations, lifting the autosampler requires a team 
effort. Moving the autosampler from one benchtop to another requires two people to 
simultaneously lift the autosampler onto a movable cart. Using the lift points underneath the 
left and right sides of the autosampler, have one person lift the left side of the autosampler 
while the second person lifts the right side of the autosampler.

Figure 9 shows the lift point underneath the right side of the autosampler.

CAUTION  The UPS unit must meet the appropriate safety standards and be certified by 
authorized agencies for your country (Authorized agencies include TÜV, CSA, UL, and so 
on. The CE mark is accepted in most countries.) Thermo Fisher Scientific cannot 
guarantee that the LC system meets the appropriate safety standards when you connect 
uncertified devices to the autosampler.
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2 Installation
Unpacking the Autosampler
Figure 9. Lift point on the right side of the autosampler

Unpacking the Autosampler
Your autosampler arrives in a specially designed shipping container to protect it from damage 
during transit. When it arrives, inspect all containers and immediately report any damage in 
transit to the transportation company. Have the carrier note the shipping crate's condition on 
both the delivery receipt and the freight bill. The carrier is responsible for all damage incurred 
in shipment. 

The SpectraSYSTEM autosampler arrives with the sample trays and syringe installed. A 
cardboard shipping insert on top of the sample trays restrains the XYZ arm and holds the 
sample trays in place during shipment. Remove the shipping insert. Retain both the shipping 
insert and shipping crate should future shipment become necessary. 

After unpacking, inspect your autosampler and its accessories for missing parts, physical 
damage, or both. If you find damage, notify both the carrier and your Thermo Fisher 
Scientific representative. You must obtain authorization from Thermo Fisher Scientific prior 
to returning any goods.
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 2 Installation
Connecting the Autosampler to the Building Ground
The shipping kit contains the following:

• Autosampler

• Accessory Kit (See Chapter 8, “Replaceable Parts.”)

• Vial Kit (See Chapter 8, “Replaceable Parts.”)

• Declaration of Conformity 

• SpectraSYSTEM documentation CD (contains the user guides for the SpectraSYSTEM 
family of LC products)

The accessory kit contains three sample trays and the vial kit contains a supply of vials, 
silicone and Teflon™ septa, and screw-top vial caps. You can order additional vials from 
Thermo Fisher Scientific. To ensure smooth autosampler operation, use standard size vials. 

For information about installing the sample trays in the autosampler tray compartment 
(sample tub), see “Installing the Sample Trays” on page 27.

Connecting the Autosampler to the Building Ground
Before you turn on the autosampler, connect the grounding post on the back of the 
autosampler to the building ground.

To connect the autosampler to the building ground

1. Connect one end of a conductive wire to the grounding post on the back of the 
autosampler (see Figure 10).

2. Connect the other end of the conductive wire to the building ground, for example, to an 
exposed metal fixture such as the building's water pipe.

CAUTION  To avoid electric shock, make sure that the autosampler is connected to 
ground. Connect the power cord to a power outlet with a protective earth ground (see 
“Powering-Up the Autosampler” on page 29). Connect the grounding post on the back of 
the autosampler to the building ground.
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2 Installation
Connecting the Autosampler to the Building Ground
Figure 10. Autosampler grounding post connected to ground
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Earth Connection Essential
Before Connecting Supply!

WARNING

ATTENTION
Raccordement a la terre 

indispensable avant 
le raccordement a l’alimentation!

WARNUNG
Vor Dem Anschluss des Netzteils 

Unbedingt Erdung 
des Gerates Vornehmen!

TERMINAL CONFIGURATION

This product is manufactured under, and covered by, one or more of the following U.S. patents:

AS3000
SPECTRA AutoSampler 
OVEN-TEMP/COOLER 

4,478.095

4,953,075

4,957,009

5,029,065

5,044,428

Description Signal
TIMED EVENT  1                    OUT
TIMED EVENT  2                    OUT
TIMED EVENT  3                    OUT
TIMED EVENT  4                    OUT
A/S READY OUT
INJ HOLD                                 IN
INJ OUT OUT
PUMP READY                          IN
GRAD START            OUT
PUMP STOP                           OUT
+ 5V    150mA OUT
GROUND                                  ----

12.
11.
10.
9.
8.
7.
6.
5.
4.
3.
2.
1.

Serial No:
Model No:

355 River Oaks Parkway
San Jose, CA 95134  U.S.A.

CAUTION

FUSE

SERVICE BY QUALIFIED PERSONNEL ONLY.

NO USER SERVICEABLE PARTS INSIDE.

This device complies with FCC Rules, Part 15. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) This device must accept any interference 
received, including interference that may cause 
undesired operation.

61010 - 1

LINE

FOR CONTINUED PROTECTION AGAINST FIRE HAZARD, 

REPLACE FUSE ONLY WITH SAME TYPE AND RATING.

180000

AS 3000

100 V 120 V

T5.0 A      T2.5 A    450 VA

220 V 240 V 50/60 HZ

Assembled in China

Grounding post
Conductive wire 
connected to the 
building ground
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 2 Installation
Connecting the Plumbing
Connecting the Plumbing
To install the solvent bottles and connect the plumbing, follow these procedures:

• “Connecting the Flush Solvent Bottle” on this page

• “Installing the Solvent Waste Container” on page 22

• “Connecting the Pump to the Autosampler” on page 24

• “Installing the Column” on page 25

• “Connecting the LC Column’s Outlet to the Detector’s Flowcell Inlet” on page 26

Connecting the Flush Solvent Bottle

Your accessory kit includes a 250 μL flush-solvent bottle and cap. The cap assembly comes 
with the 1/8 in. OD × 1/16 in. ID Teflon inlet line and high-molecular-weight polyethylene 
filter attached.

To install the flush bottle 

1. Rinse the bottle with LC-grade solvent to remove any dust. Fill the bottle with the 
appropriate LC-grade solvent.

2. Insert the filter into the solvent bottle and screw on the cap. Make sure that the inlet filter 
rests on the bottom of the solvent bottle. 

3. Connect the free end of the Teflon inlet line to the flush line on the back of the 
autosampler (see Figure 11).

Note  If you want to use your own solvent bottle or another container, be sure that it is 
clean and chemically inert. For best results, use glass bottles. 
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2 Installation
Connecting the Plumbing
Figure 11. Autosampler back panel connections

4. Place the flush bottle in a secondary container.

Installing the Solvent Waste Container

The solvent waste container (the flat, white plastic container included in your accessory kit) 
can hold 100 mL of waste. To install it, slide it into the compartment under the front left side 
of the instrument. 
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4,953,075

4,957,009

5,029,065

5,044,428

Description Signal
TIMED EVENT  1                    OUT
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TIMED EVENT  3                    OUT
TIMED EVENT  4                    OUT
A/S READY OUT
INJ HOLD                                 IN
INJ OUT OUT
PUMP READY                          IN
GRAD START            OUT
PUMP STOP                           OUT
+ 5V    150mA OUT
GROUND                                  ----

12.
11.
10.
9.
8.
7.
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5.
4.
3.
2.
1.

Serial No:
Model No:

355 River Oaks Parkway
San Jose, CA 95134  U.S.A.

CAUTION

FUSE

SERVICE BY QUALIFIED PERSONNEL ONLY.

NO USER SERVICEABLE PARTS INSIDE.

This device complies with FCC Rules, Part 15. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) This device must accept any interference 
received, including interference that may cause 
undesired operation.

61010 - 1

LINE

FOR CONTINUED PROTECTION AGAINST FIRE HAZARD, 

REPLACE FUSE ONLY WITH SAME TYPE AND RATING.

180000

AS 3000

100 V 120 V

T5.0 A      T2.5 A    450 VA

220 V 240 V 50/60 HZ

Assembled in China

Fuse compartment

AC power

Factory-installed 
flush line with union

COMM port

CAUTION  Many LC solvents are hazardous. Make sure to handle them properly and 
dispose of any waste solvents in an environmentally correct manner.

Note  The general caution label on the left side of the autosampler below the column oven 
compartment is a reminder to empty the solvent waste container. The default flush 
volume for an injection cycle is 400 μL. This means that you can overfill the solvent waste 
container within 250 injections.

Note  The back of the compartment prevents the tray from sliding too far under the 
instrument.
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 2 Installation
Connecting the Plumbing
Orient the tray so that the black plastic, barbed elbow fitting is directed through the hole in 
the liquid collection trough (across the front of the instrument) as shown in Figure 12.

Figure 12. Autosampler front panel connections

For larger injection applications, or for those requiring frequent flushing, you might want to 
install a piece of Tygon™ tubing onto the waste port to allow the waste to flow to a carboy or 
other large container for waste collection.

To hook up your waste container, locate the Tygon tubing included in your accessory kit and 
connect it to the end of the black, barbed fitting. To prevent backflushing into the lines, place 
the container lower than the instrument. Direct the Tygon tube into your container. 

WA R N IN G

Samples AS3000 

ENTER 

MENU STATUS RUN 

STOP 

Solvent pre-heat 
tube

Aluminum mounting plates 
(oven models only)

Solvent 
waste 
container

Liquid collection 
trough

From pump

To detector

Elbow fitting

To flush valve

2×24 
alpha-numeric 
display

Oven 
(optional)

Power 
switch

Single-piece 
injection 
needle

Note  Sometimes the barbed elbow fitting becomes dislodged during shipping. Be sure 
that the end of the barbed fitting is directed through the hole (not into the trough). 
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2 Installation
Connecting the Plumbing
Connecting the Pump to the Autosampler

The autosampler arrives with the column oven assembly and the flush and needle lines already 
installed. The stainless-steel, low dead-volume union that connects the pump outlet tubing to 
the column oven tubing is also factory installed. You have to connect the pump to the zero 
dead-volume union (ZDV). The preheat line runs behind the column oven, through the 
oven's mantle, up through the service loop, and into the injection valve. For standard 
analytical configurations, this line holds approximately 180 μL of preheated solvent. 
Instruments with 0.007 in. narrow-bore preheat tubing provide approximately 22.7 μL of 
preheated solvent.

To connect the pump to the preheat tube

1. Remove the column oven cover (if you have not already done so) and set it aside. 

2. Route your pump outlet line through the lower notch on the left side of the autosampler.

3. Connect the line to the low dead-volume union on the preheat tube as follows:

a. Locate the ferrule included in your accessory kit.

b. Thread the tubing through the fitting, and place the ferrule on the end of the preheat 
tube. 

c. Use two 1/4 inch wrenches to tighten the connection. Use one wrench to hold the 
union body and one to tighten the nut 1/8-turn past the stop.

Figure 13 shows the connection between the LC pump outlet and the preheat tube inlet.

Note  Your standard accessory kit contains two pieces of 0.010 in. ID stainless-steel tubing 
(one 4 in. piece and one 12 in. piece). The 12 in. piece is included to make the 
column-detector connection if the detector is not a SpectraSYSTEM detector. If you are 
connecting the pump to a SpectraSYSTEM detector, you can use the 12 inch tubing to 
make the pump-autosampler connection. 

Tip  The cover fits snugly. To remove it, place your fingers or thumb in the 
indentation on the top edge of the column door and firmly pull it back toward you.
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 2 Installation
Connecting the Plumbing
Figure 13. LC pump outlet-to-preheat tube inlet connection

Installing the Column

The LC column is placed between two aluminum column mounts that attach to the column 
oven's plate. The aluminum mounts improve the heat transfer from oven to column. 

The LC column secures directly onto the front of the oven plate. The instrument arrives with 
the column mounts already installed. 

To mount the LC column

1. Use a flat blade screwdriver to loosen the mounting screws and to remove and separate the 
column mounts. 

2. Place the column between the column mounts, and replace the mounting screws to secure 
the column in place.

SpectraSYSTEM AS3000SAMPLES

RUN

STOP

ENTER

STATUS

WARNING

MENU

FerrulePump outlet line
Low dead-volume 
unionNut

Tip  To ensure that no air gets into the column, remove air from the solvent lines 
before connecting the column.

Tip  Thermo Scientific columns are usually connected so that liquids flow from left to 
right as you read the label. If you are not using a Thermo Scientific column, refer to 
your column documentation to orient it in the correct direction of flow.
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2 Installation
Connecting the Plumbing
Connecting the LC Column’s Outlet to the Detector’s Flowcell Inlet

The accessory kit includes a 12 in. length of 0.010 in. ID tubing that you can use to connect 
the LC column outlet to a non-SpectraSYSTEM detector’s flowcell inlet. The flowcell of a 
SpectraSYSTEM detector has an inlet line of sufficient length to reach the LC column outlet. 

To connect the LC column’s outlet to the detector’s flowcell inlet

1. Depending on the detector, do one the following:

• For a SpectraSYSTEM detector, using the appropriate high-pressure fittings, connect 
the flowcell’s inlet line to the outlet of the LC column (see Figure 14). 

• For a non-SpectraSYSTEM detector, using the appropriate high-pressure fittings, 
connect one end of the 12 in. length of 0.010 in. ID tubing (found in the accessory 
kit) to the column outlet and the other end to the flowcell inlet.

2. Replace the column oven cover, snapping it firmly into place (see “Installing the Column 
Compartment Cover” on page 27).

Figure 14. LC column outlet-to-flowcell inlet connection

SpectraSYSTEM AS3000SAMPLES 

RUN 

STOP 

ENTER 

STATUS 

WARNING 

MENU RUN STATUS MENU 

STOP 

ZERO UV2000SpectraSYSTEM

ENTER 

Connection between 
the LC column
and the flowcell inlet
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 2 Installation
Installing the Column Compartment Cover
Installing the Column Compartment Cover
To install the column compartment cover

1. Insert the tabs on the bottom of the cover into the front lower edge of the autosampler.

2. Route the solvent lines through the slots on the sides of the column compartment.

3. Snap the top of the cover in place.

Installing the Sample Trays
Your autosampler comes with three sample trays and a supply of vials, silicone and Teflon 
septa, and screw-top vial caps. You can order additional vials from Thermo Fisher Scientific. 
To ensure smooth autosampler operation, use standard size vials. 

Each tray contains 35 vials arranged in seven rows of five (see Figure 15). 

Figure 15. 35-vial autosampler tray

Trays A, B, and C are arranged in the autosampler from left to right. The first tray and vial 
position is A01; the last is C35. 

IMPORTANT  Be sure to use a 40 to 60 mil (1.0 to 1.5 mm) rubber or silicone septum 
with a 5 mil (0.1 mm) Teflon liner on one side.

IMPORTANT  Be sure to use a 40 to 60 mil (1.0 to 1.5 mm) rubber or silicone septum 
with a 5 mil (0.1 mm) Teflon liner on one side.

Vial position 1

Vial position 35
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2 Installation
Installing the Sample Trays
To install the sample trays

1. Hold the tray handle, tilting the back end down (see Figure 16). 

Figure 16. Installing a sample vial tray

2. Insert the tray's runners into the slots in position A at the back of the tub.

3. Lower the front of the tray into place and press down firmly to seat the tray. 

4. Insert the other two sample trays into positions B and C.

Tip  Pull the handle back toward you until the tray snaps into place. Try moving each 
tray from side to side to be sure that it is seated completely. 

IMPORTANT  Be sure that each tray is properly seated. Each tray's upper front edge 
should fit under the upper lip of the tub. If a tray is not completely seated, the 
autosampler does not correctly pick up or return vials to that sample tray.

A

C

B

  

 

Slots

RunnerTub

Sample tray handle 
(front) Tray positions
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 2 Installation
Powering-Up the Autosampler
Powering-Up the Autosampler
Your autosampler arrives with the correct fuses installed. 

To connect the autosampler to line power and power-up the autosampler

1. Locate the power cord in the shipping container (not in your accessory kit).

2. Insert one end into the AC power receptacle on the back panel and the other end to a 
grounded power outlet. 

3. Turn on your instrument by pressing the on/off button on the lower right corner just 
below the front panel (see Figure 14 on page 26). 

During startup, the instrument's self-diagnostic goes through the following sequence:

1. Completes a series of ROM checks.

2. Completes a series of RAM checks.

3. Activates the injection valve.

4. Verifies the proper connections on all installed options.

5. Verifies the proper operation of all sensors.

6. Homes (returns to starting position) all syringes and motors.

Priming the Autosampler
After you have completed the plumbing and power-up procedures and started your 
instrument, you must prime your autosampler to wet all of the lines. To do so, flush all 
syringes and lines with an appropriate solvent.

For complete instructions on using the autosampler keypad controls, see “Keypad Controls” 
on page 57.

CAUTION  Before you turn on the power switch, ensure that the autosampler is connected 
to the building ground (see “Connecting the Autosampler to the Building Ground” on 
page 19).

IMPORTANT  The autosampler is shipped with methanol in the lines. Be sure to use a 
miscible solvent.
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2 Installation
Communication: SpectraNet or Stand Alone
To prime the autosampler 

1. If you have not already done so, fill your flush solvent bottle. 

2. Press the MENU key and select COMMANDS. 

The Commands menu appears (see Figure 17). 

Figure 17. Commands menu

3. Select Flush Sample Syringe to access the menu shown in Figure 18.

4. Press the [+] and [–] keys to select 5000 μL. Then press the ENTER key to initiate the 
flush operation. 

Figure 18. Flush Sample Syringe menu

The autosampler flushes the sample syringe and flush lines with the specified volume of flush 
solvent and returns the syringe to its starting position. The recommended 5000 μL flush takes 
approximately ten minutes. During the flush sequence, a confirmation message is displayed. 

Communication: SpectraNet or Stand Alone
You can configure the SpectraSYSTEM autosampler to send information to other Thermo 
Scientific SpectraSYSTEM modules or to non-SpectraSYSTEM LC instruments, as follows:

• SpectraNet mode: Use the SpectraNet mode as a part of a SpectraSYSTEM 
chromatograph connected to other SpectraSYSTEM modules through the SN4000 
system controller, and controlled by your chromatography data system.

• Stand Alone mode: Use the Stand Alone mode if you hardwired the autosampler to other 
non-SpectraSYSTEM HPLC modules through the remote input and output connectors, 
or connected it to older SpectraSYSTEM and non-SpectraSYSTEM instruments by 
means of specialized cables, communication protocols, or both.

This section contains the following topics:

• SpectraNet Mode

• Stand Alone Mode

• Stand-Alone Communication to Integrators

For complete instructions on using the autosampler keypad controls, see “Keypad Controls” 
on page 57.
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SpectraNet Mode

Configured as a SpectraSYSTEM module using SpectraNET communication and the 
SN4000 system controller, your autosampler is automatically controlled by your 
chromatography data system. The chromatography data system assumes almost all keyboard 
control and coordinates the majority of the autosampler's operations. 

To set up the SpectraSYSTEM modules to communicate with the data system computer 
through the SN4000 controller, follow these procedures:

• “Connecting the SpectraSYSTEM Devices to the SN4000 Controller” on this page

• “Connecting the SN4000 Controller to the Data System Computer” on page 34

• “Setting the Configuration to the SpectraNet Mode” on page 35

To synchronize the input and output signals during a run, follow these procedures:

• “Setting Up the Autosampler and Pump Contact Closure Signals” on page 36

• “Connecting the System Synchronization Harness” on page 37

Connecting the SpectraSYSTEM Devices to the SN4000 Controller

Use RJ11 cables to connect a SpectraSYSTEM UV/VIS or fluorescence detector, a 
SpectraSYSTEM pump, and a SpectraSYSTEM autosampler to the SN4000 controller. Use 
an RJ45 cable and an RJ45 to DB9 adapter to connect the SN4000 controller to the data 
system computer.

To connect the communication cables to the SN4000 controller

1. Turn the SN4000 power switch to the Off position, and then disconnect the 12 V dc 
power supply 

Figure 19 shows the power switch and the Power In port on the back panel of the 
SN4000 controller.

Figure 19. SN4000 controller back panel

ON

RESET

I
O

POWER IN
12VDC

Power 
switch

Power In 
port
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2. Remove the top cover of the SN4000 controller as follows:

a. Turn the SN4000 controller upside down to access the four screws that secure the top 
cover to the case (see Figure 20).

Figure 20. Screws that secure the top cover to the case (bottom view of the controller)

b. Using a #2 Phillips head screwdriver, remove the screws and slide the top cover off the 
case. 

Figure 21 shows the SN4000 PCB.

CAUTION  Before you remove the top cover of the SN4000 controller, turn the power 
switch on the back of the controller to the Off position, and then disconnect the 12 V dc 
power supply.

Two screws

Two screws
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Figure 21. SN4000 PCB

3. Verify that the EPROM firmware version 9.05 (P/N A4636-129) is installed in socket 
U12 on the SN4000 PCB and that sockets U11, U28, and U29 are empty. 

4. To connect a SpectraSYSTEM pump to the SN4000 controller, do the following:

a. Connect one end of an RJ11 6-pin, 4-wire cable to the PUMP port on the SN4000 
PCB. 

b. Route the cable through the access hole on the back panel of the controller.

c. Connect the other end of the cable to the COMM port on the back panel of the 
pump. 

5. To connect a SpectraSYSTEM autosampler to the SN4000 controller, do the following:

a. Connect one end of an RJ11 6-pin, 4-wire cable to the A/S port on the SN4000 
PCB.

b. Route the cable through the access hole on the back panel of the controller.

c. Connect the other end of the cable to the COMM port on the back panel of the 
autosampler.

HOST COM SPARE DET 2 INT DET 1 A/S PUMP

U12 U28

U29U11

U12 socket

RJ11 ports
(for the detector, autosampler, 
and pump connections)RJ45 port

(for the data system 
computer connection) 
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6. To connect a SpectraSYSTEM UV/Vis or fluorescence detector to the controller, do the 
following:

a. Connect one end of an RJ11 6-pin, 4-wire cable to the DET 1 port on the SN4000 
PCB.

b. Route the cable through the access hole on the back panel of the SN4000 controller.

c. Connect the other end of the cable to the COMM port on the back panel of the 
UV/Vis or fluorescence detector.

Connecting the SN4000 Controller to the Data System Computer

To connect the SN4000 controller to the data system computer

1. Connect one end of an RJ45 8-pin, 8-wire cable to the Com port on the SN4000 PCB.

2. Route the cable through the access hole on the back panel of the SN4000 controller.

3. Connect an RJ45 to DB9 adapter to the other end of the cable (see Figure 22).

Figure 22. RJ45 to DB9 adapter

4. Connect the DB9 adapter to one of the RS-232 ports on the back panel of the data 
system computer. 

5. Reinstall the SN4000 controller top cover. Using a #2 Phillips screwdriver, tighten the 
screws that secure the cover to the case.

6. Reconnect the power cable from the 12 V dc power supply to the Power In inlet on the 
back panel of the SN4000 controller.

 

RJ-45 8-Pin

1 8

RJ-45 to DB9
Adapter

RS232
Serial Communication

RJ45 8 pin

RJ45 to DB9 adapter

RJ45 cable jack
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Setting the Configuration to the SpectraNet Mode

To control the SpectraSYSTEM LC system from a data system computer, the 
SpectraSYSTEM autosampler must be set to the SpectraNet communication mode.

To configure your autosampler to use SpectraNet communication 

1. Turn on your autosampler, wait for the power-up sequence to complete, and then press 
the MENU key. 

The main menu appears (see Figure 39 on page 61).

2. Select OPTIONS > Configurations. 

The Configurations menu appears (see Figure 23). 

Figure 23. Configurations menu in SpectraNet mode

3. Move the cursor to the Mode field, and press the [+] and [–] keys to select SpectraNET. 
Then press ENTER to accept the field value and exit the Configurations menu.

 Sample Syringe  250 

 Prep Installed No

---------------------------------------------------------

 Oven Installed Yes 

 TrayTemp Installed No 

 Key Repeat Rate Medium 

 File Name Protect 

 1:                                Off 

 2:          Off 

 3:         Off 

 4:      Off 

Mode SpectraNet

 Solv Viscosity Normal 
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Setting Up the Autosampler and Pump Contact Closure Signals

Before you can control the run timing of the SpectraSYSTEM modules from a data system 
computer, you must configure the polarity of the contact closure signals for both the 
autosampler and the pump.

To set up the autosampler’s contact closure signals

1. On the autosampler keypad, press the MENU key.

The main menu appears (see Figure 39 on page 61).

2. Press the LEFT ARROW ( ) or RIGHT ARROW ( ) key to select OPTIONS, and 
then press the ENTER key. 

3. Press the DOWN ARROW ( ) key to select Input Polarity, and then press the ENTER 
key.

The Input Polarity screen appears with Pump Ready Active selected (see Figure 24).

Figure 24. Input Polarity screen

4. Use the [+] and the [−] keys to select Hi. 

5. Press ENTER to accept the field value and exit the Configurations menu.

To set up the pump’s contact closure signals

1. On the pump keypad, press the MENU key.

2. Press the LEFT ARROW ( ) or RIGHT ARROW ( ) key to select OPTIONS, and 
then press the ENTER key. 

3. Press the LEFT ARROW ( ) or RIGHT ARROW ( ) key to select More, and then 
press the ENTER key.

The More menu for the pump appears.

Figure 25. More menu for the SpectraSYSTEM pump

Pump Ready Active   Hi
Inj Hold Active    Lo

Pressure Units PSI
Purge Mode   Flow
Delay Volume 0.0
Cursor Speed Medium
Status Lock Off
Ready Output Active Hi
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4. Press the DOWN ARROW ( ) key to select Ready Output Active, and then press the 
ENTER key. 

5. Press the [+] and the [−] keys to select Hi. 

6. Press the ENTER key to accept the value and exit the More menu.

Connecting the System Synchronization Harness

The timing of the SpectraSYSTEM modules is synchronized through a contact closure wiring 
harness (see Figure 26). The harness has one connector each for the pump, detector, and 
autosampler.

Figure 26. Contact closure wiring harness for the SpectraSYSTEM LC system

To connect the system synchronization harness

1. Connect the cable labeled PUMP to the 8-pin terminal on the back panel of the 
SpectraSYSTEM pump (see Figure 27).

2. Connect the cable labeled AS to the 12-pin terminal on the back panel of the 
SpectraSYSTEM autosampler (see Figure 27).

3. Connect the cable labeled DET to the 12=pin terminal on the back panel of the detector 
(see Figure 27). 
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Note  For information on connecting the SpectraSYSTEM UV8000 Vacuum Degasser 
and PDA Detector module to the LC pump and autosampler, refer to the SpectraSYSTEM 
UV8000 Vacuum Degasser and PDA Detector Hardware Manual.
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Figure 27. Contact closure connections for a typical SpectraSYSTEM LC system
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Stand Alone Mode

Use the Stand Alone mode to operate SpectraSYSTEM modules without data system control.

With the 12-pin terminal on the instrument's back panel, you can hardwire the injection 
synchronization signals between your autosampler and other components in an LC system 
(see Figure 28). 

Figure 28. 12-pin terminal

Use a combicon connector (found in the accessory kit) to attach control wires from other LC 
devices to the 12-pin terminal. Once you have made all the connections, you can make and 
break connections without disturbing individual wires.

To connect a wire to the combicon connector

1. Loosen the appropriate screw.

2. Insert the wire.

3. Tighten the screw. 
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With hardwire communications, the autosampler can start and stop a pump or detector, begin 
a gradient program (gradient pumps only), or control other features of the externally 
connected instruments. In addition, the terminal has four timed-function outputs that you 
can use to control valve-switching devices or other devices on a timed basis. To set up a 
timed-events program, see “Timed Events Menu” on page 72. 

To set up your stand-alone system, follow these topics as appropriate:

• “Input and Output Terminal Specifications” on this page

• “Pin Assignments” on page 41

• “Recommended Hardwire Connections for a Stand-Alone System” on page 42

• “Communications Menu Parameters” on page 43

• “Setting the Polarity of the Autosampler Signals” on page 44

• “Stand-Alone Communication to Integrators” on page 46

• “ChromJet or DataJet Communication” on page 47

• “BCD Communication” on page 47

• “Ready Participation” on page 48

• “Hardware Configurations” on page 49

Input and Output Terminal Specifications

The twelve terminals on the autosampler’s back panel can be divided into two groups: outputs 
and inputs. 

The output terminals, including Time Functions 1 through 4 (TF1-4), are open-collector 
outputs capable of sinking (handling) currents up to 600 mA at voltages up to 24 VDC. The 
active state is user programmable in the Timed Events menu (see “Timed Events Menu” on 
page 72).

The input terminals accept TTL-level inputs, with a transition activating each. The two 
inputs are tied to +5 VDC through pull-up resistors. A "Lo" level is from 0 to 0.8 V; a "Hi" 
level is from 2 to 5.5 V. 

IMPORTANT  All inputs and outputs are referenced to ground.
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Pin Assignments

Table 1 list the input and output pin assignments.

Table 1. Input and output pin assignments  (Sheet 1 of 2)

Pin # Assignment

Pin 1
GROUND:

Use this pin as the ground reference used for all inputs and outputs.

Pin 2
+5VDC: 

Use this regulated +5 VDC supply to power pull-up resistors or external relays. The current 
is limited to a maximum of 300 mA to protect against external short circuits affecting the 
autosampler's operation. 

Pin 3
PUMP STOP 
(output):

Use this pin to send a pulsed output signal to stop the pump after the last sample has been 
processed. It is activated when the last sample in the queue has completed its last injection, 
or when the shutdown file has been activated (using the special shutdown command). For 
more information on the Shutdown command, see “Automated Shutdown in the Stand 
Alone Mode” on page 123. 

Pin 4
GRADIENT START 
(output):

Use this pin to send a signal to the pump to start its gradient program. The autosampler 
send this signal at a specified amount of time before it activates the Inject Out pin. The 
time is specified as the Gradient Delay value in the More menu (under Files). This 
momentarily active, preinjection signal permits the gradient to start prior to sample 
injection to compensate for the system delay volume. The result is an injection that occurs 
just as the gradient front reaches the injection valve. For more information on the gradient 
delay function, see “Gradient Delay.”  

Pin 5
PUMP READY 
(input):

Through this input, the pump signals the autosampler that the mobile-phase flow rate is 
stable and that the pump is ready for an analysis to begin. (You can connect other devices 
here as well.) This input must be continuously active for the autosampler to proceed with 
injections. From the Input Polarity menu, you can select whether a high or low level on this 
line means "ready." The default is Hi. 

Pin 6 
INJECT OUT 
(output): 

Use this output pin to synchronize the timing of external devices (pumps, detectors, 
integrators, and so on) to the autosampler injection. This line sends a momentary signal 
each time the autosampler makes an injection. For the specifications of this output, see 
“Input and Output Terminal Specifications” on page 40.

Pin 7
INJECT HOLD 
(input): 

Use this input pin to keep the autosampler in the hold state with sample in the loop. 
Releasing the hold causes an immediate injection. The signal must remain continuously 
active to hold injections. That is, when active, this signal delays an imminent injection 
until this line goes to the inactive state. You can use this function with external equipment 
to precisely control the timing of the injection valve activation. You can select the active 
level (Hi or Lo) of this input in the Input Polarity menu. 
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Recommended Hardwire Connections for a Stand-Alone System

The recommended setup for a stand-alone LC system requires a pump, autosampler, UV/VIS 
or fluorescence detector, and an integrator. For best results, connect the following signals:

• Pump Ready

• Inject Hold (detector ready)

• Detector Run/Start

• Integrator Run/Start

To wire the appropriate pin connections, see Table 2. Pin connections for the 
SpectraSYSTEM modules are indicated in parentheses. 
 

Figure 29 illustrates the hardwire connections for the SpectraSYSTEM modules.

Pin 8
A/S READY
(output):

Use this pin to signal to other devices that the autosampler is in a READY condition. 

Pins 9 thru 12
TF1-TF4 
(timed outputs):

Use these user-programmed outputs to trigger column-switching valves or other external 
hardware. The time functions defined in the currently active file control these outputs (see 
“Timed Events Menu” on page 72). 

Table 1. Input and output pin assignments  (Sheet 2 of 2)

Pin # Assignment

Table 2. Pin connections for a stand-alone system

Autosampler 
(pin connection) Pump Detector Integrator

Ground (1) Ground (3) Ground (9) (11) Ground (B1)

Pump Stop (3) 
(pulsed output)

Pump Stop (5) N/A N/A

Pump Ready (5) 
(input)

Pump Ready (1) READY (4) N/A

Inject Out (6) N/A RUN/START (10) RUN/START "A" (B5)
RUN/START "B" (B14)

Inject hold (7)*

* Indicates optional connections

Sync (8) N/A N/A

Gradient Start (4) Run Grad (7) N/A N/A
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Figure 29. Hardwire connections for the SpectraSYSTEM modules

Communications Menu Parameters 

For normal stand-alone operation, you do not need to change any of the values in the 
Communications menu. Keep the communications parameters set to the default values (see 
Figure 30). The following details for changing the polarity are provided for reference only.

Figure 30. Communications menu with the default values for stand-alone operation
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These are the allowable entries and default values for the Communications parameters.

To access the Communications menu

From the OPTIONS menu, select Communications.

Setting the Polarity of the Autosampler Signals

From the OPTIONS menu you can change the polarity of your autosampler's input and 
output signals as required by your other LC system modules. For example, when shipped, the 
Autosampler Ready Output is set to send a positive voltage (Hi) when the instrument is ready. 
If you change the Autosampler Ready Output Polarity to Lo, the instrument sends a 0-volt 
signal (Lo) when it is ready. 

The following procedures explain how to change the polarity of the input and output signals. 

To change the polarity of an input signal

1. From the OPTIONS menu, select Input Polarity. 

2. Press the [+] and [–] keys to select either Hi or Lo for the desired input signal shown in 
Figure 31. 

Figure 31. Input Polarity menu

This menu shows the level for the active state for each input signal.

Parameters Allowable entries Default values

Baud Rate 1200, 2400, 4800, or 9600 Bd 9600 Bd

Parity None, Even, or Odd None

Flow Control None or XON/OFF None

Data Bits 8 or 7 8

Stop Bits 1 or 2 1

Echo On or Off On

Tip   If the Communications menu does not appear as one of the OPTIONS menu 
choices, return to OPTIONS > Configurations, and verify that Mode is set to Stand 
Alone. The Communications field does not appear in the OPTIONS menu if Mode 
is set to SpectraNET. 

Tip  To determine the current state of a particular signal, return to the main menu, 
and select TESTS > Display Input States.
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To change the polarity of an output signal

From the OPTIONS menu, select Output Polarity. Press the [+] and [–] keys to select 
either Hi or Lo for the desired output signal shown in Figure 32. 

Figure 32. Output Polarity menu

This menu shows the level for the active state for each output signal.

Table 3 and Table 4 show the output signal levels relative to the polarity settings and 
instrument status for the autosampler's input and output signals, respectively.

Tip   To determine the current state of a particular signal, return to the main menu, 
and select TESTS > Display Output States.

Table 3. Input signal levels

Signal State Polarity

Hi Lo

Pump Ready Ready Hi*

* Default settings

Lo

Not Ready Lo Hi

Inj Hold Active Hi Lo*

Inactive Lo Hi

Table 4. Output signal levels

Signal State Polarity

Hi Lo

Autosampler Ready Ready Hi Lo*

* Default settings

Not Ready Lo Hi

Inject Out Active Hi Lo

Inactive Lo Hi*

Gradient Start Active Hi Lo

Inactive Lo Hi*

Pump Stop Active Hi Lo

Inactive Lo Hi*
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Stand-Alone Communication to Integrators

If you are connecting the SpectraSYSTEM LC to an integrator, two specialized 
communication setups are available: 

• Through an autosampler-to-integrator cable to ChromJet or DataJet integrators

• Through a binary-coded decimal (BCD) interface to older Thermo Scientific integrators 
or to non-Thermo Scientific Integrators

Before using either of these communications setups, you must configure your autosampler as 
a stand-alone module.

To configure your autosampler as a stand-alone module

1. Turn on your autosampler, wait for the power-up sequence to complete, and then press 
the MENU key. Select OPTIONS > Configurations to access the Configurations menu 
(see Figure 33).

Figure 33. Configurations menu with the Mode field set to Stand Alone

2. Select the Mode field, and press the [+] and [–] keys to select Stand Alone. Then press 
the ENTER key to accept the field value and exit the Configurations menu.

Your autosampler is now configured as a stand-alone LC module. 
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ChromJet or DataJet Communication

Using an autosampler-to-integrator cable available from Thermo Fisher Scientific, you can set 
up your autosampler to send vial information to a Thermo Scientific ChromJet (SP4400) or a 
DataJet (SP4600) integrator. For this connection you must have an RJ-45-to-RJ-45 cable and 
an integrator adapter (P/N A3981-010). 

To connect an integrator to the autosampler

1. Turn off your integrator.

2. Insert the RJ-45 connector (telephone connector) into the COMM port (telephone jack) 
on the back panel of the autosampler. 

3. Connect the adapter to the other end of the cable. It orients in only one direction. 

4. Plug the adapter-cable end into your DataJet or ChromJet integrator. 

5. Turn on your integrator and type the following:

• BAUD 9600

• POKE#C12D,#FF

6. Hold down the CTRL key and press CALIB. 

This sequence provides you with the four-line report from your autosampler shown in 
Figure 34.

Figure 34. Vial location and injection report

BCD Communication

The BCD communication option provides BCD communication from the SpectraSYSTEM 
AS3000 autosampler to older Thermo Scientific and non-Thermo Scientific integrators and 
computers. This option provides tray- or vial-location information (or both) to devices 
requiring either binary or binary-coded decimal data. If ordered after initial instrument 
delivery, the BCD assembly must be installed by a Thermo Fisher Scientific service 
representative. Installation instructions are provided in the BCD Option Kit. Contact your 
representative for further information. 

IMPORTANT   You must reenter this sequence after any integrator soft reset. For more 
information, refer to the manual supplied with the integrator.
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Ready Participation

Because Enable is the factory setting for all of the selections on the Ready Participation menu, 
the Status screen indicates that the autosampler is ready for operation when these conditions 
are satisfied:

• The door is closed. 

• The column oven is at the set temperature.

• The temperature controller for the tray compartment is at the set temperature.

Customize the settings on the Ready Participation menu to meet your needs. 

To change the settings on the Ready Participation menu

1. From the main menu, select OPTIONS > Ready Participation.

The Ready Participation menu appears (see Figure 35).

Figure 35. Ready Participation menu

2. To change any of the above requirements, select the appropriate line, and press the 
[+] and [–] keys to change ENABLE to DISABLE. 
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Hardware Configurations

Your AS3000 autosampler is shipped with a 100 μL sample loop and a 250 μL sample syringe. 
You can change the syringe sizes from the Configurations menu (see Figure 36). This menu 
also reflects your other installed options (for example, the oven temperature control). If you 
want to adjust the rate at which fields cycle through the available choices, you can change the 
Key Repeat Rate entry. “Protecting Files” on page 91 discusses the File Protect function also 
available from this menu.

Figure 36. Configurations menu

Performance Verification
After you install your SpectraSYSTEM autosampler, run a standard sample, such as a 
0.5 percent mixture of toluene in methanol, to verify the instrument's proper operation. In 
addition, you can use the following procedures to test your instrument's reproducibility and 
sample carryover, and to troubleshoot and maintain the instrument in the future. 

This section contains the following topics:

• “Reproducibility” on page 50

• “Sample Carryover” on page 52

 Sample Syringe  250 

 Prep Installed No

---------------------------------------------------------

 Oven Installed Yes 

 TrayTemp Installed No 

 Key Repeat Rate Medium 

 File Name Protect 

 1:                                Off 

 2:          Off 

 3:         Off 

 4:      Off 

Mode SpectraNet

 Solv Viscosity Normal 

Tip  Before beginning the performance verification runs, you might want to familiarize 
yourself with the autosampler's command center if you are controlling the autosampler in 
the Stand Alone mode. 

For information on the autosampler’s command center, see Chapter 3, “Keypad 
Controls.” 
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Reproducibility 

Use this procedure to measure your autosampler's injection reproducibility. In this procedure, 
you inject several volumes of a standard sample of 0.5 percent toluene/MeOH, determine the 
percent relative standard deviations (%RSD) for the injection volumes, and compare them 
with the desired results included in this section. The test takes approximately three hours. 
Retain these results for comparison to troubleshoot the injection system, if necessary.

Use the chromatographic conditions listed in Table 5 to test the autosampler’s injection 
reproducibility. 

Test Setup

To set up the test run 

1. Fill five vials with the test sample and place them in tray positions A01 through A05.

2. Check for leaks. 

3. Initialize your pump.

4. Prepare your detector for a run.

5. If you are not acquiring data through a data system computer, prepare your integrator.

6. Inspect all sample lines for bubbles. (Be sure to check the Teflon line that connects to 
port 3 of the injection valve.) 

7. Do one of the following:

• If the autosampler is set up as a stand-alone module, go to step 8.

• If the autosampler is controlled from a data system, go to step 9.

8. For stand-alone operation, do the following:

a. Create a file using the Injection menu parameters shown in Figure 37.

Table 5. Injection reproducibility test method

Column: 4.6 × 100 mm Spheri-5 RP18, 5 micron

Flow rate: 1.5 mL/minute

Mobile phase: 100% HPLC-grade methanol

Flush solvent: 100% HPLC-grade methanol

Test sample: 0.5% toluene in methanol (v/v)

Detection: 254 nm

Run time: 3 minutes
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Figure 37. Injection menu performance verification parameters

b. Return to the Edit menu.

c. Access the More menu and verify that the Needle Height is set to 2.0. (Do not 
change any other parameters in this menu.)

d. Return to the main menu and load your file.

e. Press the SAMPLES key and set up a sample queue that contains five sample sets of 
one vial each. For each sample set, enter the following Sample menu values:

Inj/Sample 10
Cycle Time 1.5
No. Vials 1

Vary the injection volume (Inj Vol) for each set using the values listed in Table 6.

f. Return to the main menu.

g. Flush the syringe with 500 μL of flush solvent. From the main menu, select 
COMMANDS > Flush Sample Syringe.

h. Press the RUN key.

9. For SpectraNet control, do the following:

a. Use the partial loop injection method for the autosampler and the method 
parameters listed in Table 5. 

b. Set up a sequence that makes 10 injection per sample using the injection volumes and 
sample vial locations listed in Table 6. 

c. Start your sequence run.

The autosampler makes 50 injections. The first group of ten injections is used to equilibrate 
the system, so do not use the data from these injections. 

Table 6. Reproducibility test sample queue parameters

Sample set Inj Vol. (μL) Sample vial

1 10 A01

2 1 A02

3 3 A03

4 7 A04

5 10 A05
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Test Results—%RSDs

Determine the percentage of relative standard deviations (%RSD) for the injection volumes 
and compare them with the desired results in Table 7. 

If your results are other than expected, see Chapter 7, “Troubleshooting.” 

Sample Carryover

Use this procedure to verify that the sample carryover is below the 0.01 percent specification 
for your autosampler. It requires the use of silicon septa, the appropriate volume of the 
required flush solvent, and clean (not previously used) blanks. The procedure minimizes the 
effects of sample concentration or chemistry, chromatographic conditions, detector linearity, 
or other hardware characteristics that might affect sample carryover.

This procedure is independent of sample- and system-specific characteristics. It reduces 
sample effects including extinction coefficients, chemical interaction with other sample or 
system components (the column), and sample degradation. It also minimizes system effects 
including detector linearity, pump and mixing anomalies, and column and guard-column 
contamination. 

In this procedure you inject your sample using the push loop injection type, a subsequent 
blank (BLANK1), additional blanks to return the system to baseline, and then a standard 
(STANDARD) that is 0.01 percent of your sample. You determine the carryover percentage 
by multiplying the ratio of the carryover by the 0.01 percent specification:

Carryover = [Peak AreaBLANK1/Peak AreaSTANDARD] × 0.01%

If desired, run this procedure three times to replicate the results. 

Table 7. %RSD results for the reproducibility test

Volume (in μL) %RSD

1 <1*

* Typical value

3 <0.7*

7 <0.5*

10 <0.5**

** Instrument specification
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Carryover Test Materials

Performing this procedure requires the following:

• Your sample

• 21 vials, septa, and caps

• Autosampler

• Any HPLC pump, detector, and data system

Carryover Test Sample Preparation 

To prepare your sample and standard 

1. Place appropriate volumes of sample and starting mobile phase into a vial labeled 
SAMPLE.

2. Dilute your sample 10000-fold in starting mobile phase and pipette into a vial labeled 
STANDARD.

Example:

1. The sample is 100 mg protein in 1 mL phosphate buffer (SAMPLE).

2. Transfer 1 μL of SAMPLE into a 10 mL volumetric flask and dilute to volume with 
phosphate buffer (STANDARD).

Carryover Test Blank Preparation

To prepare your blanks 

1. Pipette fresh starting mobile phase into three sets of five vials.

2. Label vials as BLANK, BLANK1, BLANK2, BLANK3, and BLANK4 for each test set.

Carryover Test Procedure

To set up your system

1. Prepare the appropriate mobile phase or phases.

2. Set up the appropriate chromatographic conditions for your sample.

3. Set up your integrator/data system so that it displays retention times and peak area 
information.
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To set up the autosampler injection parameters

1. Set the flush volume to 2000 μL and the injection type to PushLoop. 

2. Enter an appropriate injection volume.

Enter an injection volume no greater than 40 percent of the nominal sample loop size. 
For example, for a 100 μL sample loop, do not enter an injection volume greater than 
40 μL.

3. Set the number of injections to 1.

To inject the sample set

1. Place the vials in the tray as follows:

A01: BLANK
A02: SAMPLE
A03: BLANK1
A04: BLANK2
A05: BLANK3
A06: STANDARD
A07: BLANK4
(Add additional Blanks as necessary to return the detector signal to baseline before 
replicating the test.)

2. Set up a sequence or an autosampler file to make one injection per vial.

3. (Optional but recommended) Set up two additional groups of seven vials to run the 
carryover test in triplicate.

4. Run your HPLC system using the appropriate chromatographic conditions for your 
sample. 

Tip  To set the flush volume and the injection type from the keypad controls, press the 
MENU key, and then select Files >  Edit > More. Scroll down and select Flush 
Volume. Press the [+] or [–] keys to select 2000 μL. Scroll and select Injection Type, 
and then select Push Lo.

Tip  To enter the injection volume from the keypad controls, press the MENU key, 
and then select Files > Edit > Injection. In the Injection Volume field, use the [+] and 
[–] keys to enter the injection volume.

Tip  To enter the number of injections from the keypad controls, press the MENU 
key, and then select Files > Edit > Injection. In the Injections/Sample field, use the 
[+] and [–] keys to enter 1.

IMPORTANT  Make sure that the sample is soluble in the flush solvent. For best 
results, use the same solvent composition for the flush solvent and the mobile phase.
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Carryover Calculation

To calculate the percentage of sample carryover

1. Divide the peak area of BLANK1 by the peak area of the STANDARD. This gives you 
the ratio of the carryover to the 0.01% specification.

2. Multiply this value by 0.01% to obtain the carryover percentage.

Example:

If the peak area for BLANK1 is 110958 counts, 
and the Peak area for the STANDARD is 656283 counts,
the ratio of the carryover to the specification is 110958/656283 or 0.1691.
% carryover = 0.1691 × 0.01% 
% carryover = 0.001691
Thermo Scientific SpectraSYSTEM AS3000 Autosampler User Guide 55





3

Keypad Controls

This chapter introduces you to the autosampler's command center, provides you with three 
basic rules for using the keypad controls to navigate through the menu screens, and shows you 
how to make an injection using the keypad controls.

For more information on using the keypad controls, see Chapter 4, “Standalone Operation 
from the Command Center.”  If you are controlling the autosampler from a data system 
computer, refer to the Help provided with the data system for information on operating the 
autosampler.

Before you start this chapter, be sure that you read the Safety Information section and install 
your autosampler as described in Chapter 2, “Installation.”  

Command Center
The SpectraSYSTEM autosampler has a keypad and two-line display on the front panel 
(see Figure 38). This is the command center where you access menus and control the 
instrument's operations. 

Contents

• Command Center

• Keypad Functions

• Menus and Screens

• Messages

Note  As you proceed through this chapter, you can explore the general architecture of 
your autosampler’s menus and screens. You can also use this topic “SpectraSYSTEM 
AS3000 Menus” on page 151 as a guide.

To make your first injection, follow the procedures in “Standalone Operation from the 
Command Center” on page 63 or this two-page guide “Quick Start: Starting Runs from 
the Command Center” on page 155.
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Command Center
Figure 38. Command center for the SpectraSYSTEM autosampler

Navigating the autosampler menus assumes these three rules:

1. The arrow keys , , ,  move the cursor in the direction printed on the key. 

2. The shape of the cursor determines how you make a selection:

• If a triangular cursor appears, press the ENTER key.

• If a blinking square cursor  appears, press the [+] or [–] keys to scroll up or down 
through preset choices, or to increase or decrease alphanumeric entries. 

3. There are four ways to accept (and automatically save) an entry. Move the cursor out of 
the field by any of the following methods: 

• Pressing the ENTER key

• Using the arrow keys

• Pressing the MENU key

• Pressing the STATUS key

Tip  Press the MENU key to jump quickly to the top of the menu structure.

Note  You cannot leave a menu if errors are present or if you have not completed all 
the necessary entries.

RUN

STOP

Samples SpectraSYSTEM AS3000

ENTER

STATUS MENU

FILES QUEUE TESTS
 COMMANDS OPTIONS
58 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 3 Keypad Controls
Keypad Functions
The autosampler display follows these conventions:

• Top-level menu choices appear in all-capital letters, except for Samples. 

• A field's square cursor changes to an underscore cursor when you scroll through preset 
choices or enter numerical values and characters.

• A solid arrow, , on the right side of some displays indicates that the current menu 
continues on additional screens. To access additional menu lines, press the 
DOWN ARROW key ( ) on the keypad. 

• The last line of a longer menu is frequently a blank display line (without a solid 
arrow, ).

Keypad Functions
The keypad of each SpectraSYSTEM instrument consists of twelve keys. Four keys directly 
control the instrument's operation: RUN, STOP, STATUS, and, on the autosampler, a blank 
key called Samples. The remaining keys either access commands (MENU and ENTER), or 
are used to set parameters and move around the display keys ( , , , , [+], [–]).

Table 8 describes each key’s function. 

Table 8. SpectraSYSTEM keypad functions  (Sheet 1 of 2)

Keys Functions

RUN Starts the run. The specific RUN operation depends on the contents 
of the sample queue:

• If there are sample sets (groups of sample and associated 
calibration vials) in the sample queue, pressing the RUN key 
begins processing the first vial in the sample set.

• If the sample queue is empty, pressing the RUN key prompts you 
to press the Samples key to display the Samples menu so that you 
can add sample sets to the sample queue. 

STOP Pauses the sample set currently running, cancels subsequent sample 
sets, and returns the autosampler to the initial run conditions. For 
more information on the STOP key's function, see Chapter 4, 
“Standalone Operation from the Command Center.” 

STATUS Displays the Status screen. From the Status screen you can monitor the 
run in progress.

Note Unlike the other SpectraSYSTEM instruments, on the 
autosamplers you can make changes to the run in progress from the 
Samples key rather than from the STATUS key (see below). 
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Samples The only variable key (unlabeled) in the whole SpectraSYSTEM 
family. (It has a different function on each of the SpectraSYSTEM 
modules.) On the autosampler, the blank key is the Samples key whose 
name appears on the nameplate below it. 

The Samples key displays the Samples menu, which you use to define 
the resources (samples, reagents, and standards) and assign a file to 
each sample set. From the Samples menu you also add sample sets to 
the sample queue. 

Because you manage resources and files from the Samples menu, the 
Samples key gives you the real-time editing capability provided by the 
STATUS key on the other SpectraSYSTEM instruments. That is, from 
the Samples menu you can make changes to the file that is currently 
running. By pressing the Samples key during a run, you can obtain 
information about, or edit the locations and injection volumes of, the 
sample and calibration vials. Chapter 4, “Standalone Operation from 
the Command Center,”  contains more information on the Samples 
key.

MENU Displays the main menu (see Figure 39). For more information, see 
“Main Menu” on page 61.

ENTER Accepts a selection or menu entry. The ENTER key also advances the 
cursor to a new field, either in the same line of the display or in the 
line below. 

, , , The arrow keys (UP, DOWN, LEFT, or RIGHT) move the cursor in 
the direction indicated on the key. The UP and DOWN ARROW 
keys also move the cursor between menus and displays. 

[+] and [–] Scroll through a field's available choices, or changes the value of 
alphanumeric entries. Holding down either key continuously scrolls 
the list of choices forward or backward until you release the key. 

In fields that require alphabetical or numerical entries, the value of 
each digit is increased or decreased by one unit each time you press the 
[+] or [–] key. In fields that accept either numeric or character entries, 
such as the File Name field, the [+] and [–] keys scroll through the 
alphabet from A to Z; then through the numbers 0 to 9; and finally to 
a slash, hyphen, and blank space. 

In other fields, the [+] key advances you through a preset list of choices 
while the [–] key takes you back through the list. 

Table 8. SpectraSYSTEM keypad functions  (Sheet 2 of 2)

Keys Functions
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Menus and Screens
Your autosampler has two kinds of displays: menus and screens. Menus require you to make 
selections or enter specific values. Screens display read-only information. The menu tree at the 
back of your manual (see “SpectraSYSTEM AS3000 Menus” on page 151) illustrates the 
structure and content of the autosampler's menus and screens. 

Main Menu

The main menu (see Figure 39) is the top level of the menu structure. It gives you access to 
five other menus: FILES, COMMANDS, QUEUE, OPTIONS, and TESTS. To see the 
main menu, press the MENU key at any time. 

Figure 39. Main menu accessed with the Menu key

The tasks associated with each menu follow: 

For more information on any of the autosampler’s menus, see Chapter 4, “Standalone 
Operation from the Command Center,” and Chapter 5, “Diagnostic Procedures.” 

Status Screen

The Status screen automatically appears whenever you turn on the instrument or press the 
STATUS key. The Status screen (see Figure 40) displays the status of the sample queue, the 
current sample set, the current sample vial, and the total number of samples in the set. 

Figure 40. Queue Status screen

Pressing the DOWN ARROW key ( ) displays the Injector Status screen (see Figure 41). 

Figure 41. Injector Status screen

Files menu  Edit, load, or delete files.

Queue menu Edit or change the order of sample sets in the sample queue.

Tests menu Run built-in instrument diagnostics.

Commands menu Run built-in instrument routines.

Options menu Set up or change the autosampler’s configuration. 
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Messages
Pressing the DOWN ARROW key ( ) a second time displays the Oven Temperature Status 
screen (see Figure 42). 

Figure 42. Oven Temperature Status screen

Chapter 4, “Standalone Operation from the Command Center,” contains more information 
on the Status screen. 

Messages
Three different kinds of messages can appear on your autosampler's display: user messages, 
confirmation messages, and error messages. 

User Messages

User messages tell you about an existing instrument condition or ask for further actions. Some 
of these messages only appear on the display for three seconds. All user messages have a single 
asterisk before and after them. Figure 43 shows an example of a user message requiring further 
action. 

Figure 43. User message example

Confirmation Messages

A confirmation message appears for one second after the successful completion of an 
operation. All confirmation messages have a pair of asterisks before and after them. 
Figure 44 shows an example of a confirmation message.

Figure 44. Confirmation message example

Error Messages

An error message appears when the autosampler encounters an undesirable condition that 
prevents it from carrying out an operation. All error messages have a pair of exclamation 
points before and after them. An error message remains on the screen until you press a key. 
Figure 45 shows an example of an error message.

Figure 45. Error message example
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Standalone Operation from the Command Center

This chapter describes how to use the autosampler’s front panel controls to specify the 
injection parameters for your chromatographic methods and the vial locations for your 
injection sequences. Use these controls if you are not controlling the autosampler from a 
chromatography data system.

If you are controlling the autosampler from a chromatography data system, use the data 
system to create methods with the appropriate injection parameters and to create injection 
sequences with the appropriate vial locations. For information on controlling the 
SpectraSYSTEM autosampler from the data system, refer to the Help provided by the data 
system.

Before beginning this chapter, be sure that you have completed the Startup Checklist found in 
the beginning of this manual, installed your instrument according to the procedures described 
in Chapter 2, “Installation,”  and understand the keypad controls as described in Chapter 3, 
“Keypad Controls.” 

Contents

• Run Preparation

• Starting a Run by Pressing the Run Key

• Monitoring the Run Status

• Changing the Run in Progress

• File Management

• Needle Height

• Optimization

• Special Commands in the Commands Menu
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Run Preparation
Run Preparation
Using the front panel controls for the SpectraSYSTEM autosampler, you can process up to 
39 non-priority sample sets (groups of sample vials and associated calibration vials) within a 
given run. 

This section covers the following procedures, along with the instrument's file-management 
features. 

• “Creating a File” on this page

• “Saving a File” on page 77

• “Loading a File” on page 77

• “Building a Sample Queue” on page 78

• “Entering Your Other LC Parameters” on page 81

Creating a File

A file contains the autosampler parameters applied to a specific sample set. 

You can create up to four unique files numbered 1 through 4. From the Edit menu, you can 
name your file and access additional menus to enter injection, calibration, timed events, and 
other run parameters. 

Figure 46 shows the Edit menu. Selecting the Injection, Calibration, Timed Events, or More 
item opens an additional menu.

Figure 46. Edit menu 

IMPORTANT  Be sure that your sample or samples are completely soluble in the mobile 
phase and that you have filtered your samples and solvents through a 0.45-micron filter. 
These techniques minimize sample precipitation in the lines and remove any particulate 
matter that could obstruct the flow through the autosampler's injection valve or the LC 
column. Fill the solvent reservoir with flush solvent.

Tip  The following procedure describes how to create an edit file. For information on 
starting a run, see “Loading a File” on page 77.
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To create a file

1. Specify a number and a name for the file.

a. Press the MENU key.

The main menu appears (see Figure 39 on page 61). 

b. Select FILES > Edit. 

The Edit menu appears (see Figure 46 on page 64). 

c. In the Edit File field, select 1, 2, 3, or 4. 

The file number identifies the file.

The Edit File field indicates the number of the selected file. File 1 automatically appears 
in this field when the Edit menu is first displayed. If you want to edit a different file, press 
the [+] and [–] keys to select a different file number. 

2. (Optional) In the File Name field, enter a name for this file.

When you first display the Edit menu, the File Name field contains eight blank 
characters. Press the [+], [–],  UP ARROW , and DOWN ARROW  keys to create 
a file name using the following characters: A to Z, 0 to 9, \, blank, dash, or hyphen. 

3. Select the injection type as follows:

a. Press the DOWN ARROW key ( ) until the cursor reaches the More menu item, 
and then press ENTER.

b. Press the DOWN ARROW key ( ) until the cursor reaches the Injection Type 
menu item, and then press ENTER.

c. Select the injection type.

4. Make the appropriate entries in these menus:

• “Injection Menu” on page 66

• “Calibration Menu” on page 69

• “Timed Events Menu” on page 72

• “More Menu” on page 74

When you exit the file, the autosampler automatically saves the file.
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Injection Menu 

Use the Injection menu to specify the injection volume, the number of injections per sample, 
the time between injections, and the temperature of the autosampler’s controlled temperature 
zones.

Figure 47 shows the Injection menu and Table 9 describes the parameters in the Injection 
menu. 

Figure 47. Injection menu (AS3000 autosampler)

To specify the injection parameters

1. From the main menu, choose File > Edit > More.

2. Select the appropriate injection type (see “More Menu” on page 74).

3. Choose File > Edit > Injection.

4. In the Injection Volume field, do one of the following:

• For the full-loop injection type, select the appropriate loop size.

The selections depend on the syringe size (see “Injection Volume or Loop Size” on 
page 67).

• For the pull-loop injection type, enter an injection volume from 0.1 to 212 μL for 
the 250 μL syringe.

• For the Push Lo injection type, enter an injection volume from 0.1 to 10 μL.

• For the Push Hi injection type, enter an injection volume from 0.1 to 200 μL.

5. In the Injections/Sample field, enter the number of injections that you want the 
autosampler to make per sample vial.

6. In the Cycle Time field, enter the initial time between injections.

7. In the Oven field, select On to activate temperature control, and then enter the 
appropriate column oven temperature from 15 to 80 °C, in one-degree increments.

8. In the Tray Temp field, select On to activate temperature control, and then enter the 
appropriate tray compartment temperature from 0 to 60 °C, in one-degree increments.

After you complete the injection parameters, the cursor moves to the Calibration menu 
item. 
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Run Preparation
Table 9. Injection menu parameters  (Sheet 1 of 2)

Parameter Description

Injection Volume or 
Loop Size

Specifies the injection volume or the loop size. 

The selections or range depends on the injection type and the syringe size. 

Injection Type Selection or range

Loop Size
(Full-loop injection)

The selections depend on the syringe size.

Syringe size Selections

250 μL 5, 10, 20, 50, and 100 μL

500 μL 5, 10, 20, 50, 100, and 200 μL

1000 μL 5, 10, 20, 50, 100, 200, and 500 μL

2500 μL 5, 10, 20, 50, 100, 200, 500, and 1000 μL

5000 μL 5, 10, 20, 50, 100, 200, 500, and 1000 μL

IMPORTANT  Be sure that the Loop Size field value reflects the 
size of the sample loop.

Pull The maximum injection volume depends on the syringe size.

Syringe size Maximum injection volume

250 μL 212 μL

500 μL 461 μL

1000 μL 956 μL

2500 μL 1500 μL

5000 μL 1500 μL

Push Hi Range: 0.1 to 10.0 μL

Push Lo Range: 1 to 200 μL

IMPORTANT  For a variable-loop injection, limit the injection 
volume to approximately one-half the sample loop size.

Injections/Sample Specifies the number of injections to be made from each vial (1 to 99). 
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Cycle Time Specifies the time (0 to 655.3 minutes) between injections (from the injection to the end of 
the run). In calculating this value, be sure to allow enough time for the column to 
equilibrate (if you are running a gradient), for all peaks to elute from the column, and for 
the integrator to print any post-run reports and perform any post-run calculations. 

The autosampler is capable of making an injection approximately every 90 seconds, 
depending on the injection and flush volumes selected. If a Pump Ready contact closure 
controls your cycle time, you may set the Cycle Time to 0.0. 

Tip  The default flush volume is 400 μL so that the total injection cycle time (including 
the flush cycle) is approximately two minutes.

Column Oven Appears only if the Column Oven is set to ON in the Configurations menu. 

Selections: On or Off
Temperature range: 15 to 80 °C, in one-degree increments

Tip  

• You can specify temperatures starting at 5 °C above ambient. 

• When you set the oven's state to On, the oven does not activate (turn on) until you 
load your file.

• The autosampler automatically delays the start of the run until the oven reaches the 
set temperature. Once activated, the oven requires about 15 minutes to reach a 
temperature of 70 °C. To save time, you might want to load your file so that the oven 
can be warming up while you are completing your run preparation and entering the 
file parameters for your run. For more information on loading your file, see “Loading 
a File” on page 77.

Tray Temperature 
Control 

Appears if the Tray Temperature is set to ON in the Configurations menu. 

Selections: On or Off
Temperature range: 0 to 60 °C, in one-degree increments

For more information, see “Autosampler Components” on page 2.

Tip  

• When you set the tray temp state to On, the tray temperature controller does not 
activate (turn on) until you load your file.

• Once activated, if empty, the tray compartment requires about 30 minutes to reach a 
temperature of 0 °C and about 10 minutes to reach a temperature of 60 °C. To save 
time, you might want to load your file so that the tray compartment can be warming 
up while you are completing your run preparation and entering the file parameters for 
your run. For information on loading your file, see “Loading a File” on page 77.

Table 9. Injection menu parameters  (Sheet 2 of 2)

Parameter Description
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Calibration Menu

Use the Calibration menu to set up the calibration parameters, such as the number of 
calibration levels and the number of sample injections between calibration sets, for your 
sample set. 

Figure 48 shows the Calibration menu and Table 10 describes the parameters in the 
Calibration menu. 

Figure 48. Calibration menu

To specify the injection settings for the calibration vials

1. From the main menu, choose File > Edit > Calibration.

2. In the Number of Levels field, select the number of calibration levels for your application.

3. In the Samples/Calibration field, select the number of sample vials between calibration 
vials.

4. In the Injections/Level field, select the number of injections that you want the 
autosampler to make from each calibration vial.

5. In the Injection Volume or Loop Size field, select the injection volume for the calibration 
vials or the loop size (full-loop injection type).

For information on the injection volume range or loop size selections, see “Injection 
Volume or Loop Size” on page 67.

Note  You specify the numbers of samples per sample set and the vial locations for samples 
and calibration standards in the Samples menu.

Note  The data system that you use to acquire and process your data files does not 
recognize the information that you enter in the Calibration menu. To process your data 
files, you must create an appropriate processing sequence from your data system that 
contains the appropriate sample and calibration information.
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6. In the Type field, specify whether you want the autosampler to reuse one set of vials for 
the calibration standards or a new set of calibration vials for each calibration set:

• To specify a single location for the calibration vials, select Reuse Same Vials.

If you select Reuse Same Vials, load only one set of calibration vials in the sample 
trays. Specify the location of the first calibration vial in the Samples menu. The 
autosampler determines the number of calibration vials based on your entry in the 
Number of Levels field (see Table 10).

• To specify a new set of calibration vials for each calibration set, select Intersperse 
Vials.

If you select Intersperse Vials, load the trays with a set of calibration vials for each 
calibration set as specified in the Samples/Calibration entry. Specify the location of 
the first calibration vial in the Samples menu. The autosampler determines the total 
number of calibration vials based on your entries in the Number of Levels, 
Samples/Calibration, and Bracket Samples fields (see Table 10).

7. In the Bracket Samples field, select Yes or No.

After you complete the injection parameters, the cursor moves to the Timed Events menu 
item.

Table 10. Calibration menu parameters  (Sheet 1 of 2)

Parameter Description

Number of Levels Specifies the number of calibration levels (0 to 9). 

The autosampler automatically copies this value to the Calib 1Vial 1 (of X) field, in the 
Samples menu, where X equals the number of levels. (For more information, see Calib Vial 
1 (of X) on page 79.) A value of zero in the Number of Levels field indicates that there are 
no calibration injections for the specified sample set. 

Samples/Calibration Specifies the calibration interval (the number of sample vials to be injected between each 
recalibration). 

Injections/Level Specifies the number of injections (1 to 99) from each calibration level (0 to 9). 

Injection Volume or 
Loop Size

See the information on the Injection Volume or Loop Size parameter in the Injection menu 
(Table 9 on page 67).
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Table 11 shows the injection sequence when you select either the Reuse Same Vials or the 
Intersperse Vials calibration routines, as well as the injection sequence when you select 
Bracket, for the following sample set:

• Number of samples: 4

• Calibration levels: 2

• Number of samples between each calibration set: 2

• First calibration location: A01

• First sample location: A03

Use the Calibration menu to specify the number of calibration levels per calibration set and 
the number of samples between calibration sets. Use the Samples menu to specify the number 
of samples and the vial locations for samples and calibration standards.

Type Specifies one of two types of patterns for determining the location of the calibration vials:

Pattern Use

Reuse Same Vials Programs the autosampler to use the same calibration vials each time a 
recalibration is made. When a calibration is required, the autosampler 
goes to the first calibration-vial position specified in the Sample menu 
and injects all the calibration vials. It then injects the number of 
samples indicated in the Calibration menu for Samples/Calibration. 

Intersperse Vials Programs the autosampler to use each calibration vial only once. You 
must manually intersperse your calibration vials between your sample 
vials within the sample set. The autosampler makes injections in 
tray-placement order. 

You specify the location of the first calibration vial in the Samples 
menu. The autosampler uses the value that you enter in the 
Samples/Calibration field to determine the location of subsequent 
calibration vials.

Bracket Samples Specifies whether or not you want to automatically end the sample set with a recalibration. 
If you select Yes, the autosampler processes the last sample and then repeats the calibration 
series specified for the sample set. If you select No, the autosampler stops and returns home 
after it injects the last sample. 

Table 10. Calibration menu parameters  (Sheet 2 of 2)

Parameter Description

Note  The autosampler does not send the calibration and sample information to your 
integrator or data system. To analyze the results of the injection set, you must reenter the 
calibration and sample sequence into your data processing system.
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Timed Events Menu

Use the Timed Events menu to create a time program to turn on/off external devices (such as 
column-switching valves and fraction collectors) at preset times during your run. For timed 
events, the autosampler uses pins 9 to 12 from its 12-pin terminal. For information on 
connecting external devices to your autosampler, see “Stand Alone Mode” on page 39.

Figure 49 shows the autosampler’s Timed Events menu.

Figure 49. Timed Events menu

The Timed Events menu holds a maximum of nine lines, each of which sets Hi or Lo for one 
or more timed event outputs at the times specified. When the TF terminal is set to Hi, it 
presents a +5 V signal. 

Figure 50 shows a timed events program that does the following:

• At 0.5 minutes, turns on the TF2 terminal.

• At 1.00 minutes, turns off the TF2 terminal and turns on the TF3 terminal.

• At 2.00 minutes, turns on the TF2 terminal and turns off the TF3 terminal.

Table 11. Comparison of the total number of vials used for the calibration routine selections

Injection Reuse vials Reuse vials and 
bracket

Intersperse vials Intersperse vials 
and bracket

C A01 A01 A01 A01

C A02 A02 A02 A02

S A03 A03 A03 A03

S A04 A04 A04 A04

C A01 A01 A05 A05

C A02 A02 A06 A06

S A05 A05 A07 A07

S A06 A06 A08 A08

C N/A A01 N/A A09

C N/A A02 N/A A10

Total # of vials 6 6 8 10
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Figure 50. The timed events program described above
d

To add a line to the end of the timed events program 

1. Press the DOWN ARROW key ( ) to move the cursor to the blank line after the last 
displayed line. 

2. Press the [+] key to copy the last existing line with a new time incremented by one 
minute. 

3. Use the arrow keys and the [+] and [–] keys to change the time and set the time functions' 
states (Hi/Lo). 

To delete a line from the timed events program

1. Move the cursor to the Time field in the line to be deleted.

2. Hold down the [–] key until the value is zero (0.00). 

3. Press the [–] key once to erase the line. 

If you are deleting a line from the middle of a timed events program, the blank line remains 
until you move the cursor to another line. 

To insert a line between two existing lines in the timed events program

1. Move the cursor to the blank line at the end of the program. 

2. Enter a time that falls between two existing times. 

3. Move the cursor off the new line. The autosampler automatically inserts the new line.

4. Move the cursor to the newly inserted line or lines and set the Timed Events Outputs' 
states as desired. 

Note  The Run-time clock stops and resets at the completion of the Cycle Time. Time 
lines longer than the Cycle Time value are never activated.

Note  If you delete both of the visible lines on the display, both lines disappear, but the 
cursor remains. Press the UP and DOWN ARROW keys (  or ) to move to the 
remaining lines in the program.
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More Menu

Use the More menu (Figure 51) to enter the remainder of your run parameters.

Figure 51. More menu

Table 12 describes the More menu parameters.

 Equilibration Time 0.0 

 Gradient Delay 0.00 

---------------------------------------------------------

 Viscosity Normal 

 Flush Volume 400 

 Injection Type Push 

 Injection Range .1-10.0 

 Needle Height 2.0 

Table 12. More menu parameters  (Sheet 1 of 3)

Parameter Description

Equilibration Time Specifies the length of time (in minutes) required for the column or LC system to 
equilibrate. The equilibration time allows time for the column to equilibrate prior to the 
first injection of a new sample set. It is only in effect before the first injection. The default 
value of 0.0 is a good starting value for many applications.

Gradient Delay Specifies the amount of time required to allow the mobile phase to travel from the pump's 
proportioning valve to the column. Use this field only if you are running a gradient. To 
determine the gradient delay value, you must calculate the pre-column volume, which is 
best done during installation. To calculate your pre-column volume and gradient 
delay value, see “Gradient Delay” on page 99.

Viscosity Specifies the sample viscosity (Normal, Medium or Viscous). The viscosity setting affects 
the sample syringe draw-rate. A higher viscosity setting automatically decreases the syringe 
draw-rate. 

Tip  Use the Normal setting for running most reversed-phase applications.

Flush Volume Specifies the flush volume. 

Range: 200 to 5000 μL
Default: 400 μL 
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Injection Type For a description of each injection type and the excess sample volume required for injection, 
see “Injection Types” on page 4.

The optimum injection type depends on the amount of sample you have and the degree of 
precision desired. 

Choose from four different injection types:

Full-loop Full- or fixed-loop injection is useful when you want maximum precision 
and have unlimited sample. 

The actual injection volume depends on the loop size. 

Note If you select full-loop injection, the Injection Volume field in the 
Injection menu changes to Loop Size and the Injection Volume field in the 
Calibration menu does not appear.

Pull-loop Pull-loop injection (traditional variable-volume injection) is useful when 
sample conservation is important and when large injection volumes 
(> 100 μL) are required. 

Tip  Use a sample loop that is at least twice the size of the largest injection 
volume. For example, use a 200 μL sample loop or larger to inject 
100 μL.

PushLoop 
(Push Hi)

PushLoop injection (variable-volume method) gives the precision of 
fixed-loop injection with limited amounts of sample. 

PushLoop 
(Push Lo)

Use the PushLoop (Push Lo) method for smaller injection volumes 
(< 10 μL).

Table 12. More menu parameters  (Sheet 2 of 3)

Parameter Description
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Injection Range The Injection Range field displays the injection volume range, depending on the Injection 
Type that you select.

Injection type Range

Full-loop Displays the range: 5 to 1000.

During a full-loop injection, the autosampler overfills the sample loop. 
The actual injection volume equals the physical size of the sample loop, 
which is ± 20 percent of the loop’s nominal size. 

Tip  When you select the Full Loop injection type, the Edit > Injection > Injection 
Volume field changes to Loop Size. The Loop Size selections depends on the configured 
syringe size.

Pull-loop Displays the range: 1 to 1500 μL.

Specify the injection volume in the Injection Volume field of the Injection 
menu.

PushLoop 
(Push Lo)

Displays the range: 0.1 to 10.0 μL.

Specify the injection volume in the Injection Volume field of the Injection 
menu.

PushLoop 
(Push Hi)

Displays the range: 1 to 200 μL.

Tip  For the variable-volume injection types, specify the injection volume in the Injection 
Volume field of the Injection menu.

Needle Height Controls the distance between the needle tip and the bottom of the vial. 

Range: 0.0 to 20.0 mm
Default: 2.0 mm

Table 12. More menu parameters  (Sheet 3 of 3)

Parameter Description
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Saving a File

The autosampler automatically saves your file. Once you have filled in all of the Edit menu 
parameters, you have finished creating your edit file. Exiting the Edit menu automatically 
saves your file but does not load it. For more about file management, see “File Management” 
on page 90.

Loading a File

Use the Load function when you want to run a single sample set manually, for example, to 
turn on your oven or tray heater/cooler. 

To load an Edit file

1. From the main menu, select FILES > Load. 

The Load menu appears.

Figure 52. Load File field

2. Do one of the following:

• To load the last file you edited, press the [+] and [–] keys to select its file number and 
press the ENTER key. 

–or–

• To load a different file, select the correct file number and then press the ENTER key. 

The **File Loaded** message appears. Once a file is loaded, it becomes your run file. 

You use the Load function to run a single sample set; however, if you want to run a group of 
sample sets, press the RUN key from the sample queue. Once you press RUN, the 
autosampler automatically loads each file into the queue before running it. You do not need to 
manually load each file. For more information on running your samples from the sample 
queue, see “Building a Sample Queue” on page 78

Note  Pressing the RUN key after creating your file does not start your run. You must first 
add it to the sample queue. For more information, see “Building a Sample Queue” on 
page 78.
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Building a Sample Queue

The sample queue is the list of sample sets and associated files to be run. Building your sample 
queue requires adding each item to the queue from the Samples menu and then arranging 
those items in the desired run order from the Queue menu. If you run a group of files from 
the sample queue, the SpectraSYSTEM application automatically loads each file before it is 
run. 

To build a sample queue, follow these procedures:

• “Adding Items to the Sample Queue” on this page

• “Changing the Order of Sets in the Queue” on page 80

• “Deleting Sets from the Queue” on page 80

• “Managing a Priority Set in the Queue” on page 81

Adding Items to the Sample Queue

To add an item to the sample queue

1. Press the Samples key to access the Samples menu.

2. Enter each of the values shown in the Samples menu (see Figure 53) and described in 
Table 13.

Figure 53. Samples menu

Tip  Since the method downloads most of the values automatically, the only values 
that require editing are those in the File Number and Vial Location fields. 

File Number field

Vial Location 
fields
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3. After filling in the Samples menu for the first sample set, press the Samples key again. 
This returns you to the top of the menu where you can add the next sample set. 

Figure 54 shows a Queue menu with three sample sets.

Table 13. Samples menu parameters 

Parameter Description

Sample Set Specifies the sample set you want to add to the queue. You can add 
the sample set only once to the sample queue. You can load a 
maximum of 39 sets into the sample queue, plus one priority set. 

File Specifies the file number to be applied to the specified sample set. 
The file parameters determine the sequence of Sample Set 
prompts.

Range: 1 to 4

Injection Volume, 
Injections/Sample, 
and Cycle Time

These values are copied from the Injection menu of the associated 
file. 

Calib Vial 1 (of X) This value is copied from the Calibration menu of the associated 
file. 

Specifies the location of the first vial in the calibration series. 
X is an indicator of the number of calibration levels specified in 
the file. 

Range: A01 to C35

Tip  The vial position automatically wraps.

First Sample Vial Specifies the location of the first sample vial. 

Range: A01 to C35

Number of 
Samples

Specifies the number of sample vials in the sample set.

Range: 1 to 105

Add to Queue Selecting Yes and pressing the ENTER key adds the selected 
sample set to the queue. You can add each set only once to the 
sample queue. 

Selecting No returns you to the Status menu.
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Figure 54. Queue menu with no priority-vial sample sets in the queue 

Changing the Order of Sets in the Queue

To change the order of the items in the queue

1. Move the cursor to the line where you want to change the order.

2. Increment or decrement the set to the new Order value. 

For example, to run sample set 5 before sample set 3, move the cursor to the order 
column of the sample-set 5 line, and decrement the Order value to 1 (see Figure 55).

Figure 55. Queue with three sequential sets

The lines rearrange themselves after you exit the field (see Figure 56).

Figure 56. Queue with reordered sets

Deleting Sets from the Queue

To delete an item from the sample queue

1. Move the cursor to the line containing the item you want to delete.

2. Decrement the Order number to 0 and then blank. 

Moving the cursor to another line deletes the blank line from the display. 

Tip  You can only change Order 1 if the sample set is not active—that is, when you press 
the STATUS key, the QStatus column reads IDLE. 

Changing the run order of set 5 from third to first
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Managing a Priority Set in the Queue

A priority set is inserted into the active set and its samples run before other samples in the 
active set. It must be assigned to the active file. It appears in the Queue menu with a P in the 
Set field (see Figure 57). You cannot assign or change its priority status from the Queue menu. 
A priority set is automatically deleted from the queue upon completion of the active set or 
when the queue (QStatus) returns to its IDLE state (if you press the STOP key). For more 
information on running priority vials, see “Priority Sample Sets” on page 87. 

Figure 57. A sample queue that contains a priority set

Entering Your Other LC Parameters

Prepare your other LC modules for a run and enter the run parameters for your pump, 
detector, and data-output device (recorder, integrator, or data system). Before you start your 
run, complete these tasks: 

• Initialize your pump and degas your solvents as required for your application. 

• Be sure your detector is stabilized. Do not start your analysis until you achieve a stable 
baseline.

• Set up your data-output device. 

For more information on connecting your autosampler to other LC modules, see Chapter 2, 
“Installation.”  

Starting a Run by Pressing the Run Key
Once you have created and loaded your file, added your sample set or sets to the sample 
queue, and installed your sample trays, you are ready to start your run. 

To start a run

1. Load your sample and calibration vials into the trays and install the trays into the 
autosampler tray compartment (see “Installing the Sample Trays” on page 27).

The tray and vial positions from left to right and front to back of the tray compartment 
are A01 to C35. 

2. Press the RUN key. 
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Depending on whether you have loaded sample sets into the sample queue, the status 
screen displays the following:

• If there are sample sets in the sample queue, the RUN status for the sample queue is 
displayed on the Status screen (see Figure 58). 

• If the queue is empty, the autosampler prompts you to access the Samples menu so 
that you can add sample sets to the queue. After you have added sets, press the RUN 
key to start your run. 

Monitoring the Run Status
When you press the RUN key, the autosampler begins processing vials when the temperature 
for the column oven, tray compartment, or both reaches the set point; the equilibration delay 
time (entered in the More menu) has elapsed; and the tray compartment door is closed. If the 
autosampler is connected to an LC pump through a contact closure connection, the 
autosampler also waits until the pump is ready. 

During the run, the Status screen appears (see Figure 58). 

Figure 58. Status screen 

The Status screen gives you four kinds of information (from top to bottom): 

• “Sample Queue Information” on page 83

• “Injection Status” on page 84s

• “File Status” on page 85

• “Temperature Status” on page 85 

Note  You can change the ready requirements by choosing Options > Ready Participation 
and selecting Enable or Disable in each field. See “Ready Participation” on page 48. 

Sample queue status

Injection status

Injection status

Temperature status
82 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 4 Standalone Operation from the Command Center
Monitoring the Run Status
Sample Queue Information

Information on the sample queue is presented in the first two lines of the Status screen 
(see Table 14). 

Table 14. Sample queue status fields 

Field Description

QStatus Displays the status of the queue (IDLE, PAUSE, RUN, EQUIL, ABORT). 

Message Meaning

IDLE Indicates that no sample sets are currently being processed in the queue. 

Tip  The IDLE status does not indicate if sets are loaded into the queue. To check the contents of 
the sample queue, press the MENU key and select QUEUE. 

PAUSE Indicates that a sample set is loaded, but that processing has been suspended. If you 
pause the queue (by pressing the STOP key once), you can either resume processing 
with the current or subsequent vial, or cancel processing of the current sample set 
(see “Stopping a Run” on page 88).

RUN Indicates that a sample set in the queue is being processed. 

EQUIL Indicates that the autosampler is waiting for the equilibration delay (temperature 
zone and initial conditions) to be reached before it starts processing the current 
sample set. This status is displayed until the oven and tray compartment reach their 
set temperatures, the equilibration time has elapsed, or both.

ABORT Indicates that the processing of the current sample set has been stopped (by pressing 
the STOP key and selecting ABORT from the Abort/Continue menu) or that a 
system error has occurred. The QStatus displays ABORT until the autosampler has 
returned the active vial to the sample tray and flushed all the lines. For more 
information about Abort, Continue, and Pause, see “Stopping a Run” on page 88. 

Set Displays the number of the sample set currently being processed (1 to 39, P). If the queue is not 
running (the QStatus reads other than RUN or PAUSE), the set field is blank. 

#Samples Displays the number of the sample currently being processed and the total number of samples in the 
set: current sample number/total of samples. For example, if the autosampler is processing sample 50 
in a set of 120 samples, the #Samples field reads 50 / 120.

Tip  The total does not indicate the total number of vials or the total number of injections in the 
set. Calibration vials are not included. 
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Injection Status

After you start a run, pressing the DOWN ARROW key ( ) displays the injection status 
screen that contains information on the injection in progress (see Table 15). 

Tip  The Status Screen updates every two seconds. 

Table 15. Injection status parameters  (Sheet 1 of 2)

Field Description

Status Displays the progress of the current injection. A time in minutes in the Status field indicates 
that the queue is running (RUN) and that the current sample has been injected. In addition 
to the run time, the status field displays these messages.

Message Meaning

 RDY Indicates that the autosampler is ready for an injection (all temperature 
zones and gradient conditions have been reached), but that no injection is 
currently in progress.

 NOTRDY Indicates that the autosampler is not ready for an injection. NOTRDY 
might indicate that the temperature zones are not stabilized, the door is 
opened, or the Pump Ready contact closure is in the wrong state.

GRAD Indicates that the autosampler is waiting for the set gradient conditions to 
be reached—that is, for the gradient delay time set in the More menu to 
elapse.

HOLD Indicates that an injection hold is in effect as determined by the Inject 
Hold input or as set in the Input Polarity menu.

ABORT Indicates that the current injection has been stopped in one of two ways:

• By pressing the STOP key to stop the Queue and selecting ABORT 
from the Abort/Continue menu 

–or–

• By an error condition occurring 

During the ABORT sequence, the autosampler returns the current vial to 
the sample tray and flushes the lines. 

DOOR Indicates that the door is open. The autosampler automatically moves the 
arm to the home position to provide easy access to the sample tray. The 
arm automatically resumes where it left off when the door is closed.

Vial Indicates the position and type of vial (S for sample vial, C for calibration vial) currently 
being injected. If no injection is in progress (the Status reads NOTRDY), this field is blank. 
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File Status

After you start a run, press the DOWN ARROW key ( ) two times to display the file status.

The File field displays the number and name of the file assigned to the sample set currently 
being processed.

Temperature Status

After you start a run, press the DOWN ARROW key ( ) three times to display the status of 
the column oven and tray compartments (see Table 16).

Vol Displays the injection volume for the current vial. If the current vial is a sample vial, this 
field indicates the Injection Volume value entered in the Injection menu. If the current vial 
is a calibration vial, this field displays the Injection Volume value entered in the Calibration 
menu. 

#Inj Displays a fraction that indicates the current injection number over the total number of 
injections requested for the current vial: current injection number/injection per vial. For 
example, if the autosampler is performing the third of five injections, the #Inj field reads 
3 / 5. 

File # Pressing the DOWN ARROW key ( ) displays the number and name of the file assigned 
to the sample set currently being processed. 

Temperature Status Pressing the DOWN ARROW key ( ) accesses the Temperature Status screen, which 
displays the actual temperature of the column oven and the tray compartment. The 
temperature is displayed, even if this option is turned off (not set). OFF indicates that an 
option is installed but not turned on in the current file's Injection menu as shown in XXX. 

Tip  To check the set temperature for the oven, you can return to the Edit menu and view 
the information for the appropriate file as long as you have not loaded that file into the 
Queue. If you want to check any experimental parameters after loading your run file, 
make a copy of your file that you can review before loading it.

Table 15. Injection status parameters  (Sheet 2 of 2)

Field Description

Table 16. Temperature status 

Field Description

Oven

ON or OFF OFF indicates that the oven temperature control is turned off.

Temperature Indicates the actual temperature of the column oven compartment.

Tray

On or Off OFF indicates that the tray compartment temperature control is turned off.

Temperature Indicates the actual temperature of the column oven compartment.
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To check the set temperature of the column oven or tray compartment, you can return to the 
Edit menu and view the information for the appropriate file as long as you have not loaded 
that file into the Queue. If you want to check any experimental parameters after loading your 
run file, make a copy of your file that you can review before loading it.

Changing the Run in Progress
Once a run has started, use the Samples menu if you want to change the injection volume, 
cycle time, calibration interval, or set assignments for the sample set currently in progress. 

Figure 59 lists the changeable parameters in bold-face type and indicates when those changes 
take effect. With the exception of the Cycle Time and Calib 1(of X) values, changes made 
from the Samples menu take effect on the next sample injection. Changes to the Cycle Time 
take effect on the current sample injection; changes to the Calib 1(of X) field take effect on 
the next recalibration. Samples menu changes remain in effect until the next sample set.

Figure 59. Samples menu
\

This section contains the following topics:

• “Priority Sample Sets” on page 87

• “Stopping a Run” on page 88

Note  Changing one vial location does not affect other vial locations. 
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Priority Sample Sets

A priority sample set is one that you can insert into the currently active sample set at any time. 
It shares the same file and resources as specified for the currently active set. 

Priority sample sets are like other sample sets with several important exceptions:

• You assign their priority set number (P) in the Samples menu (not in the Queue menu). 

• You cannot change the order of priority sample sets once they are loaded into the sample 
queue. 

• If you want to run priority sample sets, you must select Reuse Same Vials as the 
calibration routine type. (If you select Intersperse Vials, the autosampler does not 
distinguish whether a subsequent vial is a calibration vial or a sample vial. As a result, it 
cannot resume the calibration routine after the priority sample set is processed.) 

• Since a priority set is inserted into the currently active set, you cannot edit or change the 
file between the currently active set and the priority set. 

To insert a priority sample set into the sample queue 

1. Press the Samples key.

2. Press the [+] and [–] keys to change the Set field value to P.

Figure 60 shows a priority sample set with P in the Set field.

Figure 60. Samples menu with a priority sample set

3. Fill in the other file parameters as you would for any other sample set. 

4. Add the priority set to the queue.

The autosampler assigns a P (priority) order to the priority set as shown in the Queue 
menu (see Figure 61): 
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Figure 61. Queue menu with one priority sample set

Stopping a Run

The STOP key has several functions depending on the instrument's status when you press the 
STOP key. See Figure 62 for an illustration of the Pause/Stop/Abort sequence. 

Figure 62. Queue Stop/Abort sequence

Tip  The door is equipped with a safety interlock that automatically moves the 
autosampler's arm to the home position to allow you to add samples to the tray during a 
run. Once the door is closed, the arm returns to its position and resumes the operation in 
progress before the door was opened. If necessary, however, you can disable the door 
interlock. Press the MENU key, and then select OPTIONS > Ready Participation. In 
the Door Interlock field, press the [+] and [–] keys to select DISABLE.

Queue is running.

STOP requested
Select ABORT SAMPLE/CONTINUE.

Returns vial to tray and flushes lines. 
STATUS goes to ABORT.

Pauses the queue.

Stops the queue.
QSTATUS goes to IDLE.

Restarts queue from
the beginning.

Resumes queue.
with current vial.

Resumes queue
with current vial.System

Error

Press STOP. Press RUN.

Press RUN

Select ABORT. Select CONTINUE.

Press STOP.
(User Abort)
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If the queue is in RUN when you press the STOP key, the autosampler suspends its current 
operation until you select ABORT (see Figure 63) or CONTINUE (see Figure 64):

Figure 63. Abort prompt

Figure 64. Continue prompt

If you select Continue (by pressing the [+] key), the autosampler returns the queue to the 
ACTIVE state and resumes the motor activity (as if you had not pressed the STOP key).

If you select Abort or if a system error occurs, the autosampler follows this sequence:

1. Cancels the processing of the current sample.

2. Returns the active vial to the vial tray.

3. Flushes the lines.

4. Puts the queue in the PAUSE state (Figure 65).

Figure 65. Queue Status line when the autosampler is in the PAUSE state

When the queue is paused, you can do one of the following:

• Press the RUN key to resume processing of the current vial.

–or–

• Press the STOP key to stop the queue (the QStatus goes to IDLE), and then press the 
RUN key to restart processing from the beginning of the queue.

This STOP/Abort sequence gives you several opportunities to stop and resume or restart the 
run as needed. 

Using the ABORT/CONTINUE selections and QPAUSE states, you can remedy problems 
that might adversely influence the processing or data received from the current or subsequent 
vials (depleted solvent supply, and so on) and resume the run without loss of previous data. 

Using the ABORT selection and the STOP and RUN keys, you can stop the current run and 
remedy problems that might have influenced the processing or data received from all prior 
injections (incorrect file assigned to the set, incorrect solvent concentration, and so on). This 
second option minimizes loss of resources (and valuable time).
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File Management
In addition to learning how to edit and load files from the Files menu, you can also copy and 
delete files, protect files from editing, and lock files to prevent changes to the run file during a 
run. 

Saving Files

As you know, the autosampler automatically saves your file when you exit the Edit menu. 
If a power failure occurs while you are editing a file, you lose all current changes. However, if 
a power failure occurs after you exit the Edit menu, your changes are saved. 

Copying Files

To copy a file

1. Press the MENU key, and then select FILES > Copy. 

The Copy menu appears (see Figure 66). 

Figure 66. Copy menu

2. Enter the number of the file to be copied in the Copy File field. 

3. Enter the number of the file you want to copy to in the To field. 

4. Press the ENTER key. 

The **File Copied** message appears briefly and the application returns you to the Files 
menu.

Deleting Files

Deleting a file restores all parameters to their default values. 

To delete a file

1. Press the MENU key, and then select FILES > Delete. 

The Delete menu appears (see Figure 67). 

Figure 67. Delete menu
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2. Enter the number of the file you want to delete and press the ENTER key. 

The **File Deleted** message appears briefly and the application returns you to the Files 
menu. 

Protecting Files 

You can protect a file from being edited or deleted by using the file protection feature in the 
OPTIONS menu. Because this feature enables you to control the changes to an original run 
file, you can easily incorporate your autosampler files into your standard, good laboratory 
practice (GLP) protocols. 

To display the Configurations menu

Press the MENU key, and then select OPTIONS > Configurations. 

The Configurations menu appears (see Figure 68).

Figure 68. Configurations menu

To protect a file

1. Move the cursor down to the Protect field in the line that contains the file you want 
secured.

2. Press the [+] and [–] keys to turn the protect function to On. 

For example, you cannot edit the Vitamins file shown in Figure 68 until you turn the 
protect function off. Attempting to edit a protected file displays the following message:

Protected file
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Changes to Real-Time Editing

If a file is protected, you cannot change the injection volume, number of injections per vial, or 
cycle time for the run in progress, and these lines are absent from the Samples menu as shown 
in Figure 69.

Figure 69. Samples menu for a protected file

Optimization
This section describes how to select the sample loop and syringe size to obtain maximum 
reproducibility when performing large-volume injections, how to adjust the draw speed for 
viscous samples, and how to adjust the needle height for sample vials containing either a 
limited sample volume or precipitates.

This section contains the following topics:

• “Injection Volume” on this page

• “Solvent Viscosity” on page 94

• “Needle Height” on page 95

Injection Volume

The maximum injection volume depends on these conditions: 

• The volume of the syringe currently installed as designated under 
OPTION > Configuration > Syringe Size 

• The Injection Type selected under FILE > More > Injection Type

• The volume of the installed sample loop

By changing the sample syringe, the sample loop, or both, you can set up your autosampler to 
deliver injection volumes larger than can be delivered by the 250 μL syringe shipped with the 
instrument. 
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To prepare your instrument for large-volume injections 

1. Determine the correct sample loop size for the injection volume desired. See Table 17.

2. Use the injection volume and algorithms outlined below to determine the required 
syringe size. 

These algorithms define the amount of sample needed for your injection volume:

3. Change your sample loop and syringe. (For instructions, see “Changing the Sample 
Loop” on page 121.)

4. Enter the syringe size in the FILE > Configuration > Syringe Size field.

5. Enter the Injection Type in the OPTIONS > More > Injection Type field.

6. Enter your injection volume in the Injection menu.

PushLoop Injection Volume + 15 μL

Pull Loop Injection Volume + 1.1 μL

Full Loop Injection Volume × 1.33 + 70 μL

Tip  If you select the Full-loop type, the maximum value depends only on the loop 
size, assuming that the syringe size is larger than the loop size. (Loops come only in 
the sizes listed in Chapter 8, “Replaceable Parts.” )

IMPORTANT  For pull-loop and PushLoop injection, to ensure maximum 
reproducibility, do not inject more than half of the sample loop volume. 

Table 17. Recommended injection size for selected sample loop sizes*

* These recommended volumes provide the best chromatographic performance. The type of system being used 
determines the maximum injection sizes.

Injection volume (in μL)

Injection type

Sample loop size (μL) PushLoop Pull Full

5 2.5 2.5 5

10 5.0 5 10

20 10 10 20

50 25 25 50

100 50 50 100

200 100 100 200

500 200 250 500

1000 200 500 1000
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The syringe size needed will be the total volume determined by these algorithms. For 
example, for a 500 μL full-loop injection (using a 1000 μL loop), the total volume (TV) 
needed is as follows:

TV = 500 μL × 1.33 + 70 μL

TV = 735 μL

You would then need a 1000 μL syringe, as there are no 735 μL syringes available. See 
Table 18.

.

Solvent Viscosity

You can adjust the syringe speed (draw rate) for your solvent viscosity from the Solv Viscosity 
field in the Configurations menu (see Figure 70). 

Figure 70. Configurations menu

Using the [+] and [–] keys, you can select from three different syringe speeds: 

• Normal (fastest)

• Medium

• Viscous (slowest) 

Table 18. Maximum injection size for syringe size

Syringe size (in μL)

Injection type 250 500 1000 2500 5000

Push Hi 200 200 200 200 200

Pull 212 461 956 1500 1500

Full 100 200 500 1000 1000
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Use Normal to optimize your cycle time; Normal is optimal for most applications. With very 
viscous solvents or normal-phase (low viscosity) solvents, you might want to use the Viscous 
setting to slow down the syringe rate. This will prevent cavitation and nonreproducible 
injection volumes. 

Needle Height

For some applications, such as liquid-liquid extractions and low-injection volumes, you might 
need to change or optimize the needle height. On the SpectraSYSTEM autosampler, the 
needle does not move. Instead, the bottom of the vial moves relative to the needle tip. The 
needle height is the approximate distance between the needle tip and the bottom of the vial 
(0 to 20 mm). 

The default setting of 2 mm in the More menu is sufficient for most applications and 
accommodates a wide variety of vials (see Figure 71). However, cases where you have very 
limited sample volumes might require further optimization. 

Figure 71. Needle Height field in the More menu

To optimize the needle height for your sample vials

1. Fill a vial with 200 to 300 μL of water and place the vial in position A01.

2. Create an autosampler file that makes two 200 μL injections.

a. In the Injection menu, set the Injection Volume field to 200.

b. Set Injections/Sample to 2.

3. Run the file and observe the amount of fluid remaining in the vial. The fluid height 
indicates the position of the needle tip from the vial's bottom. 

4. In the More menu, adjust the Needle Height value until the needle tip is located 
approximately 1 to 2 mm from the bottom of the vial. 

5. Repeat steps 1 to 3 to confirm the needle height is 1 to 2 mm from the vial bottom.

Note  The thickness of the bottom of the vial varies considerably between vial types 
(1.8 mL vials, microvials, and vials with micro-inserts, and so on) and materials, such as 
glass or plastic.

IMPORTANT  Operating the autosampler with a needle height that is different from the 
default height might bend the needle. Do not adjust the needle height without a spare 
needle available.
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Special Commands in the Commands Menu
The autosampler has several built-in commands for manually manipulating some of the 
autosampler's components (the arm, injection valve, and so on) outside of a run. These 
commands are useful during maintenance and troubleshooting procedures and are accessible 
from the Commands menu (see Figure 72). 

Figure 72. Commands menu 

These topics describe the commands available from the Commands menu:

• “Flush Sample Syringe” on this page

• “Initialize Hardware” on page 97

• “Injector” on page 97

• “Arm” on page 97

Flush Sample Syringe

Use this command to manually flush the 250 μL sample syringe. You used this command 
when you primed your autosampler, but you can also use it for maintenance and 
troubleshooting. 

To access the flush sample syringe test

1. Fill your flush solvent bottle, if you have not already done so. 

2. Press the MENU key, and then select COMMANDS (see Figure 72).

3. Select Flush Sample Syringe. 

The Flush command appears (see Figure 73).

4. Press the [+] and [–] keys to select the desired flush volume in microliters. Then press the 
ENTER key to initiate the flush operation. 

Figure 73. Flush command

The autosampler automatically flushes the sample syringe and flush lines with the specified 
volume of flush solvent and returns the syringe to its starting position. During the flush 
sequence a confirmation message is displayed. 

 Flush Sample Syringe 
 Initialize Hardware 

 Injector 

 Arm 
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Initialize Hardware

Use the Initialize Hardware command to manually control the autosampler's syringe and 
injection valve. This command brings the syringe to the initial position and removes any 
backlash. 

Injector

Use the Injector command to manually switch the injection valve between the inject and fill 
positions. Selecting Injector displays the menu shown in Figure 74. 

Figure 74. Injector command

Pressing the [+] or [–] key and then pressing the ENTER key changes the injection valve's 
position.

Arm

The Arm menu contains a routine for returning the XYZ arm to its home position and a 
routine for aligning the arm. Figure 75 shows the Arm menu. 

Figure 75. Arm menu
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Home Arm

Pressing the ENTER key with the cursor in the Home Arm field moves the arm from its 
present position to its home location (the left side in the back-left corner of the tub). See 
Figure 76. 

Figure 76. Autosampler arm in the home position

Align Arm

The Align Arm routine moves the arm to the vial position requested. It is used primarily by 
Thermo Fisher Scientific field service engineers to properly adjust the arm's x-y-z reference 
points. If you suspect that the arm's alignment is incorrect, call your Thermo Fisher Scientific 
service representative. 

Figure 77. Align Arm command

A

C

B

  

 

Autosampler arm in 
the home position
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5

Diagnostic Procedures

This chapter describes the built-in diagnostics and how to determine the gradient delay 
volume of your LC system.

Gradient Delay
Gradient delay is a user-defined value that delays the injection of a sample. This delay is the 
amount of time required for a change in the mobile phase to travel from the gradient 
proportioning valve to the injection valve. The volume of mobile phase contained between 
the two valves is also referred to as the precolumn volume (PV). 

Although not required for normal autosampler operation, Thermo Fisher Scientific 
recommends adding a gradient delay value to your Edit file when using large volume 
pre-filters or low flow rates (<0.5 mL/min). 

To add the gradient delay time for your LC system to your Edit file

1. From the main menu, select FILES > Edit.

2. Open your autosampler file.

3. Press the DOWN ARROW key ( ) until you reach the More menu, and then press 
Enter.

4. In the More menu, press the DOWN ARROW key ( ) until you reach the Gradient 
Delay field.

Contents

• Gradient Delay

• Diagnostics in the Tests Menu
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Figure 78. More menu

5. Press the [+] or [–] key to enter the gradient delay time for your LC system in minutes.

The range is 0.00 to 99.99 minutes.

Calculating the Gradient Delay Time

To calculate the gradient delay time for your HPLC system

1. Inject an unretained sample into your LC system with a column inline and using 100% A 
as the mobile phase (for example, MeOH).

2. Change to 100% B (for example, 0.1% acetone in MeOH) as fast as possible 
(0.1 minutes for SpectraSYSTEM pumps). 

3. Subtract the retention time (RT) of the unretained peak from the retention time of the 
start of the baseline shift (T2 – T1). 

4. Subtract the time required to switch solvents from 100% A to 100% B. 

The resulting time is the gradient delay time. 

Gradient Delay Example

The following example illustrates how to determine the gradient delay volume for your LC 
system.

An unretained peak has a retention time of 3.0 min with a baseline shift at 4.5 min and a 
complete mobile-phase switch time of 0.1 min (see Figure 79). The gradient delay is 
calculated as follows:

Gradient Delay = (T2 – T1)  –  0.1 min
= (4.5 – 3.0)  –  0.1
= 1.4 min
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Figure 79. Chromatographic results for a gradient delay time experiment

Diagnostics in the Tests Menu
The SpectraSYSTEM autosampler has built-in diagnostic routines accessible from the 
Tests menu. Using these tests, you can access the operation of your autosampler. In addition 
to describing each of these tests, this section shows how the diagnostic tests are run and how 
to interpret the error screen information when a test fails. 

All of the test screens are arranged similarly. You initiate a test by pressing the ENTER key. 
While a test is in progress, the name of the test is displayed along with three dots (Figure 80).

Figure 80. Test in-progress screen

Pump to detector

Injection valve 
to detector

Inject T1 T2

Time (in minutes)

Unretained
peak

Baseline
shift

Pump to 
injection valve
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Interpreting the Results

When the test is complete, either a PASS or FAIL result is displayed. When a test fails, an 
error screen similar to that shown in Figure 81 appears with the following information 
(described in Table 19):

• Test identification

• Fault code (diagnostic error)

• Module identification

• [RUN] / [STOP] 

Figure 81. Error screen for a diagnostic test

Note  The error number in this screen is just an example to show you the screen layout.

Table 19. Error screen fields from top left

Field Description

Test identification The name of the test being run.

Fault code The error number associated with the specific failed result. To 
receive further assistance in diagnosing and solving the problem, 
document and report the fault code to your service 
representative. 

Module identification Displays the specific autosampler board or assembly where the 
problem occurred.

[RUN / STOP] Prompts you to press the RUN key to repeat the test or to press 
the STOP key to exit the current test and return to the Tests 
menu. 

Test Fault code

Module
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Test Descriptions

All diagnostics and built-in assessment routines are accessible from the Tests menu 
(Figure 82). This topic describes the items in the Tests menu.

Figure 82. Tests menu

Software Version

Selecting this field displays the current software version number, x.yy.zz. 

Display Input States

This menu (Figure 83) shows the current states of the TTL-input device signals (Hi or Lo). 
You can use this information to check the level of the Pump Ready and Injection Hold input 
lines from other LC system modules. You can also diagnose situations where the autosampler 
is waiting for ready or waiting to inject. Make sure the Input Polarity is set to the proper level 
for each of these signals. Pressing the UP or DOWN ARROW key (  or ) returns you to 
the Display Input States field in the Test menu if you want to repeat the test. 

Figure 83. Display Inputs States menu

Display Output States

This menu shows the current states of the TTL-output device signals (Hi or Lo). Use this 
information when hardwiring your autosampler to other LC system modules. Pressing the UP 
or DOWN ARROW key (  or ) returns you to the Display Output States field in the 
Test menu if you want to repeat the test. 

Software Version
Display Input States
Display Output States
Display Timed Events
RAM Test
ROM Test
Hardware Test
Test External Contacts
Test Comm Port
Initialize EEPROM

Tip  You can change the active polarity of a specific input signal from the 
OPTIONS > Input Polarity menu. 

Tip  You can change the active polarity of a specific input signal from the 
OPTIONS > Input Polarity menu. This menu shows the states of the TTL output device 
signals (Hi or Lo) as shown in Figure 84.
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Figure 84. Display Output States menu

Display Timed Events 

This menu (Figure 85) displays the current states of the timed events outputs. Use this 
information when hardwiring your autosampler to other LC system modules. For more 
information, see “General Chromatography Troubleshooting” on page 129. 

Figure 85. Display Timed Events menu

RAM Test

This test (Figure 86) writes to and then reads the contents of the random access memory. If 
the write information is the same as the read information, the test is successful. You might 
want to run this test once a month to verify proper software operation. 

Figure 86. RAM Test menu

If the test is successful, the autosampler returns a PASS result (Figure 87). If unsuccessful, the 
autosampler returns a FAIL result and displays an error message. Document the test results 
and error message, and call your Thermo Fisher Scientific service representative. 

Figure 87. Successful RAM Test

Press the STOP key to return to the Tests menu. 

ROM Test 

This test evaluates check-sums on the contents of the instrument's ROM and compares the 
results to known values. 

If the test is successful, the autosampler returns a PASS result. If unsuccessful, the autosampler 
displays the number of the failed chip or chips, along with the regular error screen 
information (Figure 88). If the test fails, document the test results and call your Thermo 
Fisher Scientific service representative. 

Figure 88. Failed ROM Test
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Hardware Test 

The hardware test is the most important autosampler diagnostic. It checks all of the cable 
connections, sensors, motors, circuitry, and attached components.

Before running this test, be sure that the XYZ arm is in the home position (at the left back of 
the sample compartment), or the AS3000 autosampler might report false errors. You can use 
the Home Arm command in the Commands menu (see “Special Commands in the 
Commands Menu” on page 96) if the arm is not in the home position. 

If the Hardware Test fails, the screen displays the test identification, fault code, applicable 
module or connection, and [RUN] / STOP] fields. For example, in Figure 89, the message 
J10/J40/J45 indicates that further troubleshooting is required. Document the screen 
information and report it to your Thermo Fisher Scientific service representative when you 
call for assistance. 

Figure 89. Example error screen

Pressing the STOP key returns you to the Tests menu. 

Most of the failed Hardware Test results require that you contact your service representative 
for assistance. However, two of the messages indicate problems that you can likely resolve 
without a service call. 

• Opt Config

This message indicates an incorrect configuration. Check the Configurations menu 
(under OPTIONS) and verify that the options field entries match your installed options.

• Arm,*

This message indicates that the XYZ arm was not in its home position when the 
Hardware Test was initiated. Select COMMANDS > Arm > Home arm. 

Test External Contacts

This test activates all of the external contacts and tests for proper activation. Do not run the 
test while the external contacts are wired to other equipment, or the test will report false 
errors. Before running this test, disconnect the 12-pin connector block from the back of the 
instrument. After the test is complete, plug the connector back in to resume normal 
instrument operation. 

Pressing the ENTER key with the cursor in the Test External Contacts field displays a 
warning prompt (Figure 90). 

Figure 90. External Devices menu 
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From this menu, you can use the [+] and [–] keys to select CONTINUE or ABORT. 
Selecting Continue starts the test.

Selecting ABORT discontinues the test and returns you to the Test External Contacts field of 
the Tests menu. If ABORT is displayed and you want to resume the test, press the LEFT or 
RIGHT ARROW key. The display changes from ABORT to CONTINUE. 

Test COMM Port

Use this test to assess the operation of the communications port on the autosampler’s back 
panel. This test sends a signal to the communications port and expects a signal in return. A 
successful result is reported as a PASS; an unsuccessful result is indicated by the regular error 
screen.

To perform this test, you must connect a loop-back connector to the communications port.

Initialize EEPROM

The Electronically Erasable Programmable Read Only Memory (EEPROM) stores all files, 
user-set variable values, and system configuration information when the power is turned off. 
Reinitializing the EEPROM restores the default values to all files and erases the system 
configuration information. Pressing the ENTER key in this field displays the message shown 
in Figure 91.

Figure 91. Initialize EEPROM menu 

If you want to exit this routine before running it, you can do any of the following:

• Press the [+] and [–] keys to select No.

• Press the MENU key to open the main menu.

• Press the STATUS key to open the Status Screen.

Tip  If you want to perform this test, contact your Thermo Fisher Scientific field service 
engineer for the procedure and the necessary parts information.
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Maintenance

This chapter contains the maintenance schedule and procedures for your autosampler.

Specific Hazards 
For your own safety and to protect the autosampler from damage, follow the safety 
precautions in this manual when performing maintenance on the autosampler.

Contents

• Specific Hazards

• Maintenance Schedule

• Maintenance Procedures

• Automated Shutdown in the Stand Alone Mode

• Maintenance Log

CAUTION  Alerts you to situations that could result in personal injury and tells you how to 
avoid them.

CAUTION  High Voltage. Alerts you to the presence of high voltage and to the potential 
injury that could occur from electrical shock if you came into contact with a specific 
instrument area or component. Also indicates how to avoid contact with the high-voltage 
areas in your instrument.

CAUTION  Hot Surface. Alerts you to potential injury that could occur from contact 
with a heated surface or area on or in an instrument. Also indicates how to avoid contact 
with the heated surfaces in your instrument.
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Maintenance Schedule
Your autosampler requires only a few simple maintenance procedures to keep it in optimal 
working condition. Table 20 contains the maintenance schedule for the autosampler. Ensure 
that only a Thermo Fisher Scientific service representative or other qualified person performs 
the yearly maintenance tasks. 

This chapter contains recommended maintenance intervals based on operating the 
autosampler under typical conditions. Operating the autosampler under certain harsh 
conditions (corrosive solvents, extreme temperatures, and so on) might require more frequent 
maintenance than indicated in this chapter.

CAUTION  To avoid electrical shock, do not remove the top cover or remove parts beyond 
the descriptions in the operation portions or in the maintenance topics of this manual.

Table 20. Maintenance schedule

Frequency Task Performed by

Daily Empty flush-solvent tray. User

Monthly Inspect the sample needle module. User

Check the solvent tubing and connections for leaks. User

Clean the drop catch. User

Semi-annually Replace the flush-solvent inlet filter. User

Replace the needle assembly. User

Annually or as 
necessary

Replace the injection valve's rotor seal. User

Clean and lubricate the syringe drive mechanism. Service

Clean and lubricate the XYZ arm. Service

Verify the XYZ arm alignment. Service

IMPORTANT  You are responsible for maintenance of the autosampler. Routine 
maintenance is not provided under warranty; however, planned maintenance contracts are 
generally available. If you are interested in purchasing a planned maintenance contract, 
contact your local service representative.
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Maintenance Procedures
This section contains the following maintenance procedures:

• “Emptying the Flush-Solvent Tray” on this page

• “Replacing the Rotor Seal” beginning on this page

• “Replacing the Flush Solvent Inlet Filter” on page 115

• “Maintaining the Sample Needle Module” on page 115

• “Replacing the Syringe” on page 118

• “Changing the Sample Loop” on page 121

• “Replacing the Fuses” on page 122

Emptying the Flush-Solvent Tray

For normal operation, you might need to empty the tray at least once or twice a day. 

To empty the flush-solvent tray 

1. Be sure the autosampler is in IDLE status.

2. Carefully slide the tray out without spilling the collected solvent.

3. Empty the tray, rinse it off with water, and slide it back into place under the elbowed, 
barbed piece of black tubing.

Replacing the Rotor Seal

To replace the rotor seal, follow these procedures in order:

1. Removing the Injection Valve

2. Disassembling the Injection Valve

3. Cleaning the Stator

4. Installing the Rotor Seal

5. Reinstalling the Injection Valve

CAUTION  Wear skin and eye protection and dispose of hazardous waste according to 
local, state, and federal regulations.

IMPORTANT  Be sure that the level of the liquid in the waste container is below the level 
of the instrument, or waste will collect in the lines and can backflush into the instrument.
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Removing the Injection Valve

If you are only replacing the rotor seal, you do not have to remove the injection valve from the 
instrument; however, it is easier if you do. If you want to replace the rotor seal with the valve 
installed, proceed to the section entitled, “Disassembling the Injection Valve” on page 111. 

To remove the injection valve from the autosampler

1. Using a 1/4 in. open-end wrench, disconnect the tubing from ports 2, 3, 5, and 6 of the 
injection valve (see Figure 92). 

2. Remove the sample loop.

3. If your autosampler has a column oven, loosen and remove the two Phillips-head screws 
that secure the injection valve collar to the front of the oven. Then remove the collar.

4. Remove the two Phillips screws that secure the valve mounting plate.

5. Carefully pull the injection valve out of the instrument. 

Figure 92. Injection valve tubing connections
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Disassembling the Injection Valve

To replace the rotor seal, disassemble the injection valve on a clean benchtop.

To disassemble the injection valve 

1. Remove the injection valve from the autosampler (see “Removing the Injection Valve” on 
page 110).

2. Using an Allen wrench, remove the 9/64 in. hex cap screws from the top of the valve 
(Figure 93).

3. Carefully lift the stator from the valve body and set it onto a clean surface.

Figure 93. Injection valve components

4. Remove the valve body.

5. Before removing the worn rotor seal, note these details on the rotor seal (Figure 94):

• The three circular port grooves on one side of the rotor (the other side is smooth) 

• The small locating notch on the rotor's rim (not the V stamped on the seal)

Figure 94 shows the injection valve with the valve body removed and the rotor seal 
exposed. The valve’s mounting bracket is not shown.

IMPORTANT  Do this repair in a clean environment. Component cleanliness affects the 
useful life of your injection valve.

IMPORTANT  Do not activate the valve mechanism with the injection valve removed from 
the instrument or risk damaging the valve mechanism.

Note  Be careful not to drop the two rotation stop pins that protrude from the valve 
base (Figure 94).

Valve
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Rotor
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Valve 
shaft
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body

Stator
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Figure 94. Injection valve with valve body removed and rotor seal exposed 

6. Remove the worn rotor seal. You might need a thin, flat-bladed tool to remove the seal.

Cleaning the Stator

Determine whether the stator requires cleaning by inspecting it.

To clean the stator 

1. If it is dirty or greasy, swab the stator with HPLC-grade methanol. If more stringent 
cleaning is required, use a sonicator.

2. Inspect the remaining valve components for contamination. Clean as necessary. 

Installing the Rotor Seal

To install the rotor seal 

1. Install the new rotor seal in exactly the same orientation as the old one. Be sure that the 
rim notch is in line with the horizontal locating pin and that the circular port grooves are 
visible. 

2. Install the valve body.

Notch

Horizontal locking pin

Valve body

Valve base

Rotor seal

Vertical stop pins

Three circular port grooves

IMPORTANT  If the stator is scratched, replace it. Scratches can damage the rotor seal and 
cause valve leaks.
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3. Install the stator onto the valve body carefully, observing that the two locating pins in the 
valve body (Figure 94) line up with the two holes on the bottom side of the stator 
assembly (Figure 95). 

Figure 95. Bottom of the stator assembly

4. Insert the three cap screws so that each one just contacts the stator. 

5. Tighten each cap screw an equal amount until all setscrews are in equal contact with the 
valve body.

IMPORTANT  Be sure to hold the valve shaft so that the horizontal locating pin 
touches the left stop pin as you reassemble the valve. This puts the valve into the 
INJECT position (the same position as when you removed the valve from the 
instrument). If the pins are not in the correct orientation, the valve shaft might not be 
in the proper orientation for reinsertion into the instrument.

IMPORTANT  These locating pins orient the stator assembly in one of two positions, 
but only one position aligns the mounting holes in the valve body with the screw 
holes in the stator. 

IMPORTANT  To maintain the necessary pressure for proper valve operation and to 
avoid valve binding, look for a uniform gap between the stator and the valve body. Do 
not over-tighten the valve.

Locating hole

Screw hole (3X)

Setscrew (3X)

Stator face

Locating hole
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Reinstalling the Injection Valve

If you removed the injection valve from the autosampler to replace the rotor seal, reinstall the 
injection valve.

To install the injection valve

1. Align the valve shaft with the port for the injection valve.

2. Secure the valve mounting plate with the two Phillips screws.

Figure 96 shows the correct orientation for the valve mounting plate. The locating hole is 
below and to the right of the injection valve.

Figure 96. Valve mounting plate in the correct orientation

3. Reconnect the sample loop to ports 1 and 4 of the injection valve.

4. Reconnect the tubing to ports 2, 3, 5, and 6 of the injection valve. Connect the needle 
tubing to port 2, the flush tubing to port 3, the dead volume union to port 5, and the 
return tubing from the heat exchanger to port 6. Using a 1/4 in. open-end wrench, 
tighten the fittings.

Note  When reinstalling the mounting plate and valve assembly, be sure to orient the 
bracket with the corner that has the locating hole in the lower right as shown in 
Figure 96. Be sure that you can see the pin through the locating hole.

Mounting screw

Mounting screw

Locating hole

Mounting plate
114 SpectraSYSTEM AS3000 Autosampler User Guide Thermo Scientific



 6 Maintenance
Maintenance Procedures
Replacing the Flush Solvent Inlet Filter

Properly filtering your flush solvent extends the life of your injection valve and column. 

To replace the inlet filter

1. Be sure the autosampler is in the IDLE mode.

2. Remove the flush-solvent bottle cap and lift out the inlet tubing. 

3. Put on a new filter cartridge and put the line back into the bottle. Tighten the solvent cap.

4. Flush the inlet filter and lines with an appropriate volume of solvent (~5 μL). 

Maintaining the Sample Needle Module

To remove or clean the sample needle module and flush the drop catch, follow these 
procedures:

• “Removing or Cleaning the Sample Needle Module” on this page

• “Flushing the Drop Catch” on page 118

Removing or Cleaning the Sample Needle Module

The sample needle module resides in the sample tower and is responsible for piercing the vial 
septum and removing sample from the vial. The needle guide end of the module snaps out of 
the needle mount. The tubing portion of the assembly is routed through a hole in the column 
oven compartment and is connected to port 2 of the injection valve.

Figure 97 shows the sample needle module. Thermo Fisher Scientific supplies two versions of 
this module: a standard version and a biocompatible version. If your autosampler has a 
biocompatible injection valve, order the biocompatible version.

IMPORTANT  Be sure to follow all of the safety precautions for each solvent as 
prescribed by the manufacturer's MSDS.
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Figure 97. Sample needle module

To remove the sample needle module 

1. Using a 1/4 inch open-end wrench, remove the tubing fitting from port 2 of the injection 
valve. 

2. Carefully (to avoid damage to the tubing) release the sample needle module from the 
tower by grasping the module edges and pulling toward the back of the autosampler.

3. Pass the needle fitting through the autosampler's front bulkhead and remove the needle 
module from the autosampler.

Tip  If you are replacing (not inspecting) the needle, you might want to cut the used 
needle to make it easier to pass the fitting through the bulkhead.
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Figure 98. Sample needle module pulled away from the needle mount

To clean the sample needle module 

1. Inspect the needle module. 

2. Rinse in water or sonicate if contamination is present. 

3. If internal plugging is suspected, pass a cleaning wire through the needle and flush the 
needle with high flow from an LC pump.

IMPORTANT  The sample needle module is glued during manufacture and cannot be 
disassembled. 
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To replace the sample needle module

1. Remove the new module from the replacement kit. 

2. Pass the valve end of the needle through the hole on the underside of the column 
compartment.

3. Snap the needle assembly into the mounting brackets on the backside of the sample tower 
(Figure 98). 

4. Place the tube fitting and ferrule onto the needle and install it into port 2 of the injection 
valve (Figure 92).

Flushing the Drop Catch

The drop catch (Figure 98) removes the last drop of sample from the end of the needle after 
injection. Flush it monthly.

To flush the drop catch

1. Remove the needle module assembly as described on page 116, but leave the drop catch 
installed.

2. Flush the drop catch with water, an organic solvent, or an acid or base (as appropriate for 
the sample), and once more with water. Then dry it with a clean tissue. 

Replacing the Syringe

This topic describes how to replace the sample (250 μL) syringe (see Figure 99). You can 
replace the 250 μL sample syringe without removing the syringe drive assembly, but you must 
move the syringe drive about two inches out by interrupting a flush cycle. 

Figure 99. Syringe
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To remove the sample syringe 

1. From the main menu, select Commands > Arm > Align Arm. Press ENTER.

The autosampler arm moves to position A01at the front left of the tray compartment.

2. From the main menu, select Commands > Flush Sample Syringe.

3. When the plunger is lowered, turn off the power. 

4. Hold the silver base of the plunger to prevent it from turning, and loosen the knurled 
syringe set screw under the syringe's plunger. 

5. To loosen the top of the syringe, hold the metal tip on the top of the syringe barrel, 
unscrew the used syringe barrel, and lift it out of the instrument. 

Tip  You might need to use a needle nose pliers to loosen the set screw.

Note  The syringe set screw is a captive fitting and will not fall into the instrument's 
chassis. 

IMPORTANT  Do not try to loosen the syringe by holding the barrel. The syringe 
could break between the glass barrel and the metal tip.

Tip  Push up on the syringe plunger while lifting it out of place.

Tip  Install the syringe in its fully expelled position to prevent an air bubble in the 
syringe barrel. 
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To install the new syringe

1. Slide the syringe onto the syringe drive assembly (see Figure 100).

Figure 100. Syringe drive assembly with syringe

2. Screw the syringe nut into the syringe valve.

3. Screw the syringe drive assembly nut into the silver base of the syringe plunger.

4. Turn the autosampler on.

Because the arm is not in the home position, an error condition occurs (#140) as the 
autosampler goes through its initialization process.

5. Press RUN to clear the error.

Tip  If you change the syringe size, do one of the following:

• If you are using the autosampler in the Stand Alone mode, change the syringe size in 
the Options > Configurations > Sample Syringe field.

• If you are using a chromatography data system to control the autosampler, enter the 
syringe size when specifying the configuration settings for the autosampler.

Knurled syringe set screw

Syringe valve
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Changing the Sample Loop

A number of different size sample loops are available for the SpectraSYSTEM autosampler. 
For the list of spare parts and consumables, see Chapter 8, “Replaceable Parts.” 

To change the sample loop 

1. Be sure that the autosampler is in the IDLE mode.

2. Using a open-end wrench, loosen the fittings at ports 1 and 4, and pull out the two ends 
of the sample loop.

3. Insert the ends of the new sample loop in the same orientation as the old one and tighten 
the fittings.

Tip  If you are using the autosampler in the Stand Alone mode, enter the nominal sample 
loop size in the File > Injections > Loop Size field when making full-loop injections.

If you are using a chromatography data system to control the autosampler, enter the 
sample loop size when specifying the configuration settings for the autosampler.
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Replacing the Fuses

Instrument power is supplied by two time-lag fuses housed in the fuse compartment on the 
lower left of the instrument's back panel (Figure 101).

Figure 101. Autosampler’s back panel

To replace the fuses 

1. Turn off the autosampler by pressing the on/off button on the lower right corner just 
below the front panel. 

2. Unplug the power cord from the AC power receptacle on the autosampler’s back panel.
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This product is manufactured under, and covered by, one or more of the following U.S. patents:

AS3000
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5,029,065
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TIMED EVENT  1                    OUT
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Model No:

355 River Oaks Parkway
San Jose, CA 95134  U.S.A.

CAUTION
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(1) This device may not cause harmful interference, 
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CAUTION  Disconnect the power cord before you replace fuses. 
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3. Use a flat blade to press down on the plastic tab at the top edge of the fuse compartment 
and pull out the fuse holder. 

4. Pull both fuses out of the holder and discard. Place the new fuses into the holder with the 
metal end visible.

5. Snap the fuse holder back into place. 

Automated Shutdown in the Stand Alone Mode
If you are controlling the autosampler in the Stand Alone mode, you can set it to shut down 
the system during periods of disuse, for example, after completing an overnight or 
over-the-weekend run. The shutdown feature can turn off the autosampler’s controlled 
temperature zones, flush the injection system, and send a signal to the pump to stop the pump 
flow. Enter the shutdown parameters in the OPTIONS > Shutdown menu (see Figure 102).

Figure 102. Options menu

Figure 103 illustrates the autosampler's Shutdown menu. Table 21 describes the parameters.

Figure 103. Shutdown menu

Table 21. Shutdown menu parameters  (Sheet 1 of 2)

Parameter Description

Delay Time Specifies the desired amount of time that the autosampler is to 
wait before initiating the shutdown procedure. When you select 
Off, the autosampler performs the shutdown procedure as soon as 
the autosampler state returns to IDLE.

Selections: Off, 5, 10, 20, 30, 45, 60, 90, 120, 240, and 
480 minutes

Oven Shutoff Selecting Yes causes the autosampler to automatically turn off the 
oven after the Shutoff Delay time has elapsed. 
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Maintenance Log
The Maintenance Log menu (see Figure 104), accessible from the OPTIONS menu, 
monitors the autosampler maintenance status and counts, and displays the number of 
activations for each of the routine maintenance parts listed in the menu. 

Figure 104. Maintenance Log menu

For information on the Maintenance Log menu items, see these topics:

• “Instrument Maintenance Status” on page 125

• “Total System Cycles Menu” on page 125

• “Injector Valve Menu” on page 125

• “Needle Wear Menu” on page 127

• “Sample Syringe Menu” on page 127

Note If you are using the Shutdown function with methods that 
call for heating and cooling, be sure to allow a long enough delay 
time (10 or more minutes) for thermal equilibrium to occur.

Pump Shutoff Selecting Yes causes the autosampler to automatically activate the 
Pump Stop output after the Delay Time has elapsed. Turning off 
the pump retains your solvent supply and prevents air from being 
pumped into the lines should the solvent reservoirs become 
depleted.

Flush Volume Flushes the injection system with the specified volume. 

Range: 200 to 5000 μL
Default: 400 μL 

Table 21. Shutdown menu parameters  (Sheet 2 of 2)

Parameter Description

Note  If you are controlling the autosampler in the SpectraNet mode, set up and monitor 
the maintenance log from your chromatography data system.
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Instrument Maintenance Status

The Maintenance Log menu provides a convenient way to keep track of autosampler 
maintenance. When you first access the Maintenance Log menu from the OPTIONS menu, 
the Maintenance Required confirmation message appears if instrument maintenance is 
required. This message is displayed if any of the #Cycles field values in any of the 
Maintenance Log menus is greater than the number of cycles entered in the Due fields. See 
the other topics in this section for more information on these fields. 

If maintenance is not required, no message appears. Pressing the DOWN ARROW key ( ) 
clears the confirmation message and returns you to the Maintenance Log menu. 

Total System Cycles Menu 

The Total System Cycles menu (see Figure 105) displays the total number of instrument 
cycles in the #Cycles field. This field value is set to zero at the factory and cannot be reset. The 
Note field is a six-character, alphanumeric, user-programmable field. 

To enter the last service date or other comments

In the Note field, press the [+] or [–] keys. 

Figure 105. Total System Cycles menu

Injector Valve Menu 

Except for the Total System Cycles menu, all of the Maintenance Log menus are identical to 
the Injector Valve menu (see Figure 106 and Table 22). Only the Injector Valve menu then is 
described in detail here. 

The Maintenance log menus track the usage for the listed autosampler component. When 
you replace the component, reset the counter to 0.

To reset the counter to 0 

1. Press the [+] or [–] keys to select YES.

2. Press ENTER to accept the new setting.

The **Counter Reset** confirmation message appears. 

User-entered value 
for the last service date
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Figure 106. Injector Valve menu

Table 22. Maintenance Log menu parameters

#Cycles Displays the number of activations of the specific autosampler part since 
the last time this field (counter) was reset (0 to 999 999). The #Cycles 
value for each of the Maintenance Log menus is included in the menu 
descriptions that follow. 

Due Specifies a six-character numeric field where you enter the number of 
cycles before maintenance is due. 

Range: 0 to 999 999

If the #Cycles field value is larger than the Due field value, the 
Maintenance Due message appears when you access the Maintenance Log 
menu from the Options menu. The default maintenance Due field value is 
12 000 (approximately once a year). The default values for the other 
Maintenance Log menus are included in the menu descriptions that follow. 

Tip  The Due field default values for all of the Maintenance Log menus 
are estimates only. The actual values appropriate for your instrument 
vary with the type of applications and the specific conditions being used 
with your LC. If the "Maintenance Required" message is displayed, 
strongly consider replacing parts; however, you might want to increase 
the Due value and experiment with extending the time before 
performing maintenance. Conversely, if instrument performance 
indicates, you might want to decrease the Due field value for some of the 
Maintenance Log menus.

Tip  Similar to the Total System Cycles menu, this is a six-character, 
alphanumeric, user-programmable field. Use the [+] or [–] keys to enter 
the last service date in this field, but you might also document contact 
information or other comments regarding the maintenance of the 
specific autosampler part.

Reset #Cycles Pressing the DOWN ARROW key ( ) displays the Reset #Cycles field 
used to reset the #Cycles counter for each autosampler part. 
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Needle Wear Menu

The #Cycles field in this menu is incremented each time the needle pierces a vial. The default 
value of the Due field is 10 000, which corresponds to approximately every six months. 

Sample Syringe Menu

The #Cycles field displays each full syringe stroke. However, the instrument tracks the actual 
distance of linear travel, thus compensating for different injection (stroke) volumes. The 
default Due field value for both menus is 24 000, which corresponds to approximately once 
a year.
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7

Troubleshooting

This chapter provides information to help you troubleshoot possible autosampler problems. 

For additional assistance in troubleshooting a particular problem, contact Thermo Fisher 
Scientific Technical Support or your service representative. 

General Chromatography Troubleshooting
The first section focuses on general chromatographic problems and is designed to help you 
define the particular instrument or condition causing the problem. Once you determine the 
cause, use the ordered outline to fix the problem or refer to the troubleshooting guide for the 
specific SpectraSYSTEM instrument. Each of these problems can be detected by monitoring 
the chromatography running conditions or by observing the chromatogram.

Contents

• General Chromatography Troubleshooting

• Autosampler Troubleshooting

• Display Messages

• Testing for Tubing Restrictions

Table 23. General LC troubleshooting  (Sheet 1 of 3)

Symptom Cause/Remedy

1. No flow a. Check mobile phase connections.

b. Check for leaks.

c. Refer to the pump troubleshooting guide.

2. High backpressure a. Check flow rate and system/column specifications.

b. Check for tubing or column blockage.

c. Refer to the pump troubleshooting guide.

3. Unstable baseline or drift a. System/column not equilibrated; allow more time.

b. Refer to the detector troubleshooting guide.

c. Refer to the pump troubleshooting guide.
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4. Baseline noise a. Check for air bubbles in system, degas solvents.

b. Check for system/solvent contamination.

c. Refer to the pump troubleshooting guide.

d. Refer to the chromatography data system 
troubleshooting guide.

5. No peaks a. Check detector and data system connections.

b. Refer to the autosampler troubleshooting guide.

c. Check sample retention with chromatographic 
conditions.

6. Contaminating/ghost peaks a. Clean system and column.

b. Refer to the autosampler troubleshooting guide.

c. Refer to the pump troubleshooting guide.

7. Poor peak shape a. Check system for leaks.

b. Check fittings and tubing lengths.

c. Check column performance.

d. Refer to the autosampler troubleshooting guide.

e. Refer to the pump troubleshooting guide.

f. Refer to the detector troubleshooting guide.

8. Poor retention time 
reproducibility

a. Check system for leaks and bubbles.

b. System/column not equilibrated; allow more time.

c. Check column performance.

d. Refer to the pump troubleshooting guide.

e. Refer to the autosampler troubleshooting guide.

f. Refer to the data system troubleshooting guide.

9. Poor peak area 
reproducibility

a. Check column performance.

b. Refer to the autosampler troubleshooting guide.

c. Refer to the data system troubleshooting guide.

10. Non-integrated or too 
many peaks

a. Refer to the integrator or data system 
troubleshooting guide.

Table 23. General LC troubleshooting  (Sheet 2 of 3)

Symptom Cause/Remedy
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For more detailed chromatographic troubleshooting, refer to any HPLC troubleshooting 
reference book or call your local sales or service representative.

Autosampler Troubleshooting
This section describes autosampler problems that can affect your chromatography and general 
autosampler hardware problems.

For information on troubleshooting autosampler problems that can affect your 
chromatography, see Table 24. For information on troubleshooting general autosampler 
hardware problems, see Table 25.

11. No instrument of device 
control

a. Check cable connections.

b. Check system configuration.

c. Refer to the individual instrument troubleshooting 
guide.

d. Refer to the integrator, ISM, or data system 
troubleshooting guide.

Table 23. General LC troubleshooting  (Sheet 3 of 3)

Symptom Cause/Remedy
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Table 24. Autosampler-specific chromatographic problems (Sheet 1 of 3)

Symptom Possible problem Remedy

1. Baseline drift when the 
injection valve changes 
from INJECT to FILL

a. Lack of thermal stability in the 
column oven compartment, 
detector, or mobile phase

a. Eliminate drafts around the column 
compartment. Wait until the column 
oven has reached thermal equilibrium. 
If the problem persists, contact your 
local Thermo Fisher Scientific service 
representative.

2. Shifting retention 
times

a. Temperature variations in the lab a. Stabilize temperature.

b. Column-heater problems b. Call your Thermo Fisher Scientific 
service representative.

3. Sensitivity changes a. Inconsistent sample injection 
volumes

a. Check for a partially blocked injection 
valve and observe the pressure. If the 
problem persists, replace the injection 
valve (see “Removing the Injection 
Valve” on page 110).

b. Leaks between the injection valve 
and the column causing 
inconsistent sample-volume 
injection

b. Tighten/remake fitting.

c. Air bubbles aspirated into the lines 
along with sample

c. Replenish/prepare fresh sample and 
repeat the injection.

c. Slow down syringe speed. 

e. Sample adsorption to the walls of 
the injection valve or sample loop

e. Change the mobile phase 
concentration.

f. Sample solvent incompatible with 
the mobile phase

f. Change solvent; use mobile phase if 
possible.

g. Sample insoluble in solvent g. Be sure sample solvent has a lower 
elution strength than the mobile 
phase.

h. Air in syringe/sample lines h. Flush sample lines.
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4. Irregular peak shapes a. The sample volume exceeds the 
column's capacity.

a. Decrease the volume injected or dilute 
the sample.

b. The strength of the solvent used 
to dilute the sample exceeds the 
strength of the initial 
mobile phase.

b. If appropriate for your application, 
ensure that the flush solvent is of the 
same composition as the solvent used 
to dissolve the sample and that it never 
exceeds the solvent strength of the 
initial mobile phase.

c. Degradation of sample 
components

c. Prepare fresh sample and repeat 
injection.

5. Band broadening a. Fitting problem at the injection 
valve (port 5) to column 
connection

a. Inspect for damage, mismatch, 
incorrect assembly.

b. Tubing ID too large b. Use 0.010 inch ID tubing.

6. Smaller than expected 
peak heights

a. Smaller than expected injection 
volume due to incorrect syringe 
configuration

a. Check the syringe size and the syringe 
configuration.

b. Incorrect injection volume b. Check the injection volume value 
in the file.

c. Air in lines c. Flush the lines.

d. Misadjusted syringe-drive 
mechanism

d. Call your Thermo Fisher Scientific 
service representative.

7. Peaks during a blank 
injection (from a 
previous injection)

a. Sample carryover due to residual 
sample in the sample loop

a. Insufficient flush volume. Increase 
Injection Volume in Edit menu, add a 
blank vial between sample vials, or use 
a stronger flush solvent.

b. Sample carryover due to 
incorrectly assembled sample-loop 
fittings (adding dead volume that 
can contain residual sample)

b. Check and remake fittings.

c. Sample too concentrated c. Dilute sample.

8. No peaks a. Plugged or bent needle a. Clean/replace needle. Tighten fittings 
and syringe.

b. Leaking flush valve fitting b. Tighten fitting.

c. Plugged or leaking tubing c. Replace faulty tubing.

Table 24. Autosampler-specific chromatographic problems (Sheet 2 of 3)

Symptom Possible problem Remedy
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9. Incorrect precision 
and/or accuracy 
problem on a 
sample of known 
content-random error

a. Air leak a. Tighten all fittings and repeat the run.

b. Worn out syringe b. Replace.

10. Reproducibility of 
peak areas

a. Plugged or bent needle a. Clean/replace needle. Tighten fittings 
and syringe.

b. Leaking flush valve fitting b. Tighten fitting.

c. Plugged or leaking tubing c. Replace faulty tubing.

d. Sample viscosity too low or 
too high

d. Change viscosity setting in the 
FILE > Edit > More menu.

e. Solvent viscosity too low or 
too high

e. Change Solv Viscosity setting in the 
OPTIONS > Configurations menu.

Table 24. Autosampler-specific chromatographic problems (Sheet 3 of 3)

Symptom Possible problem Remedy
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Table 25. Autosampler hardware problems (Sheet 1 of 4)

Symptom Possible problem Remedy

Startup

1. Nothing works 
when instrument is 
turned on.

a. Power cord unplugged or faulty a. Plug in/replace cord.

b. Blown fuse b. Replace fuse.

c. Defective power switch, driver, 
transformer

c. Call your local Thermo Fisher 
Scientific service representative.

2. Fan is running but 
display does not work.

a. Display component failure a. Call your local Thermo Fisher 
Scientific service representative.

3. No response from 
keypad but display 
works.

a. Defective keypad a. Call your Thermo Fisher Scientific 
service representative.

4. Column oven, tray 
temperature control, or 
both do not turn on.

a. File not loaded a. Load file.

Communications

5. No RS-232-C 
communications.

a. Further troubleshooting required a. Call your Thermo Fisher Scientific 
service representative.

6. EEPROM fails to 
retain memory. 

a. EEPROM not initialized a. Reinitialize the EEPROM. If 
unsuccessful, might be a defective 
PCB. Call your Thermo Fisher 
Scientific service representative.

7. External devices (timed 
events) do not work.

a. Incorrect configuration settings or 
hardware connections

a. Check “Communication: SpectraNet 
or Stand Alone” on page 30 for 
configuration settings and hardware 
connections. 

b. Interface equipment problem b. Refer to the applicable instrument 
manuals.

Vials

8. Vial is stuck in tower. a. Bent needle a. Replace needle module (see 
“Maintaining the Sample Needle 
Module” on page 115.)
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9. Instrument cannot 
locate vial.

a. Incorrect vial position entered into 
Samples menu

a. Check Samples menu.

b. Sample incorrectly placed in 
sample tray

b. Check tray arrangement.

c. Arm misaligned c. Home arm. See “Special Commands 
in the Commands Menu” on page 96.

d. Arm movement restricted d. Remove restriction and home arm.

10. Vials do not fit in tray. a. Incorrect vials a. Vial diameter should be 
0.44 to 47 inches.

11. Broken vials a. Tray not aligned or not seated 
properly

a. Seat tray completely in tray chamber 
and pull handle back toward you. 

12. Torn septa a. Bent needle a. Replace needle.

Injection valve

13. Injection valve does not 
switch. 

a. Slipping injection valve drive a. Call your Thermo Fisher Scientific 
service representative.

14. Injection valve 
continues to rotate 
until fault is generated.

a. Loose or faulty sensor cable a. Call your Thermo Fisher Scientific 
service representative.

15. Injection valve does not 
rotate to the proper 
position.

a. Excessive torque required for valve 
rotation

a. Call your Thermo Fisher Scientific 
service representative.

16. Motor fails to stop after 
syringe is fully 
returned.

a. Possible defective sensor a. Call your Thermo Fisher Scientific 
service representative.

17. Sample loop does not 
fill.

a. Blocked injection valve a. To isolate blockage and flush, follow 
procedures on “Replacing the Flush 
Solvent Inlet Filter” on page 115. Or, 
take apart valve and sonicate. 

CAUTION  Do not clean valve 
with a cleaning wire, or you risk 
damaging it.

b. Blocked sample loop b. Backflush loop. If problem persists, 
replace the loop.

c. Worn syringe c. Substitute a "known-good" syringe 
and determine if symptoms persist.

d. Blocked needle d. Clean with a cleaning wire.

Table 25. Autosampler hardware problems (Sheet 2 of 4)

Symptom Possible problem Remedy
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18. Valve-seal wears 
rapidly.

a. Too much valve seal pressure 
against valve

a. Decrease LC system pressure.

b. Particulate matter in valve b. Use an inline filter before the injection 
valve. 

c. Inadequately filtered sample c. Filter with a 0.5 μm filter before 
injection.

d. Buffer crystallization d. Do not allow buffers to stand in 
system. Run a flush sequence from the 
Commands menu when the system is 
not in use.

19. Injection from 
incorrect vial.

a. Incorrect vial position entered in 
Samples menu

a. Check Samples menu.

b. Sample placed in incorrect 
position in vial tray

b. Check tray arrangement.

20. Samples are injected 
incorrectly in a pattern.

a. Error in file (calibration vials 
placement)

a. Check file (calibration template).

Needle

21. Needle is bent or 
broken. 

a. Incorrect vials a. See list of recommended replacement 
parts in the front of the manual.

b. Alignment problem b. Call Thermo Fisher Scientific.

c. Arm sticking c. Call your Thermo Fisher Scientific 
service representative.

22. Needle is plugging. a. Multiple/incorrect septa a. Verify a single septum of the type 
recommended.

Syringe

23. Syringe drive creates 
loud buzzing.

a. Defective limit switch a. Call your Thermo Fisher Scientific 
service representative.

24. Flush valve will not 
activate.

a. Defective valve/coupler/motor a. Call your Thermo Fisher Scientific 
service representative.

25. Flush valve is actuated, 
but syringe cannot 
draw flush solvent. 

a. Plugged inlet filter in solvent 
reservoir

a. Replace inlet filter (see “Replacing the 
Flush Solvent Inlet Filter” on 
page 115).

Arm

26. Hook does not lift vial. a. XYZ arm motor stepping failure a. Call your Thermo Fisher Scientific 
service representative.

Table 25. Autosampler hardware problems (Sheet 3 of 4)

Symptom Possible problem Remedy
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As mentioned in Chapter 2, “Installation,” three different kinds of messages can appear on 
your autosampler display: user messages, confirmation messages, and error messages. This 
section describes the possible conditions that generate these messages.

• User Messages

• Confirmation Messages

• Error Messages

Leaks

27. Leakage during loop 
filling

a. Blocked loop or valve not 
deflected far enough

a. Flush sample loop or replace; check 
and flush waste line. Check the sensor.

28. Cross-port leakage a. Worn rotor seal a. Replace according to instructions in 
“Replacing the Rotor Seal” on 
page 109.

29. Liquid on vial caps a. Leaky flush valve a. Replace flush valve.

b. Leaky injection valve b. Replace rotor seal (see “Installing the 
Rotor Seal” on page 112).

Other

30. An automatic sequence 
is interrupted, or 
instrument will not 
start.

a. Column-oven, heater, door 
interlock activated

a. Check the Ready Participation menu.

31. In Stand Alone mode, 
Status Screen indicates 
a run in progress, but 
the instrument is 
locked up.

a. Configuration incorrectly set to 
SpectraNet mode

a. In the Configurations menu, set Mode 
to Stand Alone.

32. Sample is 
contaminated. 

a. Dirty vials a. Replace vials.

b. Improper septa made of silicone or 
other rubber-like material

b. Use recommended septa. Thermo 
Fisher Scientific septa are made of 
Teflon-faced silicone.

33. System pressures are 
elevated.

a. Block between column and 
autosampler

a. Crack each fitting and observe 
pressure. See instructions in “Testing 
for Tubing Restrictions” on page 144.

Table 25. Autosampler hardware problems (Sheet 4 of 4)

Symptom Possible problem Remedy
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User Messages

User messages are displayed as a result of the user’s incorrect action. 

User message Description

Autosampler Busy You cannot issue a command from a menu or 
press a key while the autosampler is in the middle 
of a previously requested operation. 

Autosampler Busy No Loading Allowed You cannot load a sample set while the queue is 
running.

Cannot Add Priority Set During Final 
Calibration

You cannot add a priority set during bracketing 
(after all the sample vials have been injected). 

Cannot Add Priority Set at This Time You cannot add a priority set to other than set 1. 
You cannot add a priority set unless the file's 
Calibration menu calls for interspersed 
calibration vials (you must select Reuse 
calibration vials if you want to add priority sets 
to the queue).

File in Queue Cannot Be Copied To You cannot copy to a file assigned to a sample set 
in the queue.

File In Queue Cannot Be Deleted You cannot delete a file assigned to a sample set 
in the queue.

File In Queue Cannot Be Edited You cannot edit a file assigned to a sample set in 
the queue from the Edit menu. You can edit the 
run-file copy of the active file from the Samples 
menu.

File Protected Cannot Be Copied To You cannot copy to a file that is protected 
(Protect is set to On) in the Configurations 
menu. 

Use Samples Key to Add Samples to 
Queue

You cannot start a run by pressing the RUN key 
when the queue is empty. You must first load or 
add sample sets to the queue.
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Confirmation messages inform you that the autosampler is completing a requested operation 
or command. These messages disappear when the operation is complete.

Error Messages

There are three kinds of errors: hardware errors, system errors, and diagnostic errors.

This topic describes these types of errors:

• “Hardware Errors” on page 140

• “System Errors” on page 143

For descriptions of diagnostic errors, see “Diagnostics in the Tests Menu” on page 101.

Hardware Errors

Hardware errors occur during the normal use and operation of the instrument. Most of the 
time you can clear these errors. For some, you might need to call your Thermo Fisher 
Scientific service representative. 

To clear the error message, press any key, and then take the steps suggested for each message in 
Table 26 to resolve the problem.

Confirmation message Description

Aligning Arm The Align Arm command is in progress.

Clearing Mixer The Clear Mixer command is in progress.

File Copied The requested file has been copied.

File Deleted The requested file has been deleted.

File Loaded The requested file has been loaded into the queue.

Flush Sample Syringe The Flush Sample Syringe command is in progress.

Homing Arm The Home Arm command is in progress.

Initializing The Initialize Hardware command is in progress 
(see“Initialize Hardware” on page 97).

Set Added to Queue The requested sample set has been added to the sample 
queue.
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Table 26. Hardware error messages  (Sheet 1 of 3)

Hardware error message Description

Arm Failed to Home on X, Y, Z The XYZ arm could not make the final x-, y-, or 
z-axis motion required to return to the home 
position. Check for a dislodged vial, tray, or other 
obstruction. Run the Initialize Hardware routine. If 
the error persists, contact your Thermo Fisher 
Scientific service representative.

Arm Jam on X, (Y, Z) Axis The XYZ arm is obstructed on its left-to-right (x) 
axis, its front-to-back (y) axis, or its vertical (z) axis. 
Check for a dislodged vial, tray, or other obstruction. 
Run the Initialize Hardware routine. If the error 
persists, contact your Thermo Fisher Scientific 
service representative.

Flush Valve Misaligned The flush valve did not turn all the way to the 
required position. Perform the Initialize Hardware 
routine. If the error persists, run the Test Connectors 
routine. If the error persists, contact your Thermo 
Fisher Scientific service representative.

Hardware Failure A problem occurred with the valves or syringes. Run 
the Initialize Hardware diagnostic (see “Initialize 
Hardware” on page 97), the Injector Test (see 
“Injector” on page 97), or both. If you are unable to 
clear the error, contact your Thermo Fisher Scientific 
service representative. 

Hardware Not Homed The solvent valve could not move to a certain 
requested position, but the hardware was not 
initialized properly. Or, on power-up, the solvent 
valve could not home properly. Run the Initialize 
Hardware diagnostic (see “Initialize Hardware” on 
page 97). If you are unable to clear the error, contact 
your Thermo Fisher Scientific service representative.

Hardware Timeout Time ran out for completing the requested 
mechanical operation. The problem could be with 
the arm, valves, or syringes. Run the Initialize 
Hardware routine (see “Initialize Hardware” on 
page 97). If the problem persists, try manually 
flushing the syringes using the Flush Sample and 
Flush Prep Syringe commands (see “Flush Sample 
Syringe” on page 96). If the problem persists, contact 
your Thermo Fisher Scientific service representative.
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Injector Valve Failure The injection valve failed to move (between the 
INJECT and FILL positions, or vice versa) for the 
requested operation. Issue the Injector command 
from the Commands menu. If the error persists, call 
your Thermo Fisher Scientific service representative.

Inject Valve Misaligned The injection valve is positioned between the 
INJECT and FILL positions. Run the Injector test 
(see “Injector” on page 97), and call your Thermo 
Fisher Scientific service representative if the error 
persists.

IValve Move Is Impossible The injection valve cannot move to the requested 
position from its current position. Switch the 
injection valve position using the Injector command, 
and call your Thermo Fisher Scientific service 
representative if the error persists.

IValve Move Not Detected The system did not detect a requested movement to 
the required position. Check for a loose connection 
to the injection valve. Try manually moving the 
injection valve to another position. If the error 
persists, call your Thermo Fisher Scientific service 
representative. 

Inject Valve Overshoot The injection valve moved past the desired position. 
Run the Injector test (see “Injector” on page 97), and 
call your Thermo Fisher Scientific service 
representative if the error persists.

Injector Valve Undershoot The injection valve failed to move far enough to the 
desired position. Run the Injector test (see “Injector” 
on page 97), and call your Thermo Fisher Scientific 
service representative if the error persists.

Parameter Out of Range You entered a value that was too large or too small. 
For example, you entered an injection volume that 
was too large for the installed syringe. Check the 
installed syringe/sample loop versus the edit file 
parameters.

Syr 1(2) Not Enough to Expel The syringe is not retracted far enough to expel the 
requested volume flush operation. Run the Initialize 
Hardware test (see “Initialize Hardware” on page 97), 
and restart the flush cycle. 

Table 26. Hardware error messages  (Sheet 2 of 3)

Hardware error message Description
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System Errors

System errors occur very rarely but they cancel normal operation. Because system errors are 
not usually problems you can correct, they are listed in this section but not described. If you 
see these or other messages, document them and contact your Thermo Fisher Scientific 
service representative for assistance.

Invalid Current Location

Invalid Command

Not in GET/RET Sequence

Z Must be Up/No Vial

Move Z Not Allowed

Get LocNum: Bad Row, Col

Z up Only in Serv Block

Invalid Target Location

SValve Extra Interrupt

Bad Vial Number

Unexpected Syr Event

Syringe Failure The syringe failed to move to the appropriate 
position required for an operation. Run the Initialize 
Hardware test (see “Initialize Hardware” on page 97). 
If the error repeats, call your Thermo Fisher Scientific 
service representative.

Syringe Overfill You requested an injection volume that is too large 
for the size of the installed syringe. Check the 
method and syringe volume.

Unexpected Vial in Hook A vial was found in the hook where no vial was 
expected for the requested operation. To clear the 
error, remove the vial and restart or resume the 
requested operation.

Vial Not Found in Hook No vial was found in the hook where one was 
expected. Verify that a vial exists in the requested tray 
location, check the file and vial assignments in the 
Samples menu, and check to see if a vial is lodged in 
the sample tower. (If so, the needle might be bent.)

Table 26. Hardware error messages  (Sheet 3 of 3)

Hardware error message Description
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Testing for Tubing Restrictions
If the solvent lines are restricted, you will probably hear a loud grinding sound from the 
syringe-drive mechanism due to increased resistance to syringe travel.

To isolate a block to a section of tubing

1. Place the autosampler injection valve into the FILL position (press the MENU key and 
select COMMANDS > Injector > Rotate Injection Valve, and press the [+] and [–] keys 
to select Fill).

2. Disconnect the tubing from port 3 of the injection valve.

3. Initiate a flush sequence (press the MENU key and select COMMANDS > Flush 
Sample Syringe (see “Flush Sample Syringe” on page 96). Solvent flows freely on the 
return stroke of the plunger if there are no restrictions present. Flow restriction is unlikely 
at this point due to the large internal tubing diameter.

4. Reconnect the tubing.

5. Disconnect the needle and check the flow.

6. If no restriction is found, reattach all of the tubing, and flush the syringe to verify that the 
restriction still exists.

7. If a restriction is still present, remove and clean the sample needle as described in 
“Maintaining the Sample Needle Module” on page 115.

IMPORTANT  Before beginning this procedure, be sure to set up a beaker or other 
container to catch the solvent. 
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Replaceable Parts

When you must replace parts for use with your SpectraSYSTEM autosampler, refer to this list 
of spare parts, consumables, and kits available from Thermo Fisher Scientific.

Clear Vials and Vial Kits
Shell Vials

Shell vials, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4946-010
Shell Vial Kit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4948-010

Standard Vials
Standard vials, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4951-010
Standard vial septa, 100/package. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4952-010
Standard vial caps, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4953-010
Standard Vial Kit, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4954-010

Crimp Vials/Caps
Crimp caps, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4955-010
Crimp vials, 100/package, 1.8 mL  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4956-010
Crimp Vial Kit, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4957-010 

Poly Kits
Polypropylene Kits, 600 mL, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . A4958-010
Polypropylene Kits, 100 mL, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . A4959-010

Inserts
Spring for insert, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4981-010
Insert, 50 mL, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4960-010
Insert, 100 mL, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4961-010

Contents

• Clear Vials and Vial Kits

• Amber Vials and Vial Kits

• Cables and Adapters

• Standard Autosamplers

• Inert/Biocompatible Autosamplers

• Test Mixes

• Upgrade Kits
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Amber Vials and Vial Kits
Crimp Vials

Amber crimp vials, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4964-010
Amber Vial Crimp Kit, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4965-010

Standard Vials
Standard amber vials, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4966-010
Standard Amber Vial Kit, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4967-010

PFTE Liners/Septa
PTFE Liners, 100/package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4968-010
PTFE Vial caps/septa, 100/package  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4969-010
Standard vial station . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4970-010

Sample Trays
Three sample trays, 35-vial capacity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3696-010

Cables and Adapters
Autosampler-to-integrator cable/adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3981-010
BCD Communications option

(This option requires field installation by 
Thermo Fisher Scientific unless purchased 
simultaneously with a SpectraSYSTEM autosampler.)  . . . . . . . . . . . . . . . . . A3663-010

Standard Autosamplers
Injector valve assembly for the AS3000, 100 mL, stainless steel

(Assembly includes the complete autosampler valve assembly.) . . . . . . . . . . . A3566-030
Standard Maintenance Kit (Kit includes everything necessary to 

maintain the instrument for one year: inlet filter, 
needle replacement kit, valve rotor seal, syringe, 
lubricant, cleaner, and LC test sample.). . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4101-010

Standard Fittings Kit (Kit includes stainless steel fittings and tubing 
used in a SpectraSYSTEM LC system.). . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4051-010

Autosampler Needle Replacement Kit 
(Kit includes the standard, stainless-steel, 
deflected-point replacement needle.). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4719-010

Standard Sample Loops and Syringes
Rheodyne sample loop, 20 μL, stainless steel  . . . . . . . . . . . . . . . . . . . . . . . . 3302-0230
Rheodyne sample loop, 50 μL, stainless steel  . . . . . . . . . . . . . . . . . . . . . . . . 3302-0010
Rheodyne sample loop, 100 μL, stainless steel  . . . . . . . . . . . . . . . . . . . . . . . 3302-0020
Rheodyne sample loop, 200 μL, stainless steel  . . . . . . . . . . . . . . . . . . . . . . . 3302-0220
Rheodyne sample loop, 500 μL, stainless steel  . . . . . . . . . . . . . . . . . . . . . . . 3302-0030
Rheodyne sample loop, 1 mL, stainless steel . . . . . . . . . . . . . . . . . . . . . . . . . 3302-0040
Screw-tip syringe, 250 μL, (standard) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3588-020
Screw-tip syringe, 500 μL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3588-010
Solvent inlet filter cartridge (pkg. of four). . . . . . . . . . . . . . . . . . . . . . . . . . . A4094-010
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 8 Replaceable Parts
Inert/Biocompatible Autosamplers
Injector Valve Assembly 

(The assembly includes the complete autosampler valve assembly.) . . . . . . . . A3566-020
Inert/Biocompatible Maintenance Kit 

(The kit includes the inert/biocompatible versions of everything in 
the Standard Maintenance Kit.)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4102-010

Inert/Biocompatible Fittings Kit 
(The kit includes PEEK fittings and tubing used in an 
inert/biocompatible SpectraSYSTEM LC system.) . . . . . . . . . . . . . . . . . . . . A4061-010

Autosampler Needle Replacement Kit (Kit includes the standard, 
inert, deflected-point replacement needle.) . . . . . . . . . . . . . . . . . . . . . . . . . . A4719-020

Inert/Biocompatible Sample Loops and Syringes
Rheodyne Sample Loop, 20 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-010
Rheodyne Sample Loop, 50 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-020
Rheodyne Sample Loop, 100 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-030
Rheodyne Sample Loop, 200 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-040
Rheodyne Sample Loop, 500 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-050
Rheodyne Sample Loop, 1 mL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-060
Rheodyne Sample Loop, 2 mL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4169-070
Screw-tip Syringe, 250 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3588-020
Screw-tip Syringe, 500 μL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A3588-010

Solvent Inlet Filter Cartridge (pkg. of four) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4094-010

Test Mixes
Autosampler Test Mix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A4991-010
Autosampler Dilution Test Mix. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A5135-010

Upgrade Kits

Upgrade kits are available for SpectraSYSTEM stainless steel autosamplers. Contact your local 
Thermo Fisher Scientific representative for details.
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Quick Reference Guides

Use the following two-page guides to familiarize yourself with the SpectraSYSTEM AS3000 
autosampler’s command center.

Tip  To control the autosampler from the command center, set the Options > 
Configurations > Mode field to Stand Alone.

Contents

• SpectraSYSTEM AS3000 Menus

• SpectraSYSTEM AS3000 Quick Reference Guide

• Quick Start: Starting Runs from the Command Center
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RUN

STOP

Starts a run.

Pauses a run.

If the queue contains 
one or more sample sets, 
the QStatus changes from
IDLE to RUN.

**Use SAMPLES Key**
to Add Samples to the Queue

If the queue is empty, 
the following message appears.

QStatus  Set  # Samples
RUN  1   1/   1

When you press STOP, 
the following message appears.

STOP requested
Select      Abort Sample
          Continue

�To stop the run
1. Select Abort Sample.
2. Press Stop a second time.

�To continue the run
      Select Continue.
Thermo Scientific S

SpectraSYSTEM AS3000 Menus

FILES

QUEUE

Order  File Name Set
       1      1

TESTS (see page 2)

COMMANDS (see page 2)

OPTIONS (see page 2)

Edit

Edit Load
Copy Delete

Edit File 1
File Name
Injection
Calibration
Timed Events
More

Load File 1:

Copy File 1:
To File 1:

Delete File 1:

Injection Volume*    10
Injections/Sample     1
Cycle Time     10.0
Col Oven Off  Temp  18
Tray Temp Off  Temp  0

Number of  Levels 1
Samples/Calibration 0
Injections/Level 1
Injection Volume 10
Type                      Reuse same vials
Bracket Samples No

Timed Events

Time   TF1   TF2   TF3   TF4
0.00   Hi   Hi   Hi   Hi

More

Equilibration Time 0.0
Gradient Delay 0.00
Sample Viscosity Normal
Flush Volume 400
Injection Type Push Hi
Injection Range 1-200
Needle Height 2.0

SAMPLES

Sample Set  1
File 1:
Injection Volume*  10
Injections/Sample  1
Cycle Time  10.0
First Sample Vial  A01
Number of Samples 1
Add to Queue?  Yes

page 1 of 2

STATUS

QStatus  Set   # Samples
IDLE      0/   0
Status  Vial  Vol  #Inj
NOTRDY    10  0/   0
File 1:
Oven           Tray Temp
OFF  18         OFF  0 

MENU

FILES         QUEUE            TESTS
   COMMANDS      OPTIONS

Delete

Calibration

Injection

Load

Copy

*Becomes Loop Size if Injection Type = Full

*Becomes Loop Size if Injection Type = Full
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Arm

Total System Cycles

Maintenance Log Menus

ns (Stand Alone mode only)

9600
NONE
NONE

8
1

On

ycles

e

og

EPROM

m Port

back Cable
 CONTINUE

ome Arm
lign Arm A01

Total Cycles    Note
         0      01 May10

#Cycle   Due    Note
 0    12000  01May10
Reset   #Cycles  No

stem values
re? No
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Software Version
Display Input States
Display Output States
Display Timed Events
RAM Test
ROM Test
Hardware Test
Test External Contacts
Test Comm Port
Initialize EEPROM

Software Version

Version x.yy.zz

COMMANDS
Flush Sample Syringe Initialize Hardware Injector

Communicatio

Configurations

Sample Syringe 250
Prep Installed No
Oven Installed Yes
Tray Temp Installed Yes
Key Repeat Rate Medium
File Name Protect
1: Off
2: Off
3: Off
4: Off
Mode Stand Alone
Solv Viscosity Normal

Ready Participation

Door Interlock ENABLE
Tray Temp Ready ENABLE
Col Oven Ready ENABLE

Flush Sample Syringe
Initialize Hardware
Injector
Arm

Configurations
Ready Participation
Input Polarity
Output Polarity
Shutdown
Maintenance Log
Communications

OPTIONS

Shutdown

Input Polarity

Output Polarity

Autosampler Ready Lo
Inject Out Active Lo
Grad Start Active Lo
Pump Stop Active Lo

Delay Time Off
Oven Shutoff Yes
Tray Temp Shutoff No
Pump Shutoff Yes
Flush Volume 400

Baud Rate 
Parity 
Flow Control 
Data Bits 
Stop Bits 
Echo 

Total System C
Injector Valve
Needle Wear
Sample Syring

Maintenance L

Initialize E

Test Com

Install Loop
  

RAM Test

ROM: PASS

Connector: PASS

Disconnect all external
contacts     CONTINUE

Test External Contacts

Hardware Test

ROM Test

“Initializing”Flush 500 µL H
A

Reset all sy
Are you su

Display Timed Events

TF1   TF2   TF3   TF4
Hi    Hi    Hi    Hi

Display Output States

AS Rdy  Inject  Grad  Stop
    Hi    Hi    Hi    Hi

Display Input States

Pump Ready  Inj Hold
        Lo       Lo

TESTS

RAM: PASS

page 2 of 2

Pump Ready Active Hi
Inj Hold Active Hi

Rotate Injection Valve
                           Inject

SpectraSYSTEM AS3000 Menus



To enter values

• For numeric entries, use the  or  key to increase or 
decrease the value of each digit.

• For alphanumeric entries, use the  and  keys to scroll 
through the alphabet from A to Z, then through numbers 0 to 9, 
and then slash, hyphen, and blank space.

• For preset choices, use the  key to advance through a preset 
list of choices. The  key takes you back through the list.

To accept values

Press the ENTER, MENU, or STATUS keys or use the 
arrow keys.

Trays A, B, and C are arranged from left to right in the sample tub. 
The position number is indicated on the top left of each vial position.

To install your trays
1. Hold the tray handle and tilt the back end down. 
2. Insert the tray's runner into the slots at the back of the sample tub 

and lower the front of the tray into place.
3. Press down firmly to seat the tray and pull the handle back 

toward you to be sure the tray is properly seated. 

To set up a file
1. Press  and select FILES > Edit. 
2. Enter the file number and name. 
3. Select Injection. 
4. Enter the injection volume, number of injections per vial, and 

cycle time, and set the oven and sample tray temperatures.
5. Select Calibration. 
6. Enter the number of standard levels, calibration interval, number 

of injections per level, and injection volume. Select the type of 
calibration routine (reuse or intersperse calibration vials). Select 
whether or not (yes or no) you want the sample set to end with a 
calibration set.

7. To program external events, select Timed Events and program a 
time and state (Hi or Lo) for up to four time functions. 

8. Select More. 
9. Select the injection type: Full, Pull, Push Hi, or Push Lo. Enter 

the equilibration time, gradient delay, flush volume, and needle 
height values for your application. 

To load a file
1. Press  and select FILES > Load. 
2. Select the file number and press .

To build the sample queue
1. Press the Samples key. 
2. Enter the file number in the Use File field. 
3. Press  to accept the other values in the Samples Menu 

and to add the file to the Queue (Yes).

SpectraSYSTEM AS3000 Quick Reference Guide

Using the Keypad

RUN Starts a run. 

STOP Pauses the sample queue. You can continue the run 
from the current vial or cancel the run and return 
to the beginning of the sample queue.

Samples Opens a menu where you can specify the injection 
parameters and a file name for a sample set, add 
sample sets to the queue, and edit runs in progress. 

STATUS Displays the status screen. 

, , , 
and 

Moves the cursor in the direction indicated on the 
key. The UP and DOWN arrow keys also move 
the cursor between menus and displays. 

MENU Displays the main menu. For information on the 
menus, refer to the AS3000 Menus sheet.

 and  Scrolls you through a field's available choices or 
changes the value of alphanumeric entries. 

ENTER Accepts a selection or menu entry; also advances 
the cursor to a new field. 

Setting Parameters

RUN

STOP

Samples SpectraSYSTEM AS3000

ENTER

STATUS MENU

FILES QUEUE TESTS
 COMMANDS OPTIONS

Installing Trays

Managing Files

MENU

MENU

ENTER

ENTER
© 2010 Thermo Fisher Scientific Inc.
All rights reserved. 



To run a file
1. Press  to start the run. 
2. To monitor the sample queue, vial injection, and column and tray 

temperatures, press .
3. To pause a run, press . 

STOP requested appears.
4. Do one of the following:

• To cancel the run, select ABORT Sample, and then press 
 again.

• To continue the run, select Continue.

To edit a run in progress

You can edit some of the file parameters for the run in progress from 
the Samples menu. 
1. Press the Samples key. Press . 
2. Edit the Injection Volume, Injections/Sample, Cycle Time, and 

Number of Samples values. 

You can edit the Calib 1 (of X) value only if you have selected 
Reuse vials as your calibration routine. You cannot edit the First 
Sample Vial value. 

Except for the Cycle Time and Calib 1 (of X) values, changes take 
place on the next sample injection. A cycle time change affects the 
current sample injection, a Calib 1 (of X) change affects the next 
recalibration. 

To delete a file
1. Press  and select FILES > Delete. 
2. Select the file number to be deleted. 
3. Press . 

To copy a file
1. Press  and select FILES > Copy. 
2. Select the file number to be copied from the Copy file field, and 

the file number to be copied to the To file field. 
3. Press . 

To protect a file
1. Press  and select OPTIONS > More. 
2. Scroll down to the File Name and Protect fields. Select On in the 

appropriate file's Protect field. 
3. Press . 

To reorder sets in the Queue
1. Press  and select QUEUE.   
2. Move the cursor to the line where you want the change to occur 

and increment or decrement to the new Order value.   
3. Move the cursor out of the field to automatically rearrange the 

lines. 

To add a set to the queue
1. Press the Samples key.
2. Enter the file number and set to add to the queue. 
3. Accept the Edit file parameters and press  in the Add to 

Queue? field. 

To delete a set from the queue
1. Press  and select QUEUE. 
2. Move the cursor to the line to be deleted. 
3. Decrement the Order value to 0 and then blank. Moving the 

cursor deletes the blank line from the display. 

To add a priority set 

A priority sample set is inserted into the active (currently running) 
run before other samples in the set. It uses the same file name as the 
active set. 

1. Press the Samples key. 
2. Use the  key to change the Set field value to P. 
3. Fill in the other file parameters as for any other set. 
4. Add the priority set to the queue. 
5. Press  and select QUEUE. The priority set has an Order 

value of 1, has the same File Name as the active file, and is 
indicated by a P in the Set field. 

To change the cursor speed

You can adjust the cursor speed and display contrast.
1. Press  and select OPTIONS > Configurations. 
2. Move the cursor to the Key Repeat Rate field. 
3. Use the  and  keys to select between Slow, Medium, and 

Fast. 

To change the display contrast
1. Press  to access the Status Screen. 
2. Press . 
3. Do one of the following:

• To increase the contrast, use the  key.

• To decrease the contrast, use the  key. 

To turn off the door interlock 

When the door interlock is enabled, the XYZ arm moves to the 
back-left corner of the tray compartment when you open the door. 

To turn off the interlock 
1. Press  and select OPTIONS > Ready Participation. 
2. Move the cursor to the Door Interlock field and use the  and 

 keys to select DISABLE.

Managing the Queue

RUN

STATUS

STOP

STOP

MENU

ENTER

MENU

ENTER

MENU

ENTER

MENU

Note  When running priority sets, remember the following: 

• If you are running calibration vials in the priority set, you 
must select Reuse vials as your calibration routine.   

• You cannot change the order of a priority set in the queue. 

Changing Your Autosampler's Setup 

ENTER

MENU

MENU

MENU

STATUS

MENU
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This guide describes how to start runs from the command center. If 
you have not set up your LC system, inject distilled water rather than 
an actual sample.

For information on the menu screens, see “SpectraSYSTEM AS3000 
Menus.”  For information on the keypad controls, see the 
“SpectraSYSTEM AS3000 Quick Reference Guide.” 
Figure 1. Command center

Trays A, B, and C are arranged from left to right in the sample tub. 
The position number is indicated on the top left of each vial position.

To install your trays
1. Fill a vial with distilled water.
2. Place the vial in position 1 of tray A, location A01.
3. Hold the tray handle and tilt the back end down. 
4. Insert the tray's runner into the slots at the back of the sample tub 

and lower the front of the tray into place.
5. Press down firmly to seat the tray and pull the handle back 

toward you to be sure the tray is properly seated. 

To set the operation mode to Stand Alone
1. Turn on your autosampler by pressing the on/off switch in the 

lower right corner of the autosampler. 

When the startup sequence is complete, the Status screen appears. 
Figure 2. Status screen

2. Press  and select Options > Configurations.
3. Press  to move down the Configurations menu.
4. In the Mode field, select Stand Alone.

To start a run, do one of the following:

• To customize the injection settings, follow these steps:
− Step 1: Creating Your File
− Step 2: Loading Your File
− Step 3: Building a Sample Queue
− Step 4: Starting Your Run

• If you want to use the default settings, go directly to these steps:
− Step 3: Building a Sample Queue
− Step 4: Starting Your Run

Step 1: Creating Your File
Create files when you want to use more than one set of injection 
parameters in the queue, when you want to store a specific set of 
injection parameters, or both.

The default file contains these parameter settings. 

Quick Start: Starting Runs from the Command Center

Contents

• Command Center

• Loading Trays into the Autosampler

• Setting the Operation Mode to Stand Alone

• Starting a Run

 Command Center

Loading Trays into the Autosampler

RUN

STOP

Samples SpectraSYSTEM AS3000

ENTER

STATUS MENU

FILES QUEUE TESTS
 COMMANDS OPTIONS

Setting the Operation Mode to Stand Alone

Starting a Run

Menu parameters Default setting

Injection

Injection Volume 10 μL

Injections/Sample 1

Cycle Time 10.0 minutes

Column Oven Off

Tray Temp Off

QStatus  Set  # Samples
IDLE  0   0/   0

MENU
© 2010 Thermo Fisher Scientific Inc.
All rights reserved. 



To create your file
1. Press  and select FILES > Edit. 

The Edit menu appears. 
Figure 3. Edit menu

2. Press  to edit File 1.
3. Use the use the , , , and  keys to specify 

each character in the file name of your choice. For this example, 
enter the name PRACTICE. 

4. Move the cursor to each field in the Injection, Calibration, Timed 
Events, and More menus and press  to accept the default 
values.

Step 2: Loading Your File

To manually load your file
1. Select Edit > Load.
2. Verify that File 1 is entered, and then press  to load it 

into the autosampler's active memory. 

The **File Loaded** message appears briefly, and then the Status 
screen appears (Figure 4). Loading the file activates the 
temperature control options that you set in the Injection menu. 
Figure 4. Queue Status screen 

Step 3: Building a Sample Queue

To build a sample queue
1. Press the Samples key to display the Samples menu. 

If you have not loaded a file, the File field is blank.
Figure 5. Samples menu

2. To move down the Samples menu, press . 
3. To change the Cycle Time to 1.0, use the , , , 

and  keys. 
The cycle time is the time between injections. If you are injecting 
an actual sample, enter an appropriate cycle time for your 
application (injection time + data acquisition time).

4. When you reach the Add to Queue line, press  to add the 
sample set (1) to the queue.

Step 4: Starting Your Run

To start your run
1. If you have not already done so, place a vial filled with distilled 

water in position A01.
2. Press .

If everything is running properly, the QStatus changes from 
IDLE to RUN (Figure 6). The autosampler picks up the vial, 
carries it to the sample tower, injects the sample, returns the vial 
to the sample tray, and flushes the lines.
Figure 6. Queue Status screen with the queue running

The injection status field displays the time elapsed since the run 
started (Figure 7). When the run ends, the QStatus returns to 
IDLE.
Figure 7. Injection Status screen with a run in progress

Calibration

The default value in the Samples/Calibration field is zero, which 
means that the sample set contains no calibration vials and the 
autosampler ignores the other settings in the Calibration menu. 

Number of Levels 1

Samples/Calibration 0

Injections/Level 1

Injection Volume 10

Type Reuse same vials

Bracket Samples No
More

Equilibration Time 0.00 minutes

Gradient Delay 0.00 mL

Sample Viscosity Normal

Flush Volume 400 μL

Injection Type Push Hi

Injection Range 1–200 μL

Needle Height 2 mm

Note   After the last field in each menu, the next most 
probable choice in the menu structure appears. For example, 
after you accept the default values in the Calibration menu, 
the screen returns to the Edit menu with the cursor in the 
Timed Events field. Similarly, after you accept the default 
values in the More menu, the screen returns to the File menu 
with the cursor in the Load field. This pattern occurs 
throughout the user interface. You can override the default 
choice at any time by moving the cursor where you like.

Menu parameters Default setting

MENU

Edit File   1_
File Name:   PRACTICE

Injection
Calibration

Timed Events
More

ENTER

ENTER

ENTER

QStatus  Set  # Samples
IDLE  0   0/   0

Sample Set 1
File 1:

Injection Volume  10.0 
Injections/Sample  1 

Cycle Time   10.0 
First Sample Vial   A01

Number of Samples  1 
Add to Queue  YES

ENTER

RUN

QStatus  Set  # Samples
RUN  1   1/   1

Status  Vial  Vol  #Inj
0.05  A01-S  10  1/  1
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I

Index
Symbols
#Inj  85
#Samples  83

A
A/S Ready pin, back panel  42
Abort/Continue menu  89
Align Arm command  98
arm

misaligned  136
movement restricted  136

Arm menu  97
arrow keys  60
AS3000 photograph  1
autosampler ready signal  45

B
back panel pin connections  42
backlash  97
baud rate, Communications menu  44
BCD interface  46
bench space requirement  16
bent needle  135
biocompatible, replaceable parts  147
blinking square cursor  58
blocked

injector valve  136
needle  136
sample loop  136

bracket samples, Calibration menu  71
broken vials, cause of  136
building ground, connecting the autosampler to  xiv, 19

C
cable connections

contact closure  38
SN4000 controller  33

cables
communication  31
contact closure  37

carryover, sample  52–55
caution, defined  xiii–xiv
checklist, startup  14
column compartment cover, installing  27
column oven

description  3
temperature control  68

column, installing  25
Commands menu  96
communication among the system modules  30
Communications menu  43
compliance

regulatory  iii
WEEE  v

Configurations menu  91
confirmation messages  62
contact closure cable assembly  37
conventions used in manual

Cautions  xiii–xiv
Tips  xiv

cursor
square and blinking  58
triangular  58

cycle time, Injection menu  68

D
data bits, Communications menu  44
data system control  30
delay time for shutdown  123
detector, connecting the plumbing  26
diagnostics  101
Display Input States menu  103
Display Output States menu  103
Display Timed Events menu  104
DOOR status  84
drop catch, flushing  118
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Index: E
E
echo, Communications menu  44
Edit menu  64
EEPROM, initializing  106
electrical requirements  17
EPROM firmware, SN4000 controller  33
equil status  83
equilibration time, More menu  74
error messages  62, 140
external contacts, testing  105

F
File #  85
files

loading  77
managing  90

flow control, Communications menu  44
flush solvent bottle, connecting  21
flush solvent inlet filter, replacing  115
Flush Syringe menu  96
flush volume, acceptable range  74
full-loop injection type  4
fuses, replacing  122

G
GRAD status  84
gradient delay

determination  99
More menu parameter  74

Gradient start pin  41
gradient start signal  45
Ground pin, back panel  41
grounding post  xiv, 19

H
hardware error messages  140
Hardware test  105
hardwire connections  43
high voltage, defined  xiii
hot surface, defined  xiii

I
inert, replaceable parts  147
Initialize Hardware command  97
inj hold signal  45
Inject Hold pin, back panel  41
Inject Out pin, back panel  41
inject out signal  45

Injection menu  66
injection range  76
injection types

description  4
selections  75

injection volume
range  67
recommended  93

injections per level, Calibration menu  70
injections per sample, Injection menu  67
Injector command  97
injector valve

disassembling  111
testing  97

Injector Valve menu  125
input pins, back panel  40
input signal polarity  44
integrators, using  46
intersperse vials, Calibration menu  71

K
keypad keys  59
kits, BCD Communication  47

L
lift points, autosampler  17

M
main menu  61
maintenance log  124
maintenance procedures

changing the sample loop  121
cleaning the sample needle module  115
emptying the flush-solvent tray  109
flushing the drop catch  118
flushing the solvent inlet filter  115
replacing the fuses  122
replacing the rotor seal  109
replacing the syringe  118

manual set, SpectraSYSTEM user guides  19
MENU key  60
menu trees  151
menus

Abort/Continue  89
Arm  97
Calibration  69
Commands  96
Communications  43
Configuration  91
Copy  90
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Index: N
menus (continued)
Delete  90
Edit  64
Flush Syringe  96
Injection  66
Injector Valve  125
Input Polarity  44
Load  77
Maintenance Log  125
More  74
Needle Wear  127
Output Polarity  45
Ready Participation  48
Sample  78
Sample Syringe  127
Shutdown  123
Tests  101
Timed Events  72
Total System Cycles  125

messages
Arm,*  105
Opt Config  105
types  62

module Identification, test result  102
More menu  74

N
needle height

More menu field  76
optimizing  95

needle module, cleaning  117
needle plugging  137
Needle Wear menu  127
number of levels, calibration  70

O
ordering information, replaceable parts  145
output pins, back panel  40
output signal polarity  45
oven shutoff  124

P
parity, Communications menu  44
pause status  83
pin assignments, back panel  40
pin connections  42
plumbing connections

connecting the autosampler to the detector  26
installation procedures  21

plus and minus keys  60

polarity setting  44
priming the autosampler  29
protective earth ground, connecting the autosampler to  xiv
pull-loop injection type  5
Pump Ready pin, back panel  41
pump ready signal  45
pump shutoff  124
Pump Stop pin, back panel  41
pump stop signal  45
PushLoop injection type  6

Q
Queue menu  80
quick reference guides

SpectraSYSTEM AS3000 Menus  151
SpectraSYSTEM AS3000 Quick Reference Guide  153
Starting Runs from the Command Center  155

R
RAM test  104
Ready Participation menu  48
regulatory compliance  iii
replaceable parts  145–147
reproducibility, injection volume  50
reuse same vials, Calibration menu  71
RJ45 to DB9 adapter  34
ROM test  104
rotor seal, replacing  109–113
RS-232 communication ports, data system computer  34
RUN key  59
runs

starting from the command center  81, 156
stopping from the command center  88

S
safety and special notices, defined  xiii
safety icons  xiii–xiv
safety standards  iii
sample loop, changing  121
sample needle module, replacing or cleaning  115
sample sets, priority  87
sample trays, installing  27
Samples key  60
Samples menu

adding samples to the queue  78
troubleshooting  137

samples per calibration, Calibration menu  70
schedule, maintenance  108
set temperature, checking  85
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Index: T
shipping kit  19
Shutdown menu  123
signal polarities, SpectraNET mode  36
SN4000 controller

back panel  31
bottom  32
U12 socket and communication ports  33

SN4000 controller, connecting the cables to  32
software version  103
solvent waste container, installing  22
specifications, autosampler  11
SpectraNet mode  30
Stand Alone mode  30
startup, autosampler  29
stator, cleaning  112
STATUS key  59
Status Screen  61
stop bits, Communications menu  44
STOP key  59
syringe

flushing  96
injection volume range  94
replacing  118–120

syringe speed, appropriate for solvent viscosity  94
system errors  143
system synchronization harness  37

T
temperature control

column oven  68
tray compartment  68

tests
COMM port  106
diagnostic  101
External Contacts  105
flush sample syringe  96
Hardware  105
Initialize EEPROM  106
performance verification  49
RAM  104
ROM  104
tubing restrictions  144

Tests menu  101
Timed Events menu  72
Tips, defined  xiv
Total System Cycles menu  125
tray compartment, temperature control  68
trays, installing  27
triangular cursor  58

troubleshooting
autosampler hardware problems  135
autosampler specific chromatography problems  132
general chromatography problems  129

TTL input and output signals  103
tubing restrictions, testing for  144

U
uninterruptible power supply (UPS)  17
user guides, SpectraSYSTEM  19

V
variable-loop injection  67
Vial Not Found in Hook error message  143
vials

appropriate caps for  27
position numbering  27
total number is sample set  72
type S or C  84

viscosity
changing the draw rate based on  94
normal, medium, or viscous  74

W
waste solvent container, installing  22
WEEE compliance  v
weight, autosampler  16
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